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How this manual is Organized
P r e f a c e :

Using this Manual

This manual will tell you everything you need to know about performing specific tasks available in RMS/DeskTop. 

Who should read this book
The primary audience consists of persons who will be using the system as a tool to manage reports for their own use:

• RMS/DeskTop Users

• System Administrators

What you should know to use this book
You should be familiar with:

• Turning on your computer workstation

• How to work in a Microsoft Windows environment

How this manual is Organized
Your RMS/DeskTop documentation is organized into three useful sections — User’s Reference, Administration, and 
Installation.

RMS/DeskTop User Guide
The RMS/DeskTop User Guide comprises chapters 1 through 6 and contains detailed information and explanations 
about performing specific tasks typically available to end users in RMS/DeskTop. These tasks are made easier with 
easy to follow, step-by-step instructions and illustrations.

RMS/DeskTop User Administrator
The RMS/DeskTop User Administrator comprises chapters 7 through 10 and provides detailed information on 
RMS/DeskTop systems, including system setup and configuration. The IMPORTER and SYSGEN programs are 
documented in this section.

RMS/DeskTop Reference Guide 
The RMS/DeskTop Reference Guide provides easy, step-by-step instructions for installing the RMS/DeskTop 
programs on your computer, along with technical support assistance. 

Chapter Summary
The following is a high level view of the manual’s chapters along with a brief description of each chapter’s content. 

User Guide

Chapter 1: OVERVIEW This chapter provides an overview of the RMS/DeskTop product and is written 
as an aid to understanding the structure and overall functionality of the product.

Chapter 2: The Viewer Window This chapter explains the setup and use of the catalog VIEWER WINDOW, which 
serves as a navigational tool for accessing data within an RMS/DeskTop 
system.
© 2013 Mantissa Corporation. All rights reserved.  13
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Conventions Used in This Manual
Conventions Used in This Manual
The following typographical conventions are used throughout this manual.

Chapter 3: The Report Viewing Window This chapter focuses on working in RMS/DeskTop’s REPORT VIEWER WINDOW. 
It provides information on performing tasks such as opening report files, 
moving around within a report, searching for information in a report, and 
copying selected data to other applications.

 Chapter 4: Extracting Data from Reports This chapter focuses on extracting tabular or index information from reports. It 
provides information on creating data extraction definitions, performing 
extractions, and viewing extraction results.

Chapter 5: The Table Viewing Window This chapter focuses on working in RMS/DeskTop’s TABLE VIEWER WINDOW. It 
provides information on performing tasks such as opening indices, moving 
around within the index, filtering, sorting, and searching the index and selecting 
or copying selected data to other applications.

Chapter 6: Report Printing This chapter explains logical printers including their setup and use.

User Administrator

Chapter 7: Administration Overview This chapter provides an administrative overview of the RMS/DeskTop product 
and is written to aid the System Administrator in implementation 
considerations.

Chapter 8: Security Overview This chapter is a reference for the RMS/DeskTop security setup. 

Chapter 9: Data Import This chapter is a reference for the RMS/DeskTop import program. It provides a 
detailed reference for configuring and running the importer.

Chapter 10: Creating an RMS/DeskTop 
System

The chapter describes how to create a new RMS/DeskTop system.

Reference Guide

Chapter 11: Installation This section explains how to install the RMS/DeskTop software on a network 
server and/or workstation.

TYPE STYLE USED FOR

PLAIN ALL CAPS Windows directory names and file names will appear in ‘full size uppercase’ Sans-
serif typeface, e.g., C:\WINDOWS\SYSTEM.

NORMAL “COURIER NEW” 
CAPS

Screen and report text will appear in ‘fixed-width uppercase’ “Courier New” 
typeface, i.e., “8,019.00”.

NORMAL SMALL CAPS Special DeskTop jargon and names defining display screens, tables, or figures will 
appear in a ‘small uppercase’ Serif typeface, e.g., FIGURE 23-1.
14 © 2013 Mantissa Corporation. All rights reserved.
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PLAIN BOLD SMALL UPPERCASE 
TEXT

Special keyboard keys (function/command) that you are instructed to 
press will appear in ‘bold small uppercase’ Sans-serif typeface, e.g., 
ENTER, ESC, CTRL, ALT, and F1
When command keys are used in association with other keys they will 
be separated by a + sign, e.g., CTRL+C (remember that a command 
key, such as CTRL, should be depressed and held while the associated 
keys are pressed and released).

plain bold lowercase text Text that you are requested to type from your keyboard will appear 
in a ‘bold lowercase’ Sans-serif typeface. For example: Enter the 
User ID demo and press ENTER.

ITALIC-SMALL-CAPS Menu commands and dialog options will appear in a ‘small 
uppercase’ italic Serif typeface. Furthermore, menu command levels 
will be separated by a comma. An example is: Select FILE, OPEN (the 
keyboard accelerator for this command would be ALT+F, O).

TYPE STYLE USED FOR
© 2013 Mantissa Corporation. All rights reserved.  15
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Using this Manual Reference Guide
Summary
Summary
This manual is designed to provide everything users need to know to perform specific tasks using RMS/DeskTop. 
It is written in a task-oriented format which will provide easier reference access. This manual gives a complete 
description and reference of the operational aspects of the RMS/DeskTop APPLICATION. This guide also includes 
information about the setup and administration of the entire RMS/DeskTop SYSTEM. 
16 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide Overview
What is RMS/DeskTop?
C h a p t e r  1 :

Overview

What is RMS/DeskTop?
RMS/DeskTop is a powerful, industrial-strength report management system, which automatically and transparently 
receives your reports from your organization’s mainframe, mini computer, or PC and stores them on your PC’s media 
(or LAN file server’s media), providing you with access to secure, view, browse, search, organize, mine, and print any 
data contained within those reports. RMS/DeskTop is sold in Enterprise or Personal edition. We will indicate that 
the information is applicable only to the Enteprise edition by placing an asterisk next to a topic or chapter’s title.

Unlike other high-level report viewers, RMS/DeskTop is one of the fastest production-grade report viewers in the 
marketplace today. RMS/DeskTop provides you with immediate access to data on any page or line of a computer 
generated report, regardless of its size, because of RMS/DeskTop’s advanced: 

• Repository techniques

• Block level compression

• Block-based retrieval

• Direct jump compressed data reads

• Multi-level cache

NOTE: Try searching through a 20 megabyte to 2 Gigabyte, report for data with other report viewers in 
the marketplace, and you will immediately discover the dramatic difference between other 
report viewers and RMS/DeskTop.

Yes, RMS/DeskTop is a powerful application that provides you with the flexibility to access, view, analyze, mine, 
print, and archive data presented in computer reports. But, its real strength lies in its advanced architecture for 
performing these functions!

A few of RMS/DeskTop’s architectural strengths include:

• A user-configurable report viewer for quick and easy access to reports. Features include:

Date range filtering and selection
Prior version range selection
Hierarchical category exploration

• Report cataloging, which provides transparent access to reports, without having to know where the reports 
are stored (regardless of storage media).

• Powerful repository techniques, including automatic low-level indexing and media bridging

• A shared magnetic cache controller, with up to four cache levels

NOTE: Simply stated: “RMS/DeskTop is a powerful, industrial-strength report management system, 
which automatically and transparently receives your reports from your organization’s 
mainframe, mini computer, or PC and stores them on your PC’s media (or LAN fileserver’s 
media), providing you with access to view, browse, search, mark, reorganize, mine, and print 
any data contained within those reports.” 
© 2013 Mantissa Corporation. All rights reserved.  17
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Overview Reference Guide
What is RMS/DeskTop?
You can think of RMS/DeskTop as a file security agent, file cabinet, filing clerk, and research assistant, all rolled into 
one.

RMS/DeskTop
RMS/DeskTop allows you to display and analyze report data that has previously been printed to disk as a print or 
spool file, as well as ASCII files. In a business environment, these files are usually distributed through a 
communications interface. 

RMS/DeskTop allows you to select a report file that has been stored on disk and display it on your computer monitor 
in the format it was originally printed or stored. But this is only the beginning of your RMS/DeskTop experience.

From this beginning, your world of data analysis and exploration expands. Not only can you review printed reports 
quickly and efficiently, but you can also perform searches for data or data strings using boolean logic and multiple 
field selection criteria to find answers to those demanding management questions that are hidden within printed 
reports. And, when that elusive data is found, RMS/DeskTop marks the data in red ink the way you would on hard 
copy.

How RMS/DeskTop Works
When reports (or other desired files of any type) are downloaded from a mainframe to your LAN or local PC through 
a communications program, the transfer of those files can be performed transparently to your local activity. And, 
RMS/DeskTop can detect the arrival of reports on your system and immediately begin making them available for 
your use.

As RMS/DeskTop recognizes the arrival of reports in which you are interested, it will immediately catalog, index, 
compress, and store those reports according to your predetermined wishes. Then, when you are ready to view the 
information contained in these reports, it is immediately accessible through RMS/DeskTop’s REPORT VIEWER.
18 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide Overview
What is RMS/DeskTop?
When a new version of an existing report is received by RMS/DeskTop, the previous version is not overwritten, but 
is kept and remains accessible just as before. RMS/DeskTop allows you to expand your report selection to display 
prior versions of a report or only list the most recent version. All of this is accomplished with a simple click of the 
mouse.

RMS/DeskTop Facilities
The RMS/DeskTop product creates the final logical step in Mantissa’s REPORT MANAGEMENT SYSTEM. 

RMS/DeskTop is a functional composite of three facilities: the Catalog Viewer, the Report Viewer, and the Table 
Viewer. 
© 2013 Mantissa Corporation. All rights reserved.  19
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Overview Reference Guide
What is RMS/DeskTop?
Catalog Viewer
The first of these facilities, the Catalog Viewer, provides the ability to browse the reports available in a given RMS/
DeskTop system. The “File Viewer” like interface makes catalog browsing simple and intuitive. Advanced features 
make it possible to filter the available reports to a date range or other criteria. 

Report Viewer
The Report Viewer provides the ability to convert a report file from disk into a soft copy report window. Within this 
report window you can select data (by columns, lines, or streams), search for data strings within defined parameters 
(text and indexed number, date, and expression strings), modify report display attributes (display font, colors, 
greenbar overlay, and column arrangement), view multiple reports at the same time (cascaded, tiled horizontally, or 
tiled vertically), and split report windows to provide exceptional viewing flexibility.
20 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide Overview
What is RMS/DeskTop?
Additionally, the Report Viewer provides the capability to mine (extract) data from a report and create report 
annotations that can be private or shared with other users.   
© 2013 Mantissa Corporation. All rights reserved.  21
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Overview Reference Guide
What is RMS/DeskTop?
Table Viewer
Data that has been mined/indexed either from the Report Viewer or during the RMS/DeskTop import process is 
viewed using the Table Viewer. Within this facility there are capabilities to search, filter, sort, rearrange, save, and 
export index data. At any time, one can hyperlink back to a related report page. 
22 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide Overview
About RMS/DeskTop Systems
About RMS/DeskTop Systems
The diagram below shows how the various parts of the RMS/DeskTop relate to one another.

RMS/DeskTop systems are accessed by referencing the directory in which the system exists in the application’s 
SYSTEMS PATH setting. See “Application Settings” on page 249 for information about how to change the accessible 
systems for a given workstation.

RMS/DeskTop systems are created with the SYSGEN program. See “Creating RMS/DeskTop Systems (*)” on 
page 265 for information on how to create a new system.

Importing Reports into an RMS/DeskTop System (*)
Reports are brought in, or imported, into an RMS/DeskTop system with the IMPORTER program. IMPORTER 
operates based on an import definition file in the context of a single RMS/DeskTop system at a time.

An RMS/DeskTop® System

SPOOL *
RMS DeskTop

Importer*

Sysgen *

Database
Catalog 

Security

Security
Database

Storage Subsystem

Import Setup

Extraction
Definitions

System

Definitions

Logical
Printers

System

Report 
Viewer

Table

Catalog

Viewer

Viewer

RMS Report

External Report

Directory
RMS ReportImport

An RMS/DeskTop
System

Archival Storage *Direct File Storage

iDT Server *
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Overview Reference Guide
About RMS/DeskTop Systems
IMPORTER will poll directories at a user defined frequency and import reports as they are found into the system. 
The user interface allows control and monitoring of the import process.

See Chapter 9, "Data Import" for more information on importing reports or files into RMS/DeskTop.

Controlling Access to an RMS/DeskTop System
The security for an RMS/DeskTop system is controlled by each system’s security setup.

RMS/DeskTop systems may be secure or non-secure. A non-secure system does not require user authentication and 
has only one user whose user ID is Default and whose password is empty. New systems are non-secure systems. Any 
change from the non-secure setup causes a system to become secure. For example, setting the Default user’s 
password or adding another user.

See Chapter 12, "Security Setup" for more information on setting up security.
24 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide The Explorer Window
The Node Hierarchy Pane
C h a p t e r  2 :

The Explorer Window

Viewer windows display a hierarchal view of all accessible RMS/DeskTop Systems. There are two panes in the 
window; the left displays the systems’ node hierarchies and the right displays the reports in the currently-selected 
node. The size of the two panes can be adjusted by dragging the vertical splitter bar to the left or right. Any 
modifications are automatically saved to a file which holds settings for the viewer when the application exits. These 
files are typically named with a (.dte) file extension. To reopen a previously saved viewer, simply open the respective 
(.dte) file.

 

The Node Hierarchy Pane
The left side of the view displays an expandable/collapsible hierarchy of all systems that are currently accessible to 
the RMS/DeskTop workstation. Systems can be expanded/collapsed to reveal or hide nodes and report series that 
exist in each system. Report series and/or sub-nodes may exist in any node. 

Nodes will have a plus (+) or minus (-) symbol to the left of the node’s name. Clicking these symbols will cause the 
node to expand or collapse respectively. Likewise one can use the (+) plus or (-) minus keys to expand/collapse via 
the keyboard. When a system is expanded for the first time in an RMS/DeskTop session, you will be prompted to 
login to the system if the system is a secure RMS/DeskTop system. To expand all subnodes recursively for a node, 
© 2013 Mantissa Corporation. All rights reserved.  25
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The Explorer Window Reference Guide
The Viewer Report Series Pane
hold down the control key when expanding. When the selected node changes, the right side of the view refreshes to 
reflect the contents of the newly selected node. The nodes that appear will be constrained by user’s view privileges. 
The tab key can be used to move the keyboard focus from the hierarchy pane to/from the report series pane.

The tip, or most recent, version of a report series can be opened from the node hierarchy pane by double clicking on 
the report series.

 

The Viewer Report Series Pane
The right side of the view shows an expandable/collapsible list of reports (or documents) in the currently selected 
node. The reports that appear are limited by several things:

• The report series that actually exist in the node.

• The report series for which the current user has view privileges.

• The report series that have at least one version that meets any Filter criteria set

When a report series has more than one version available for viewing, there will be a plus (+) symbol to the left of the 
report ID. Click this symbol to expand/collapse viewing of prior versions of the report. Only versions meeting the 
above outlined criteria will be shown, even when expanded. 

Expand/Collapse buttons
26 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide The Explorer Window
The Viewer Report Series Pane
Series Properties
The report series pane shows various properties about each report. These properties may be rearranged, hidden, or 
shown by right clicking on the column header. A list of column headings will appear to enable the user to modify/
hide/rearrange.

 

To resize a column’s width, click on the column header’s left or right boundary and drag to the desired size. To view 
or change report properties for a selected report, use the Report menu item on the Properties menu and the Report 
Properties dialog will appear. For more information about Report Properties, see the Report View section.

Expand/Collapse button 
(for multiple report versions)

Column boundaries

Report properties
(right click on column headers to add, remove, or sort)

 (drag to resize)
© 2013 Mantissa Corporation. All rights reserved.  27
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The Explorer Window Reference Guide
The Viewer Report Series Pane
Changing how the reports are presented
The view menu or the pop-up column menus may be used to change the sort criteria for the report series view. Sorting 
is always performed on the report series, not on report versions. The report versions are always presented in their 
proper business date-based version order from most recent report version to least recent report version. Columns may 
be rearranged by right clicking, then selecting the desired header arrangement. Hiding the property can also be 
accomplished from within this same menu selection. The user may also drag the properties by clicking on the heading 
and holding down the mouse button. Dragging allows the user to set the column to their desired location. 

Explorer Properties
Explorer Properties can be found by selecting Properties – Explorer from the menu bar. As the title says these can 
only be accessed when in Explorer View. There is no need to log onto a “system” to access these properties.
28 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide The Explorer Window
The Viewer Report Series Pane
  

The Explorer Properties dialog appears. 
© 2013 Mantissa Corporation. All rights reserved.  29
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The Explorer Window Reference Guide
Viewer Filtering Report Versions
This dialog allows one to limit the number of versions that Explorer Windows will expand. This can be very useful to 
speed up access to nodes that contain report series with numerous versions. In many cases the older versions are only 
needed in special situations and are not required to be displayed all of the time.

Use the MAX REPORT VERSIONS to Show field to enter the total number of versions to be shown in the explorer view. 

Use the SHOW ALL REPORT VERSIONS field when all versions need to be visible.

Use the SHOW HIDDEN VERSIONS field to include reports from the explorer's view that have hidden attributes turned on. 
See Report Properties Dialog.

Use the BUILD TREE FAVORING SPEED field to speed up the logon process. The default behavior is to build the tree at 
once. When this option is checked, the tree is built as the user navigates around it. This option should be used only if 
the logon is taking several minutes.

Use the HIDE ARCHIVED REPORTS field to hide archived reports. This feature does not apply the hidden attribute to 
archived reports. It visually hides the archived reports.

Use the DISABLE FILTERING field to completely disable any report filtering in the Explorer. 

The FILTER BASE DATE field is used to set a date for Explorer Version Filter's relative date comparisons when Base 
Date is selected as the comparison reference. This allows a single place to set a date for which any number of filters 
may express a relative comparison. 

If the user selects the BUILD TREE FAVORING SPEED the user will notice that login time is greatly improved. This 
process is behind the scenes and no longer affects the view in the node tree.

In older releases, if the BUILD TREE FAVORING SPEED was checked the user would see that no nodes would be 
available in the left pane of the Viewer.   This option is useful if “system” logon speed is being hampered by a very 
large system, log on times will be greatly increased.

Viewer Filtering Report Versions
In the Viewer Window, filters can be attached to any element in the Node Hierarchy pane to reduce the versions that 
are to be shown for all reports at or beneath the respective position in the hierarchy. Each filter completely overrides 
any filters at a higher level of the hierarchy. 

To add or edit a filter at a given position in the hierarchy, use the “Filter...” command on the View menu, the Popup 
Menu, or the toolbar to add or change filter settings.
30 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide The Explorer Window
Viewer Filtering Report Versions
Version Filter Dialog
This dialog allows the user to specify the criteria for filtering report versions for a given portion of the repository. 
Each filter overrides any previous filter that is higher in the repository. 

All of the components are cumulative. A match is only made when all checked criteria options are met. For example, 
if Description Contains is checked and the given string is not part of the report’s description, the report does not 
match - even if the Report Mask and Version criteria match. The Date criteria specifies a date range that must be met 
for either the business or import date properties of each report version. A match occurs when the business or import 
date is within some time frame prior to a specified date.
© 2013 Mantissa Corporation. All rights reserved.  31
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The Explorer Window Reference Guide
Viewer Filtering Report Versions
For the Select when clause, choose either Business Date or Import Date as the date to be used for the test

For the is within clause, specify a number and quantity for the time span.
32 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide The Explorer Window
Viewer Filtering Report Versions
For the prior to clause, specify the reference date. Today will cause the current system date to be used. Base Date 
causes the Base Date date from the Viewer Properties dialog to be used. This is a great way to set up relative 
selection criteria. An explicit date can also be used, and should be entered in either a format of  MM-DD-YYYY or 
DD-MM-YY. 

The limit versions shown to at most criteria provides a way to limit the number of versions of the report that will be 
shown considering the other filtering criteria. For example, if you type 5 for the version limit, the largest number of 
versions that will ever be presented for the report series that the filter applies to will be 5, but the versions shown will 
have to match the other filtering criteria, if any.

The Description Contains criteria allows the description to be scanned for a particular text string. The search is case 
insensitive.

The User Field Contains criteria allows the user information to be scanned for a particular text string. The search is 
case insensitive.

When a report version matches all the supplied criteria, the report will appear in the Viewer's content (right) view 
when the report series is selected for viewing.

To disable a filter or specific filter criterion, uncheck the check box that is to the left of the criterion. When OK is 
pressed with none of the criterion checked, the filter will be automatically removed. Viewer filter settings are 
persistent. They will automatically be saved with the other viewer state information.

When a filter is present on a given element of the hierarchy, a visual cue is added to the element's icon that is much 
like the cue that indicates which nodes are selected. Filters, however, are indicated by a small triangle in the lower left 
corner of the icon. The following is an example showing some tree elements with filters attached.
© 2013 Mantissa Corporation. All rights reserved.  33
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The Explorer Window Reference Guide
Finding Reports
NOTE: If filters are disabled in the Explorer Properties the filter icon (small triangle) will continue to 
appear with the report node.

Finding Reports
The NODE HIERARCHY PANE can be searched to quickly find a node or report series. Searching can be invoked from 
the EDIT menu, the POPUP menu, or the toolbar. Simply specify some text which should be present in the report series 
specification and specify the direction to search. Searching will begin or continue from the location of the caret. 
34 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide The Explorer Window
Manipulating Reports
SEARCH DESCRIPTIONS enables the search function to search text provided in the descriptive field for the report. 

Since the NODE HIERARCHY PANE can contain more than one system, an option is provided to limit the search to a 
single system. Likewise, all systems may be searched when needed. When an attempt to search a system that the user 
is not currently logged-in is made, the user will be prompted to login to the system. Upon successful login, the search 
will continue. Use F3/F4 to repeat the search forward or backward, respectively.

Manipulating Reports
Once a report is found, it can be selected by clicking on the report with the left pointer button. A report may be 
opened into a report viewing window by double-clicking the report. Selected reports may be manipulated via either 
the File menu or the Pop-up menu. From this menu reports may be opened, exported, deleted, or printed.

 

© 2013 Mantissa Corporation. All rights reserved.  35
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The Explorer Window Reference Guide
Refreshing View Contents
Refreshing View Contents
The viewer presents a static, i.e., not automatically updated, view of system content. Since reports can be added or 
removed from the system by another user or the Importer program, it may be desirable to refresh the viewer view. 
This can be done by pressing the Refresh toolbar button or by pressing the F5 key.

 

REFRESH
BUTTON
36 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide The Explorer Window
RMS/WebAccess connection
RMS/WebAccess connection
The RMS/DeskTop Viewer now allows a seamlessly integrated view of RMS/Online documents. This is made 
possible by selecting the RMS\WebAccess icon from your Viewer’s toolbar. 

RMS/WebAccess is available by contacting Mantissa Corporation’s Sales Department at 205-968-3939 or emailing 
Sales@Mantissa.com.

The initial view will provide detailed information on Mantissa’s RMS/WebAccess.

.

RMS/WebAccess
BUTTON
© 2013 Mantissa Corporation. All rights reserved.  37
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The Explorer Window Reference Guide
RMS/WebAccess connection
Define the current ip address for the RMS/WebAccess from the WebAccess Addresses tab within the APPLICATION 
PROPERTIES DIALOG.

The RMS/WEBACCESS LOGIN DIALOG will be presented for User id and Password. 
38 © 2013 Mantissa Corporation. All rights reserved.
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Reference Guide The Explorer Window
External Documents
A valid User id and Password will bring forward RMS/Online viewable reports. Contact Mantissa Sales regarding a 
trial for RMS/WebAccess. The Document group must be a valid doc group setup within RMS/Online and must be 
supplied in the login for report viewing.

The report versions within the doc group specified are retrieved via the web for viewing.

External Documents
Though the primary focus of RMS/DeskTop is report viewing and management, RMS/DeskTop is in fact capable of 
handling other document types as well. This can be useful because RMS/DeskTop offers compression and security 
for any documents in its repository. It also offers versioning with automatic retention control. These features, 
combined with the usefulness of storing related documents together, can make adding “external” documents to an 
RMS/DeskTop system desirable.

What is an “external” document? An external document is any non-text report or file that is imported into RMS/
DeskTop. Common file types include word processor documents, HTML documents, and spreadsheets. However, 
any arbitrary file can be imported and considered an external document.

External documents are imported in much the same way that reports are imported except that their document type is 
set to “External Document” in the related Report Series Definition. When the Viewer encounters an “external” 
document, it uses the appropriate icon from the Windows registry based on the file extension of the document. For 
this reason, it is important to name external documents placed into RMS/DeskTop with a report name that ends in an 
appropriate extension for the underlying file type (e.g., MySpreadsheet.xls for an excel spreadsheet).

The RMS/DeskTop installation CD contains Windows Internet Explorer plugin viewers for external documents, 
including MS-Word, MS-Excel, VISIO, and Adobe Acrobat. RMS/DeskTop relies on appropriate programs being 
registered to handle the file in your Windows environment. If no program is registered to handle a given “external” 
document, a prompt will be presented for selection of an appropriate program when an attempt to open the document 
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Desktop Viewer Plugins
is made. Otherwise, the registered program will automatically be opened to view the document. If no viewer exists 
for a given “external” document, the only useful operation available from RMS/DeskTop for the document is to 
export the document.

NOTE: RMS/DeskTop does provide native support for AFP viewing.

The page count and line count report properties are not applicable to external documents. They will both show zero 
values.

The following shows the Viewer with both "report" documents and “external” documents. 

When an external document is opened, the document object is retrieved from the repository and uncompressed into 
the application’s temporary disk storage area. The associated viewer is then launched for the temporary disk file. 
RMS/DeskTop will attempt to delete the temporary files from the application’s temporary disk storage area when 
exiting. However, any files that are open at the time RMS/DeskTop exits will not be deleted. If the viewer for the 
external document does not keep the viewed file open, closing RMS/DeskTop can cause the file to be no longer 
available to the viewer. Also, if necessary, a toolbar command for the File command category is available to delete 
these temporary files during an RMS/DeskTop session.

Desktop Viewer Plugins
Viewer Plugin capability is available within RMS/DeskTop. This dialog is used to add documents' extensions for 
external document viewing. If an extension is defined to the Viewer Plugin dialog within the Application Properties 
Dialog for your system, RMS/Desktop launches its plugin for viewing inside RMS/DeskTop. 

For example, PDF documents are very prevalent in office environments. You can download the PDF viewer from 
Adobe's website and install it on your local computer. In order to view a PDF document that was imported into your 
Desktop system, you can simply add PDF to the list of extensions. When the PDF document is accessed by double-
clicking, RMS/Desktop lets you view it inside the viewer without having to launch the Adobe Acrobat Reader. 

NOTE: It is the responsibility of the user to locate and install the various plugins, if they do not already 
have the appropriate programs installed on their computer.
40 © 2013 Mantissa Corporation. All rights reserved.
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Index Documents
AFP is also another type of document with a plugin that you can install. Although its plugin is very functional, its 
toolbar lacks some important features. RMS/DeskTop’s native AFP support is tightly integrated with the RMS/
Desktop Viewer and does not have limitations like the plugin. Contact the Mantissa Customer Support Department 
for information on Mantissa’s native AFP support.

Microsoft also has free plugins available for Internet Explorer that you may find useful. Mantissa has downloaded 
plugins from its website for Word, Excel, PowerPoint, Visio, and Access documents. We also have a plugin for 
PostScript documents. 

Once you have defined the plugins they will appear at the bottom of this screen under “Globally-defined document 
types.

Index Documents
One additional document type that can exist in the viewer is an Index Document. Index documents can be placed into 
the repository in two ways:

• As an Attachment to a specific report version
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• As an Index Document

Indices that are attached to specific report version do not appear in the viewer. They must be found or explored from 
the specific report version of interest.

Top-level index documents do appear in the viewer. These index documents are added to the viewer by performing a 
“Save Index” command from a Table View. Index documents can be opened directly within RMS/DeskTop and can 
be used to hyper-link to the related report information. Index documents are managed separately from the report 
versions from which they were created, therefore a hyper-link to the report will only be possible if the report version 
exists within the repository at the time the jump is attempted. 

Index documents can be deleted or retained independently of the related report data.

One useful type of index document is produced by performing an extraction across more than one report or report 
version. This technique can create a cross report index, which can be very useful for comparing or reviewing data 
from multiple reports. Since a cross report index cannot be purely associated with any one report version, it must be 
saved as a top-level index document. 

For more information on cross-report indices see Cross Report Indices in the chapter entitled, Extracting Data from 
Reports.

The following is an example of the Viewer showing both Report and Index Documents.
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View of the Processed Draft Register Index when opened:
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An index document can be saved as a document to any report.  For clarification we have chosen to save an index on 
to the \Banking\Misc\540 Report Series Mask.  Once saved and the Viewer is refreshed the index is shown as a 
separate document.  See "Register Report" attached to the \Banking\Misc\540 report below.    
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Importing Documents
In most typical production report management setups, documents will primarily be imported into an RMS/DeskTop 
system via the Importer program. However, for ad hoc non-repetitive situations, one can import reports or external 
documents into a given system from the Viewer Window.

To import a report, first ensure you have the security rights to import documents into this specific report series.  Then, 
select the appropriate destination within the Viewer’s NODE HIERARCHY PANE for the document(s). Select the IMPORT 
menu item from either the FILE or POPUP menu. This will cause a standard FILE OPEN dialog to appear.  
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Select the documents (files) to be imported and press the OPEN button. More than one file can be selected if 
appropriate. Once the files are selected, the following IMPORT DOCUMENTS dialog will appear.

NOTE: Ad hoc imports can only be performed if the user has the appropriate security rights.
46 © 2013 Mantissa Corporation. All rights reserved.
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Use the IMPORT DESTINATION tree to select a SERIES or node specification for the import destination. Alternatively, 
one can simply type the SERIES into the respective text entry control.

Use the DOCUMENT text entry control to specify the name the document will have in the repository.  If a document 
name is added in the Document field the user must provide the extension for the filetype manually.  This is most 
critical when the user has selected an External Document file type.  If the extension is not provided the file is 
imported, however the file cannot be opened in the report viewer. 

Alternatively, check the USE FILE NAME checkbox to use the last part of the file name as the document name.

Use the DESCRIPTION text entry control to supply a meaningful description of the document’s contents (if desired).
© 2013 Mantissa Corporation. All rights reserved.  47



R
D

_C
ha

pt
er

_0
2.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3

RMS/DeskTop® Version 3.25 

The Explorer Window Reference Guide
Importing Documents
The IMPORT AS selection must be used to indicate to RMS/DeskTop whether the file(s) being imported are TEXT 
DOCUMENTS or BINARY DOCUMENTS. Chose TEXT DOCUMENT if the files are known to contain report data that is to be 
manipulated by RMS/DeskTop; otherwise choose BINARY DOCUMENT. If more than one file is selected for import, 
all files must be of the same IMPORT AS type. External documents are not viewed within RMS/DeskTop, but are 
subject to versioning and security controls like TEXT DOCUMENTS. Most documents imported into RMS/DeskTop will 
be TEXT DOCUMENTS.

Within RMS/DeskTop, the Business Date of a document is important because it determines the version order of 
documents. Use the SET TIMESTAMP USING selection to indicate how the BUSINESS DATE for the documents should be 
determined. There are three options available, as described in the following table:

Once all the import selections have been made, press the OK button and the import process will begin. During this 
process, an IMPORT PROGRESS dialog will appear that will show the various steps and progress for each file being 
imported.

 

The CANCEL button on the IMPORT PROGRESS dialog can be used to cancel subsequent file imports when more than 
one file is queued to be imported.

Set timestamp using Business date is selected based on...
Current time The time the file is imported.
Time from file being imported The timestamp associated with the file that is being 

imported.
Matching Report Series Rules The document’s complete series specification is used to 

find a most appropriate matching report series defini-
tion, and the matching report series’s SET THE BUSINESS 
TIMESTAMP USING attribute is used to determine how the 
Business Date for the document is determined.
48 © 2013 Mantissa Corporation. All rights reserved.
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Exporting Multiple Documents
From the Explorer, one or more documents may be exported. To begin exporting, select the documents to be exported 
from the content pane. Next, issue the Export command from either the File or popup menu. 

This will cause the following Export Queue dialog to appear. 
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Exporting Multiple Documents
 

Export Queue Dialog
The Export Queue dialog provides a way to view and control the export of report data. This dialog is modeless, and 
may be opened whenever report data is selected for export by pressing the Export menu item from the File menu. You 
may also select the export queue from the Popup menu by right clicking the mouse. This window may be closed at 
any time. Closing the window has no effect on the reports in the view.

The view is broken into two tabular sections:

• the export setup and confirmation section

• the export progress and cancellation section

The Export Setup and Confirmation Section
The top section, which is the export setup and confirmation section, shows reports that have been submitted to be 
exported and have not yet been confirmed. Each row of the table shows a single report export request and allows the 
export attributes for that report to be set prior to performing the actual export operation.

Use the cells of the table to make refinements to each report as needed.

The REPORT NAME is a view only cell which shows the name of the report to be exported.

To change the destination file or modify the exported report’s name, either double click the FILE NAME cell or press 
the (...) browse button to the right of the file name to select the new destination and or file name.

The FILE TYPE cell allows you to output the file in ASCII or PDF format.

The EXPORT RANGE cell will initially contain the complete page range from the export request, however, the page 
range may be changed by double clicking the cell and modifying the range. The page range entered for both text or 
PDF documents should be single page numbers; or page ranges separated by dashes or commas. 
50 © 2013 Mantissa Corporation. All rights reserved.
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The FILE OPTIONS cell allows you to modify properties for PDF documents. Text documents can only be exported 
with the report option. PDF documents may be exported with either Report or Report with options. Options may 
include the report only, report with annotations, report with note content, report with bookmark list and the report 
with the highlight list.   If Report with options is selected the following Export Options dialog will be opened for 
specific export options.

The APPEND OUTPUT cell provides control over whether the destination file will be truncated or appended during the 
export. Check the checkbox to cause the output file to be appended or uncheck the checkbox to cause the output file 
to be overwritten. Currently PDF document exports do not append. 

EXAMPLE: Append Output - If, for example, a number of reports are to be exported in a con-
catenated fashion to the same file, do the following. Set all of the output file names to the same file 
name; uncheck the first Append Output checkbox for the first report to be exported, and check the 
remaining Append Output checkboxes; using the Export button, export the reports in the order you 
wish the reports to appear when appended.
© 2013 Mantissa Corporation. All rights reserved.  51



R
D

_C
ha

pt
er

_0
2.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3

RMS/DeskTop® Version 3.25 

The Explorer Window Reference Guide
Exporting Multiple Documents
Once the appropriate settings have been made in the export setup and confirmation section, press the EXPORT button 
to the left of each report to confirm the export request for the report. Alternatively, the Export All button may be 
pressed to confirm the export of all reports.

The order of the reports in the setup and confirmation section are only significant when the EXPORT ALL button is 
pressed. The order, from top to bottom, corresponds to the order that the reports will be confirmed for export when 
the EXPORT ALL button is pressed. Use either the popup menu or the following buttons to reorder or delete the reports 
in the setup and confirmation section::

The Export Progress and Cancellation Section
The bottom section, which is the export progress and cancellation section, shows any reports which have been 
confirmed to be exported. The top row of this table shows the report currently being exported. Reports queued to be 
exported follow in the order that they will be exported from top to bottom.

The Progress cell shows a progress indicator for the report being exported. The other cells simply show the export 
settings that will be used to export the report.

To cancel or abort a report which is either being exported or to be exported either use the CANCEL ALL button, the 
Delete choice on the popup menu, or the Cancel button shown below under Action. Use the CANCEL ALL button to 
abort all in-progress exports.

This button is used to move an export request down in 
the upper, setup and confirmation section. This button 
is used to move an export request up in the upper, 
setup and confirmation section.
This button has two uses. When the report selected 
has already begun exporting, this button stops the 
exporting process and deletes the output file from 
storage; otherwise, the export request for the report is 
simply removed.
This button has two uses. When the report selected 
has already begun exporting, this button stops the 
exporting process and deletes the output file from 
storage; otherwise, the export request for the report is 
simply removed.
52 © 2013 Mantissa Corporation. All rights reserved.
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Printing Documents
From the Explorer, one or more documents may be printed. To begin printing, select the documents to be printed from 
the content pane. Next, issue the Print command from either the File menu, the popup menu, or the toolbar. If 
multiple documents were selected, the following Print Queue dialog will appear. 

The Print Queue dialog provides a way to view and control the printing of multiple reports. This dialog is modeless, 
and may be opened at any time by pressing the Print Queue menu item from the Window menu. It will also appear 
whenever more than one report is selected to be printed at one time from the Viewer Window. This window may be 
closed at any time. Closing the window has no effect on the reports in the view.

The view is broken into two tabular sections:

• the print setup and confirmation section

• the print progress and cancellation section

The Print Setup and Confirmation Section
The top section, which is the print setup and confirmation section, shows reports that have been submitted to be 
printed and have not been confirmed. Each row of the table shows a single report print request and allows the print 
attributes for that report to be set prior to performing the actual print operation.

Use the table cells to make refinements to each report as needed.

The Report Name is a view-only cell which shows the name of the report to be printed.

The logical printer that will be the destination for the report may be selected using the Printer cell. To change the 
print settings for a given report either double-click the Printer cell or press the button to the right of the logical printer 
name to be changed.
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The Page Range cell will initially contain the page range from the print request. However, the page range can be 
changed by double-clicking the cell. This can be a comma separated list of pages or page ranges. For example, 1,3,5-
7 to print pages 1, 3, and 5 through 7. Additionally, page ranges can be specified in reverse order, like 7-5, which 
would cause pages 7, 6, and 5 to be printed in that order.

Once the appropriate settings have been made in the print setup and confirmation section, press the Print button to the 
left of each report to confirm the print request for the report. Alternatively, the Print All button may be pressed to 
confirm the printing of all reports.

The order of the reports in the setup and confirmation section is only significant when the Print All button is pressed. 
The order, from top to bottom, corresponds to the order that the reports will be confirmed for printing when the Print 
All button is pressed. Use either the popup menu or the following buttons to reorder or delete the reports in the setup 
and confirmation section:

The Print Progress and Cancellation Section
The bottom section of the Print Queue dialog, which is the print progress and cancellation section, shows any reports 
which have been confirmed to be printed. The top row of this table shows the report currently being printed. Reports 
queued to be printed follow in the order that they will be printed from top to bottom.

The Progress cell shows a progress indicator for the report being printed. The other cells show the print settings that 
will be used to print the report.

To cancel or abort a report which is either being printed or to be printed either use the Cancel button, the Delete 
choice on the popup menu, or the delete button shown above. Use the Cancel All button to abort all in-progress 
printing.

Moves a print request down in the upper setup and 
confirmation section.

Moves a print request up in the upper setup and confirmation 
section.

Removes a request to print a report.
54 © 2013 Mantissa Corporation. All rights reserved.
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Emailing Documents
From the Explorer, a document may be sent to another user via e-mail. Just select the document to be sent from the 
content pane. Next, use the Email command from the File menu or the popup menu (right-click report). A dialog 
similar to the one below will be shown where you can set properties like page range, text or PDF output, forms 
overlay, etc..

The most important field in this dialog is the Mail Server. You will need to enter your outgoing mail server’s address 
in order to send the e-mail. You can find such information in the properties or settings for your e-mail account with 
Outlook, Outlook Express, Eudora, or Thunderbird. If you are not sure, ask your internet administrator.

The Report Range and Report Properties tabs are used to set the range of pages and properties related to the look and 
feel of the report’s output.

NOTE: In order to send your report in PDF format you will need to have a logical printer associated with the report 
in question. You can learn more about printing in Chapter 7: System Setup and Printing Reports section in this 
chapter.

Address Buttons
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The Address Buttons are used to add, edit, remove, or select e-mail addresses.You will get a dialog like the one shown 
below where you can perform these functions.
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C h a p t e r  3 :

The Report Viewing Window

The Report Viewing Window displays an individual report version whose business date, system name, and report 
series specification are shown in the title bar. A large number of features are available to find information, alter the 
view, and even extract information from the report views, but modification of the underlying report data is never 
allowed. Below is an example of a basic report view. 

Splitting the View
The view may be split into multiple semi-dependently scrollable panes for added viewing flexibility. Splitting the 
view can be accomplished several ways.

• Selecting Split from the Window menu.

• Dragging down the small bar that is just above the vertical scroll bar.

• Dragging to the right the small bar that is just to the left of the horizontal scroll bar.

• Double-clicking either of the small bars to split the view into two even halves.

The view shown below was created by dragging the vertical splitter handle down so that the column headers in the 
report can remain visible as the bottom portion is scrolled.
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To remove a splitter from a view simply double-click it or drag it to the edge of the view and drop it.
58 © 2013 Mantissa Corporation. All rights reserved.
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Changing Colors or Font
The appearance of the report is customizable by selecting the preferred font and colors. This is done by selecting 
Font or Colors from the Format menu respectively. The font dialog is a standard windows font selection dialog. The 
Report Viewing Colors dialog lists each color used in the report view and allows adjustment as appropriate to the 
background and foreground colors for each item. The report view has three presentation styles: Greenbar, Form 
Overlay and Normal. When viewing in the greenbar style, the colors with the Green Bar prefix are used. When 
viewing in the normal style, the colors with the Normal prefix are used when viewing in the Form Overlay style, the 
report is presented with the graphic report overlaid with the report text. The presentation style can be selected from 
the colors dialog or by using the greenbar toggle button on the toolbar

.

Report Viewing Colors
This dialog allows the user to specify the colors used by the report view.

Changes will apply only to the current report view unless the Update All Views check box is checked.

The Color list box shows each configurable color by name and a sample of the current setting.

To change a color, first select the color in the list. Next, use the Foreground or Background button to change the 
respective color attribute. The standard Windows color selector dialog is used for selecting colors. Some colors may 
only have a background setting.
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The Drawing Optimization provides a choice of how text will be drawn by the application. The Favor Speed option 
selects a faster text drawing approach, but causes colors to be converted to their nearest solid color. The Favor Colors 
option uses the actual colors selected, but uses a slower drawing approach. Select the option that works best for your 
environment.

When the Green Bar check box is checked the report is displayed in traditional green bar form with alternating 
background colors. This setting can also be controlled with the toolbar toggle button shown below

.

The Default Colors button will cause all color settings to revert to their factory default settings.

The following describes the use of each color name:

View/Hide Greenbar 
60 © 2013 Mantissa Corporation. All rights reserved.
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Color Name Color Use

Normal Text Text foreground and background when viewing a report without greenbar.

Normal Page Background Color surrounding the page (i.e., the background of the window) when viewing a 
report without greenbar.

Green Bar 1 Text Text foreground and background for the odd bars when viewing a report with 
greenbar.

Green Bar 2 Text Text foreground and background for the even bars when viewing a report with 
greenbar.

Green Bar Page Background Color surrounding the page (i.e., the background of the window) when viewing a 
report with greenbar.

Selected Text Text foreground and background for selected text.

Target Highlight The color used when circling a search or hyper link target.

Target Line Highlight The background color used to highlight the entire line that contains a highlighted 
target. This helps one to see that there is a target highlight somewhere on the line. 
This is most useful when the report is too wide to fit completely within the current 
view.

Extract Keyline/Field Highlight The color used to outline keyline and field definitions when there is an extraction 
definition open for the report. Note: Regardless of the drawing optimization, this 
color will be converted to the nearest solid color.

Rearranging Columns
The report’s presentation can be rearranged so that columns are hidden, stripped, or presented in any order necessary. 
To rearrange the view, select Column Rearrange from the Format menu which will present the Column Rearrange 
dialog. Searching operates on the rearranged view, so this is one way to change the behavior of a report text search.

Column Rearrange Dialog
This dialog allows the user to rearrange the columns of report text in a single view.

The Column Viewing Arrangement specifies a list of column ranges that should be shown. Either type the column 
ranges or select a recent column arrangement from the drop-down list. Each column range is specified as either an 
individual column or a range of columns specified as two column numbers separated by a dash (-). An asterisk (*) can 
be used as a to-end-of-line indicator. Each column range should be separated with a comma.
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For example,

14, 1-20, 32-40, 21-31, 76-*
Columns can overlap, be out of order, or be duplicated as necessary.

The application remembers the last ten column arrangements. This aids in quick recall of rearrangements frequently 
used. The Clear History button clears all entries from the recent arrangement list.

To return to a normal 1-* column arrangement either use the Disable Rearranger check box or clear the column 
viewing arrangement.
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Calculate Column
Columnar selections of numbers can be calculated. This feature will produce a sum, max, min, and average for the 
selected numbers. To access this feature, (1) select a column of numbers and (2) click the Column Calc menu item 
from the popup menu for the selection.. 

The Report View Ruler
It is sometimes handy in the report view to be able to determine the line and column position of various report 
contents. One case of this is the previously mentioned Column Rearrangement feature. When using other features of 
the product, character coordinate determination can be useful as well. The line and column position for the current 
cursor position are shown in the status bar for an active report view. For even better coordinate pinpointing, a 
character and page-line ruler is available in the report view. The ruler can be toggled on and off in the application by 
selecting the Ruler menu item from the View menu or by selecting the Ruler toolbar button. When the ruler is 
displayed, you may also select entire rows or columns by clicking and dragging across the ruler. Below is an example 
of the report view with the ruler visible.
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If the ruler is not currently on your toolbar, you may add the ruler button by editing the toolbar by accessing the 
Customize dialog from the Toolbars Dialog under the View menu. Select the desired Command and drag to the 
toolbar.

Vertical Scrolling
The report view may be scrolled vertically with the vertical scroll bar. Since RMS/DeskTop handles very, very large 
reports (in some cases millions of lines), it is more user friendly to use the GoTo options shown CTRL+ALT+G, from 
the report view’s EDIT menu; or from the report view click on the “LINE # COL #” icon. In both instances the GOTO 
SPECIFIED LINE dialog will be opened to allow you to enter your specified line destination.

The GOTO SPECIFIED LINE dialog is shown below.
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The GOTO SPECIFIED PAGE is shown below.

Scroll Tips and Fine-Tuned Scrolling
If you have a general idea of the desired position but aren't sure of the exact page or line number, you can use the 
vertical scroll bar to quickly move to a general position in the report. As you position the scroll bar, a small window, 
or scroll tip, will appear alongside the scroll bar. It displays the page number that appears at that scrolling position. 
Once you've positioned the scroll bar in the general area of interest, the view can be smoothly scrolled to specific 
positions by pressing the space bar (which changes the mouse cursor to a hand), then clicking and dragging the view 
to the exact location you want to see.

Keep in mind that several keyboard commands are available to make report navigation quick and intuitive. For a 
complete list of all available commands, refer to Report View Keys.
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Goto Report Page Dialog
If you know the exact page or line number that you want to view, you may prefer to jump directly to the page by 
entering the page number in the GOTO PAGE dialog or the line number in the GOTO LINE dialog. You can access the 
GOTO PAGE dialog by typing CTRL+G, clicking on the “PAGE # OF #” status bar indicator, the GOTO PAGE toolbar 
button or choosing GOTO PAGE from the report view's EDIT menu item. 

This dialog is used to specify a Destination Page in the report to immediately jump to. Any number over the actual 
number of pages in the report will create an RMS\DeskTop dialog asking the user to enter a page number between 
page 1 and a page ? which is truly the correct integer. 

Working with Pre-Printed Forms
Reports are often printed on pre-printed forms paper. A pre-printed form may contain column separators, descriptive 
labeling or other information needed to interpret the report's data content.

The forms overlay facilities in the report view make it possible to view a report on-screen as it would appear on the 
pre-printed form. A rough draft of the final report may be printed without using the pre-printed form paper.

NOTE: Viewing pre-printed form images requires sufficient display hardware. Your display should be 
set to display at least 256 colors. For the best results, 16-bit (64K colors) or 24-bit (true color) 
settings are required. Launch the Windows control panel “Display” pallet to confirm you are 
using sufficient settings.

Creating Pre-Printed Form Images
The initial creation of a pre-printed form image requires additional third-party software and hardware, including 
image scanning hardware and image manipulation software. This task is an administrative function and is not 
normally provided to the end-user. 

Administrators are to refer to the operating instructions provided with your scanner and imaging application for 
assistance in scanning your pre-printed forms.

For best results, scan the image using 96 dots-per-inch (DPI) resolution. This resolution matches the DPI setting used 
for most display resolution settings in the MS Windows environment. Higher scanning resolutions may be used if you 
plan to print the form image. However, doing so will result in longer processing times when the image is loaded into 
RMS/DeskTop.

Once the form has been scanned, perform any needed image manipulations (rotation, cropping, brightness/contrast 
adjustments, etc.) in your image manipulation software. While RMS/DeskTop provides these operations, they are 
performed in a “non-destructive” manner. This means that none of the adjustments are applied to the original source 
image. All of the selected operations must be reapplied each time an adjustment is made or whenever the image's 
content changes. These operations will result in longer processing times when the image is loaded into RMS/
DeskTop.
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When satisfied with the form image, save it in a format recognized by RMS/DeskTop. RMS/DeskTop supports the 
Joint Photographic Experts Group (JPEG) open standard, PC Paintbrush (PCX) images and Windows bitmap (BMP) 
files. You should use the JPEG format for grayscale or full-color images and the PCX format for black and white 
images. Only use the BMP format if your imaging application doesn't support either the JPEG or PCX formats. The 
BMP format doesn't provide any form of image compression. This results in very large image files, particularly when 
creating full-color images.

Assigning Form Images to Reports 

Form images are assigned to reports via the report's associated report series definition. The Forms tab in the Report 
Series Definitions dialog lists the currently-assigned form images and allows you to delete, add or modify the form 
image entries.

 Deletes the selected form image from the list. This action does not permanently delete the form image 
file. It only removes the form image from the selection list for reports imported using this report series 
definition.

 Creates a new form specification.

 Activates the selected form for editing. You may also double-click on the form to edit it. The Select 
Form dialog will appear when the specification is being edited.
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Whenever you add a new form specification or edit an existing one, the Select Form dialog will be displayed. It 
allows you to select a form image, name the image and specify if it will be the default form. The default form is 
automatically selected by default when a report is first opened.

Viewing Form Images in the Report View
When pre-printed forms are used, the report data may be printed on a limited portion of the form. Some examples of 
this are skipping the form's top portion to avoid printing on top of your company's logo and address, or leaving 
another portion of the form's area blank to allow for handwritten information, such as customer comments on an 
invoice.

While the report data could contain blank lines to skip these areas, they may also be skipped by adjusting the printer's 
“top of page” position, or by sending “form feed” commands to skip the remaining portion of a page.

When the latter techniques are used, the length of the report's data content for a page will not match the form's length. 
For example, the form's length may be 66 lines, while the page's report data may consist of only 42 lines. These 
differences are taken into account in the report view when forms are being displayed, but result in minor changes in 
the report view’s behavior.

If the pages' data content comprises only a portion of each page, there will be gaps between one page's data content 
and another's. These gaps will not contain selectable data. They cannot be copied to the clipboard or have any of the 
annotation tools applied to them. In effect, these areas do not exist as far as the text selection, copying and annotation 
tools are concerned. Text selections across multiple pages are still possible, but the blank regions will not be selected. 
All other aspects of the report view's behavior should be the same.
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Adjusting Form Overlay Properties
 

A form's dimensions, top-left print margins and characters/lines per unit of measurement must be specified in order to 
be displayed correctly. To do so, open the Form Overlay Properties property sheet by selecting the Form Overlay... 
menu option from the Properties sub-menu.

The Form Overlay Properties property sheet is modeless, meaning you may continue to perform operations in the 
report view while it is open. This allows you to adjust the report view’s viewing position or make other adjustments 
while modifying the form overlay’s properties.

NOTE: Keep in mind that all image adjustments made in this property sheet must be applied to the 
image each time any of the adjustments are changed. This is referred to as “non-destructive” 
editing. These operations will increase the time required to initially open the report or display the 
form image. Therefore, you should make image adjustments to the source image using a third-
party image manipulation application whenever possible.

Adjustments made in this property sheet may be applied to the report, the associated report series or this report’s 
parent node. 
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Note: If you attempt to apply a form overlay at the parent node level and a report within this same node already has a 
form overlay defined you will be promted by RMS\DeskTop and asked whether you wish to have the previously-
applied properties deleted and the newly defined form overlay assigned.  An example of the dialog presented follows:

Adjustments may be previewed in the property sheet by selecting the Preview button. The form's thumbnail image in 
the property sheet will be updated.

Once satisfied with the settings, apply them to the associated form image by selecting the Apply button.

Making Dimension Adjustments
The property sheet's Dimensions tab allows you to specify a pre-printed form's dimensions and print margins. Any 
unit of measurement (inches, centimeters, etc.) may be used, so long as the same unit is being used for all entries in 
this tab.
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The Lines per unit, Characters per unit, Width and Height edit fields must be correctly specified in order for the 
report's data content and the form image to be properly aligned. You must also specify the Left and Top margins if 
your report's data content is restricted to a portion of the printed form.  
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Working with Pre-Printed Forms
Adjusting the Image's Cropping/Rotation
 

The property sheet's Cropping/Rotation tab allows you to make adjustments to the portion of the source image being 
used and its orientation. These adjustments are useful if they are not provided in your image manipulation software.

The Left, Top, Right and Bottom cropping adjustments use character cell coordinates as their unit of measurement. 
You may enter fractional values, if needed. The use of cell coordinates allows you to view the form image in the 
report view and visually determine the amount of cropping needed.

You may want to enable the report view rulers to aid you in determining the cropping values.

The Rotate edit and circular slider controls allow you to adjust the orientation of the form image, in degrees, down to 
fractional values. This may be used to correct the image's orientation (landscape vs. portrait) or to make minor 
adjustments if the form was scanned askew.
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Working with Pre-Printed Forms
Form Selection and Brightness/Contrast Adjustments
 

The Options tab allows you to select from a list of form images assigned to the associated report (via its report series 
definition) and adjust a form image's visibility.

The Name combo box contains a list of all available form images for the report as well as a selection labeled 
“(None)”, allowing you to clear any existing form image assignment. 

The Brightness and Visibility slider controls adjust the image's color and translucency levels. Possible settings for 
brightness range from -99 to +99 percent, with a value of 0 percent resulting in an unchanged image.

Possible visibility settings range from 0 to 100 percent, which control the mixing of the form image and the report's 
background color. A setting of 0 percent results in the form being invisible (the report's background color is displayed 
100 percent), while a setting of 100 percent results in the form being fully visible.

The Flip Horizontal and Flip Vertical buttons provide a quick and easy means of flipping the image horizontally or 
vertically, respectively. The buttons will be displayed in their depressed state if the image is being flipped 
horizontally and/or vertically.
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Report Annotations
Report Annotations
It can often be useful to leave notes or highlights on a report for yourself or others to see during subsequent viewing. 
Annotations provide a way to draw attention to or make comments on specific report data. There are three annotation 
tools provided: highlighting, notes, and bookmarks. Highlighting works just like a highlight marker on paper--the 
background behind highlighted portions of the report changes to a bright yellow, or otherwise chosen, color. Notes 
look like a yellow sheet stuck to the report. Bookmarks are positions in the report that can be used to quickly return to 
specific viewing positions.

NOTE: Your ability to create, modify and/or view annotations depends on your user account having the 
appropriate security access rights. These rights are specified on a per-report basis, so your 
rights may vary depending on the currently-open report. Check with your system administrator if 
you need to use report annotations and do not have the appropriate security rights.

Annotation Toolbar Commands
The easiest way to add or manipulate Annotations is to use the associated toolbar buttons. The image below shows 
the relevant toolbar buttons that affect annotations and their basic function. 

When not manipulating an Annotation, the Text Selection Tool is normally depressed. Note creation interactions 
behave as semi-modal interactions. Once the Note Creation Tool is selected, the application expects a selection to be 
created to conclude the creation operation (if one does not exist when the respective button is pressed). The report 
view will remain in this mode until either a selection is made or the user re-selects the Text Selection Tool. A similar 
behavior occurs with the Delete Annotations Tool, except the delete mode remains until either an Annotation is 
deleted, you press the Esc key or click on the report background. Highlight creations are also semi-modal except that 
the mode is not canceled until the user clicks on the Text Selection Tool.

Public Annotation
Private Annotation
Bookmark Creation Tool

Highlight Creation Tool
Text Selection Tool

View/Hide Bookmarks

View/Hide Highlights
View/Hide Annotation Manager

Note Creation Tool

View/Hide Notes

Delete Annotation Tool

(leaves annotation node)
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Report Annotations
Annotations may be either shown or hidden as required. To toggle the viewing or hiding of annotations, select All 
Annotations, Highlighting, Notes or Bookmarks from the Annotations sub menu of the View menu, or press the 
corresponding toolbar buttons.

Creating Annotations
Annotations can be created by selecting a portion of the report and choosing from the Insert menu the Highlight, 
Note, or Bookmark menu commands. Toolbar equivalent commands are available as well. The selected area will be 
immediately changed to a highlighted area, note, or bookmark respectively. Bookmarks are somewhat different in 
that they only leave a locator at the caret’s current location; however, the selection is used as a suggested title for the 
bookmark. You may also choose either of the Insert Highlight or Insert Note commands without a selection being 
made, then drag the cursor across the screen to interactively create a highlighted area or note at any size you desire. 
The following shows a report with both a Highlight and a Note. There is no practical limit to the number of 
highlights, notes, or bookmarks that can be placed on a report.

 

Public vs. Private Annotations
Annotations may be created for either public or private access. Public annotations can be seen or changed by anyone 
that has access to the report. Private annotations only appear when the user that created the annotation opens the 
report.

To specify the annotation type, first click either the Highlight Creation Tool or the Note Creation Tool. Once 
depressed, the application will enable the Public and Private menu items in the Insert menu and the corresponding 
toolbar buttons. Select Public or Private from the Insert menu or toolbar as appropriate for the annotation to be 
created.

Note Tool Highlighter Tool
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Report Annotations
 

NOTE: If "Private" or "Public" is selected for your notes, this setting will then become the default for 
subsequent reports that are viewed.

(selected)
Public Annotation

Private Annotation (selected)
New Creation Tool
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Report Annotations
Revising Annotations
Highlighting can't be adjusted after it's initial creation. If you want to change the highlighted area, delete the existing 
highlight and create a new one or just add more highlighting if you want to extend the highlight.

A note's content may be edited by moving the mouse cursor on top of the note and clicking when the cursor changes 
to a text “I beam” shape. If you are editing a public note, a combo box control will appear in the caption area after 
subsequent edits. Click the drop-down button to display a list of revisions. The most recent revision appears at the top 
of the list. The text for a given revision is displayed when the revision is selected from the drop down list.

The following is an example of a public note with revisions.

 

Resizing or repositioning notes is similar to adjusting application windows. If you want to resize a note, move the 
mouse cursor on top of it's edges. When the cursor's shape changes to an arrow, click and drag the edge to a new 
position. To reposition a note, click in it's caption area (the top portion of the note that states the note's author and 
creation date) and drag the note to it's new position.

Minimizing Notes
In addition to hiding all notes from the view, individual notes may be minimized by clicking the small minimize icon 
in the upper right corner of the note. This causes the note to be reduced to a small icon in the left margin of the report 
view. To restore the note to a visible state, click the respective icon in the left margin.
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Report Annotations
In addition to simply de-cluttering a view, the note minimization feature can be useful when printing a report to cause 
specific (minimized) notes to be skipped during printing. See Chapter 6 regarding “Report Printing” and review how 
to skip notes while printing a report.

Using Bookmarks
In addition to the methods described above for creating Bookmarks, a keyboard shortcut (CTRL+F2) is available to 
quickly add bookmarks at the current caret position. By default, creating a bookmark causes a dialog to appear that 
requests a title for the bookmark. This can be avoided by unchecking the PROMPT FOR BOOKMARK TITLE on the 
APPLICATION PROPERTIES dialog, which may be accessed via the APPLICATION menu item on the PROPERTIES menu.

To jump to the next or previous bookmark from the current position simply press the F2 or SHIFT+F2 key strokes 
respectively.

Deleting Annotations
You can delete any highlighting, private notes or public notes, or bookmarks that were originally created by you. To 
delete an annotation, select the Delete Annotation menu command from the Edit menu or select the Delete 
Annotation toolbar button, then move the mouse cursor on top of the annotation. If the annotation can be deleted, it 
will alternate between it's regular appearance and a selected appearance. Click on the flashing annotation and confirm 
it's deletion to remove it from the report.

Minimize Icon
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Report Indices
The Annotation Manager
Once you've created multiple annotations, you may want to view a list of them, jump directly from one annotation to 
another or quickly delete multiple annotations. The Annotation Manager provides a convenient interface for doing all 
of these things. The Annotation Manager is a tool window that will appear (if enabled) whenever a report view is 
active. You can dock the tool window onto the main application window or drag it so that it becomes a floating 
window, just like the tool and menu bars. 

 

The Annotation Manager tool window contains navigation and deletion buttons, a tree view control that displays the 
annotation contents for the currently-active report view and three tabs that allow you to change the tree view's display 
contents to notes, bookmarks or highlights.

When you view notes, you may see a plus sign to the left of the note content in the tree view control. This allows you 
to expand the content to review past revisions to the note. Keep in mind, however, that only public notes store 
multiple revisions.

NOTE: Notes, Bookmarks and Highlights can be deleted from Annotations only by the person that 
created them.

Report Indices
Reports may have zero or more indices. An index is produced by an extraction which pulls selected information from 
a report using an extraction definition. If a report has an index, there will be a menu item at the bottom of the View 
menu for the report. If there are multiple indices, the menu item will pop-up a list of indices that may be opened. In 
this list there will always be a selected index which changes to the most recently opened index as indices other than 
the primary index are opened.

New Creation Tool
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Extraction definitions may be saved locally or in on the network for sharing. Only administrators have the ability to 
save to any location other than their own local drive. The administrator may choose to save the extraction definitions 
on the server. If a non-administrative user creates an extraction, these .exi definitions are saved to the user’s local 
machine. If it is a requirement that an extraction definition be shared among numerous users, the administrator will be 
required to save the .exi to the shared location.

To Add an Automatic Index for a Report
Indices can be automatically produced when a report is imported. To add an automatic index, use the report view to 
define the extraction definition for the index. Save the extraction definition into the respective RMS/DeskTop 
System’s EXTDEFS subdirectory. Remember the filename. Then, using Importer or RMS/DeskTop, add or edit the 
report series definition for the report adding the index. The report series definition can easily be added by accessing 
the Report Properties dialog for the report. Remember that an administrative user can save .exi definitions to shared 
locations; a non-administrative user can only save the extraction definitions to their local machine.

 

This dialog will allow access to the Report Series Definition dialog for an explicit report series definition for the 
report. Once these things are in place, subsequent imports of the report will have the respective index produced.

NOTE: Report Series Definitions for automatic indexing can be added only by users that have system 
administrator rights.
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Searching
There are several ways to search the report. The simplest is to perform a report text search on the report. This is a 
sequential search of the actual report text. To perform a report text search, select Find from the Edit menu or press the 
Search button (binocular icon) on the toolbar. The Report Text Search dialog will appear. 

Various options may be selected and the search may begin either from the current cursor position or from the top of 
the report. The current selection is automatically used to fill the search dialog.

Report text searches are performed in the background, and each report view window may have an active report text 
search. The search status of the selected view is presented in the status bar. To cancel a search running in the 
background, press Esc.
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Report Text Search Dialog
The Report Text Search dialog allows the user to find a specified text string in the active report window. The search 
will be performed by scanning the actual report content (i.e., not an index search). Report text searching is performed 
in the background.  

The Search string editable, drop-down list is used to enter the text to find. Additionally, recent search targets may be 
selected. The past few searches are saved. The Clear History button can be used to clear the recent search strings.

Select Ignore case if the text comparisons shouldn’t consider differences in the case of letters.

Select Whole words only to cause the target to be bounded by spaces or end-of-line.

The Page area to search can be used to control the portion of each page that will be scanned for a search match. 
Entire page causes all characters of the page to be searched, and is the default selection if entire rows/columns are not 
selected. Selecting Limited area will limit the searchable area of each page to the box indicated by the line range and 
column range. Note the to-end-of-line, to-end-of-page selections for specifying a soft end point. The line and column 
numbers are inclusive. Limited area is the default selection whenever entire rows/columns are selected.

Limited area searching can be useful for restricting searching to a fixed area of the page. For example, to search the 
last few digits of an account number field that occurs in a page header without incurring the irrelevant hits in other 
positions on the page.

When a report text search is running, its progress will be shown in the status bar when the searching view is focused. 
To cancel a report text search, focus the view that is searching and press ESC. Each view can have a report text search 
running simultaneously.
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Once the search settings are ready, press Find First to begin searching at the beginning of the report. Press Find Next 
to begin searching at the character position following the current cursor position. Press Find Prev to begin searching 
toward the beginning of the report at the character position prior to the current cursor position.

The Index Text, Index Number, Index Date, and Index Expression buttons can be used to access alternate search 
dialogs that allow searching a selected index. Of course, the report must have at least one index for these buttons to be 
enabled.

NOTE: If a large report is indexed, it is faster to perform an index search rather than a text search.

In addition to the straight forward Report Text search, which simply scans the actual report information for a 
matching text pattern, when a report has an associated index, the index may be searched directly from the report 
without opening the index. 

The Index Text..., Index Number..., Index Date..., and Index Expression... buttons on the search dialogs accessed 
from a report view all perform index searching. For more information on index searching, see the respective sections 
regarding searching in the Table View chapter. When these dialogs are accessed from a report view, they perform the 
same functions as available from the table view, except that they operate on the default index, which is the first index 
in the list of indices for the report.
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Searching
Index Text Search Dialog
The Index Text Search dialog allows the user to perform a text search of the report index.

The Field to search combo box is used to select a field to search. Comparisons are only done by string comparison, 
and not by data type value comparison. Use the Text to find edit control to enter the text to find. Select the desired 
matching characteristic of either Match if field content starts with text to find or contains the text to find Select 
Ignore case if the text comparisons are to not consider differences in the case of letters. The Ignore leading spaces 
option causes the search to treat the field as if it starts with the first non-blank character. When used with the starts 
with text to find option, it will allow matches when the text is the first non-blank text in the field. The Ignore trailing 
spaces option causes the search to treat the field as if it ended with the last non-blank character.

Once the search expression is ready and syntactically correct, press Find First to begin searching at the beginning of 
the index. Press Find Next to begin searching on the row following the current cursor position. Press Find Prev to 
begin searching toward the beginning of the index at the row previous to the current cursor position.

The Report Text, Index Number, Index Date and IndexExpression buttons can be used to access alternate search 
dialogs.
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The resulting search using Find First:  
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Searching
Index Number Search Dialog
The Index Number Search dialog allows the user to search a numeric field in the index view for a specific value or 
range of values. The Find where drop-down list is used to select the field to search. In addition to number fields, any 
field that can be converted into a number with the function VAL() can be used.

Use the operator drop-down lists to specify the type of comparison to be made, and type the target number or 
numbers in to the edit fields.

If a range is to be used, select the other operators and related numeric value. To simply use one operator, leave the 
second numeric field empty and it will be ignored.  

Once the search expression is ready and syntactically correct, press Find First to begin searching at the beginning of 
the index. Press Find Next to begin searching on the row following the current cursor position. Press Find Previous 
to begin searching toward the beginning of the index at the row previous to the current cursor position.

The Report Text, Index Text, Index Date, and Index Expression buttons can be used to access alternate search dialogs.
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Index Date Search Dialog
The Index Date Search dialog is used to search for a selected date field in the current index for a date or range of 
dates.

Use the Find where drop-down list to select the date field to search. If there are no fields in this drop-down list, 
there are no date fields in the index, and date searching is not appropriate. In this case, use one of the other index 
search dialogs.

Specify the target by selecting a comparison operator from the first operator drop-down list, and supply the related 
date for the comparison.

If a range is to be used, select the other operators and related date value. To simply use one operator, leave the 
second date value field empty and it will be ignored.

Dates should be entered as either, mm/dd/yy or mm/dd/yyyy formatted strings. If you enter a year in YY format and 
its value is from zero to forty-nine, DeskTop assumes it to be a 21st. century year.

Once the target indications are made, press Find First to begin searching at the beginning of the index. Press Find 
Next to begin searching on the row following the current cursor position. Press Find Prev to begin searching toward 
the beginning of the index at the row previous to the current cursor position.

The Report Text, Index Text, Index Number, and Index Expression buttons can be used to access alternate search 
dialogs.
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Searching
Index Expression Search Dialog
The Index Expression Search dialog allows the user to search the index using the powerful algebraic expressions 
involving one or more fields. Most of the controls on the dialog are simply conveniences for inserting text into the 
Search Expression. In addition to using these controls to insert text, the expression can be edited directly by clicking 
at the appropriate location in the text field.

The Field list contains the names of each of the fields in the index. To insert a field into the search expression at the 
current cursor position of the search expression, either select the field and press the Insert button or double click the 
field name. The semantics of various operators depends on the data types of the operands. When a field is selected, 
the data type of the field is displayed at the bottom of the dialog.

The Function list contains samples of functions that are available to convert one data type to another or perform 
various operations that can be useful when composing an expression. 

The operator buttons insert their labels into the search expression when clicked.

The Clear button will clear the search expression when pressed.

The Check button will cause the current search expression to be evaluated for syntactical correctness. A message will 
appear at the bottom of the dialog indicating whether the expression is valid or not. For help with errors see Index 
Expression Errors.

Once the search expression is ready and syntactically correct, press Find First to begin searching at the beginning of 
the index. Press Find Next to begin searching on the row following the current cursor position. Press Find Previous 
to begin searching toward the beginning of the index at the row previous to the current cursor position.

The Report Text, Index Test, Index Number, and Index Date buttons can be used to access alternate search dialogs.
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Searching
Search or Target Highlight Dialog
When a search target is found, it is circled with the search highlight color. This is not the same as selection, and the 
search highlight will remain until another search is performed or until it is specifically cancelled. To cancel or remove 
highlighting, press the Esc key. The same type of highlighting will occur when a hyper link is performed from the 
table view window indicating the cell or row from which the hyper link was performed. 
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Reference Guide The Report Viewing Window
Selection and Copy
Selection and Copy
Report text may be selected by dragging across the text to be selected. Or, keyboard-based selection can be performed 
by pressing the Shift key in combination with any cursor movement key. There are three selection modes available 
(Box, Line, and Stream) which may be selected from the Edit menu.   

Stream selection mode works much like most word processors. It selects from a starting point, continues to the right 
and wraps from line to line to the end point.
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Line selection is useful for selecting complete lines from a start point to the end point. 

Box selection mode selects a rectangular area from the start point to the end point. There is a special case built-in to 
the box selection mode that allows an effective line mode selection when the start column is the same as the end 
column. For most situations, box mode is the only mode needed since line mode can be affected by using a zero 
column select - which is very easy to do with the keyboard.  

Double clicking a sequence of characters selects the entire sequence. Double clicking on a space selects the entire 
page. Page selection may also be performed via the toolbar or Edit menu commands. 

To copy selected data to the Windows clipboard, use the Copy menu item from the Edit menu.
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Report View Keys
Report View Keys
The following table summarizes the special keys applicable in the report view.

Key Type Key Action

Navigation Page Down Next screen of data

Page Up Previous Screen of data

Ctrl+Page Down Top of next report page

Ctrl+Page Up Top of previous report page

Alt+Page Down Next report page beginning at the same line number as current page’s 
top line in view

Alt+Page Up Previous report page beginning at the same line number as current 
page’s top line in view

Ctrl+Down Arrow Automatic scroll down of report data

Ctrl+Up Arrow Automatic scroll up of report data

Ctrl+Left Arrow Word jump left

Ctrl+Right Arrow Word jump right

Home Go to beginning of current line

End Go to end of current line

Ctrl+Home Go to the first line of the report

Ctrl+End Go to the last line of the report

Bookmarks Ctrl+F2 Toggle bookmark for current line

F2 Scroll view downward to display next bookmark

Shift+F2 Scroll view upward to display previous bookmark

Search F3 Find next (forward)

F4 Find previous (backward)

Ctrl+S Display Search dialog

Selection Shift+Arrow Key Selects a character at a time

Shift+End Selects data from cursor to end of line

Shift+Home Selects data from cursor to beginning of line

Shift+Page Down Selects one screen full down from the cursor

Shift+Page Up Selects one screen full up from the cursor

Ctrl+Shift+Page DownSelects from the cursor to the end of the next page

Ctrl+Shift+Page Up Selects from the cursor to the beginning of the previous page

Ctrl+Shift+Home Selects from the cursor to the beginning of the report

Ctrl+Shift+End Selects from the cursor to the end of the report

ESC Drop all highlighting, stop searching
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Clipboard Ctrl+C Copies the selection to the clipboard

Ctrl+Insert Copies the selection to the clipboard

Fine Scrolling Space+Pointer Drag Pans (scrolls) the view around near its current position
94 © 2013 Mantissa Corporation. All rights reserved.
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C h a p t e r  4 :

Extracting Data from Reports

Overview
The RMS/DeskTop Report View provides an automatic method of extracting exactly the information that is desired 
from a free-form report.

In RMS/DeskTop, this feature is called data extraction, and the rules that determine what data will be extracted from 
a report are contained in an extraction definition.

The extraction feature allows fields of information to be marked on-screen, creating an extraction definition that 
specifies the information desired from a report. This definition can be saved/loaded to/from an extraction definition 
file and can be used with any similarly formatted report to find and extract desired information.

Extraction results can be useful for many reasons including data analysis, index searches/sorts, as Hyperlink to the 
underlying report data, and for exporting tabular, typed data to other applications like spreadsheets and databases. 
Also, once a useful extraction is created, it can be defined to be an “automatic index” for a given report. Automatic 
indices are produced for the associated reports at the time the report is imported into the system and are available 
immediately after the import for viewing without any extra user intervention.

Some extractions with RMS/DeskTop can be simple, and some can be complex. Some extractions are impossible 
with RMS/DeskTop (but this is relatively rare). The difficulty of defining a given extraction varies from report to 
report depending on the consistency of the report generator and the exact desires for the extracted data. When 
creating extractions, the best practice is to slowly add new keylines/fields to the extraction checking the output after 
each small addition. This lets you make incremental progress, and provides better understanding of the underlying 
operation. Debugging a complex multi-field, multi-keyline extraction can be difficult without this approach. With 
some practice, extractions can become a relatively easy and powerful tool revealing a wealth of information from 
your reports.

Users running the internet-based release of RMS\DeskTop (iDT) are only allowed to save extraction definitions 
locally to their machine. Currently remote administrative privileges are not allowed.  Those same administrators, if 
using RMS\DeskTop (non-internet based) may save extractions to directories on the LAN for sharing purposes. Non-
administrative users only have the privilege of saving to their local machines.

Basic Principles of Extraction
An extraction is performed by scanning every line of the report. As it scans, it checks to see if the current line 
matches any known keylines. When there is a keyline match, the fields associated with the keyline are collected with 
the contents of the lines at the relative field positions, which are designated by each field.

An extraction produces records of identical format. Every record output contains the same fields in the same relative 
positions. Often, the information for one output record is on several different lines and may be repeated several times 
on a page. Generally, whenever the last field defined on a page is collected, the appropriate output fields are loaded 
up and an output record is produced. This can happen several times on each page. There are many options to limit and 
alter what is extracted. However, it is always good to keep in mind that all output records have the exact same format, 
and only the data in the fields change.

As data is being extracted, it is placed into a temporary output table which is visible in a Table View Window. One 
can begin using the output immediately because the extraction is created as a background activity. To cancel a 
running extraction, close the table showing its output or use the Stop menu item on the Extract menu from the report 
view that is performing the extraction.
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Opening an Existing Extraction Definition
Extraction definitions can exist in two types of files: .EX$ and .EXI. The .EX$ file type is an RMS/DeskTop 1.X file 
type created with RMSXW.EXE, a standalone extraction program. EXI files are an RMS/DeskTop file type created 
by RMS/DeskTop from a report view window. RMS/DeskTop can read .EX$ files, but can only save .EXI files.

Extraction definition files are usually stored in the EXTDEFS directory of a given RMS/DeskTop system, but may 
be stored in any directory.  Administrators have the right to save EXTDEFS to any directory.  Normal users may only 
save the definitions to their local machines. iDT currently allows saving extraction definitions to local machines for 
both administrators and users.

NOTE: If you want Auto Indices produced, the extraction files MUST be stored in the EXTDEFS folder.

To open an existing extraction definition file, use the “Open Definition” menu item from the Extract menu for a 
given report view. 
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Creating a New Extraction Definition
It is easy to create a new extraction definition. Simply mark a field and use either the popup menu (right mouse button 
click) or the Extract menu to define the new field. When a new field is defined an extraction definition is 
automatically created. You can then add to or alter the new definition as needed. Alternatively, you can use “New 
Definition” from the Extract menu to begin a new extraction definition. 
© 2013 Mantissa Corporation. All rights reserved.  97



R
D

_C
ha

pt
er

_0
4.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3

RMS/DeskTop® Version 3.25 

Extracting Data from Reports Reference Guide
Creating a New Extraction Definition
Th Extraction Field dialog allows the properties of an extract field to be modified.

Each field must have a unique, non-blank, non-numeric name of no more than ten characters.  Use the Name edit 
control to supply a name for the field. The Name may not exceed 10 characters and must contain only alphanumeric 
and underscore characters.  If an invalid Name is provided the user will be presented with a message dialog entitled 
Invalid Field Name noting that the Field Names may only contain alphanumeric and underscore characters.

There are three types of fields which correspond to three types of data types in the resultant output table.  They are:

Character A seqence of characters which are not necessarily a number or date.

Number A number value with the indicated number of digits after the decimal in the output table.

Date A date value.  The order may be either: MDY, DMY, or YMD.  Dates are automatically 
recognized.  If the year in the data stream is in YY format and its value is from zero to forty-
98 © 2013 Mantissa Corporation. All rights reserved.
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nine, DeskTop assumes it to be a 21st. century year.

A new extraction definition will exist only in memory until it is saved to disk.

Saving an Extraction Definition
To save an extraction definition, use either Save or Save As from the Extract menu.   

In some situations, a .EX$ file may be used in an automatic index. When a .EX$ file is saved as a .EXI file, make sure 
that any related report series definitions that reference the .EX$ are adjusted to reference the newly saved file. It is 
important to remember that the location in which the extraction definitions are saved are dependent on the user’s 
security rights.  Administrators are the only users allowed to place .exi definitions at any location.  Other users may 
only save extraction definitions locally to their own machines.
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Extraction Keylines
There are two main entities that define the behavior of an extraction definition; keylines and fields. 

A keyline is an entity that is used to identify key lines in the report. A key line is a line about which some action is to 
be taken. There are three basic keyline types:

Keyline
100 © 2013 Mantissa Corporation. All rights reserved.
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Normal A keyline that collects associated fields upon a match.

Start A keyline that enables all normal keylines.

Stop A keyline that disables all normal keylines.

Normal keylines always have associated fields which are collected after the keyline matches a report line. 

Start and Stop keylines generally have no associated fields, and are simply used to enable/disable the Normal keylines 
as required based on desired output. Start and Stop keylines are rarely used, but in some situations they can be quite 
handy.

Extract Keyline Dialog
This dialog allows the keyline’s matching and behavior to be modified.

The mask edit control looks like a two line edit control. The top line contains a template string which is not editable. 
The bottom line contains the mask string which is editable. The mask characters determine the matching 
characteristics of the keyline. Some mask characters act in combination with the template string character at the same 
position, and some mask characters simply act on the report line being tested.

The From/To Page and From/To Line ranges can be used to only consider the keyline for a match in certain areas of 
the report. To use these features, make sure that the related checkbox is selected and that the related range is valid.

The Clear All Fields checkbox can be used to cause all fields in the extraction to be cleared when the keyline 
matches. The fields will be cleared before any fields associated with the keyline are collected.

The Trigger an Output Record checkbox can be used to force an output record to be written after all fields associated 
with the keyline have been collected. Any number of keylines may have this property set. When no keylines have this 
property set, the extraction produces an output record when the field furthest to the right/bottom of the page is 
collected.

The Keyline Type can be used to cause extractions to be disabled/enabled or to cause normal field collection. Most 
extractions only use Normal keylines; however, sometimes data should only be extracted in certain areas of the report 
that are delimited by keyline detectable lines. Start/Stop keylines typically have no associated fields.

Keyline Mask
Template String
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Keylines can have both a page range and a per-page line range in which they are to be considered. 

The combination of a keyline template string and keyline mask characters control the actual matching behavior for a 
keyline. The template is set automatically to the report content of the line on which the keyline is defined. The mask 
is automatically set to match the special characters, if any, on the line. The special characters are period(.), equal(=), 
colon(:), and forward slash(/). In many cases, matching on the special characters on a given line produces the desired 
effect; however, this is only a default behavior. The keyline mask must be examined by the user to ensure proper 
matching characteristics.

NOTE: The template string is simply a string that contains a typical set of data for a given, example line 
to match. It is set for the keyline at the time the keyline is defined. When a keyline is moved, its 
template strings will be recaptured, and the keyline mask will be reset to match the special 
characters in the new template.

Keyline Matching
As each line of the report is processed, each keyline is checked to determine whether it matches the report line. For a 
match to be possible:

• the keyline must be enabled

• the page/line range must be such that the keyline should be examined

• the report line must match based on the mask characters and the template string.

When testing each report line, each character of the report line which has an associated mask character is tested as 
follows:

Mask Character Report line character test

= Case sensitive equality test between the report line character and the 
associated template character.

~ Case insensitive equality test between the report line character and the 
associated template character.

\ Case sensitive inequality (not equal) test between the report line 
character and the template character.

! Case insensitive inequality (not equal) test between the report line 
character and the template character.

A The report line character must be alphabetic (A-Z, a-z).

a The report line character must be alphanumeric (A-Z, a-z, 0-9).

B The report line character must be blank (space).

d The report line character must be a digit (0-9).

U The report line character must be upper case alphabetic (A-Z).

L The report line character must be lower case alphabetic (a-z).

X The report line character must not be blank.

S The report line character must be a special character. The special 
characters are period(.), equal(=), colon(:), and forward slash(/).

DDD Consecutive Ds indicate that the area of the report line above the Ds 
must convert to a date value.
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Extraction Fields
Navigating the mask edit control
The mask edit control can be edited by clicking on the bottom line. Once focused, the following keys allow 
navigation:

Extraction Fields
A field is an entity which is used to collect data from a report. Fields are always associated with some keyline. The 
keyline determines when it is appropriate to collect its associated fields. Fields are always located relative to their 
associated keyline at a fixed column position and a fixed number of lines above or below the keyline or on the same 
line as the keyline. Fields can be used to collect multiple rows of information, but usually single line fields are 
collected.

Fields are generally created by interactively selecting an “interesting” field on a report and issuing a New Field 
command from the Extract or Popup menu.

Care must be taken when selecting the field to ensure that enough area is selected to accommodate all possible values 
for the field, not just the example data being selected. For example, if a “balance” field were selected, and if the 
example data contained a number like $123.00, a much larger area than the seven characters comprising the example 
text should be selected to accommodate the largest expected value for the field. Only data within the area marked 
(relative to the associated keyline of the report) will be collected during the extraction.

NNN Consecutive Ns indicate that the area of the report line above the Ns 
must convert to a number value.

(space) Ignore.

Key Action

Left/Right Arrow Moves the cursor left or right.

Ctrl Left/Right Arrow Moves the cursor left or right 10 spaces.

Home Moves the cursor to the beginning of the line.

End Moves the cursor to the either the last template character or the last 
mask character (whichever is further right).

Backspace Deletes the mask character to the left of the cursor.

Delete Deletes the mask character under the cursor.
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Extracting Data from Reports Reference Guide
Extraction Fields
Extract Field Dialog
This dialog allows the properties of an extract field to be modified. The following is an example of the dialog:

Each field must have a unique, non-blank, non-numeric Name of no more than ten characters. Use the Name edit 
control to supply a name for the field.
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Extraction Fields
There are three types of fields which correspond to three types of data types in the resultant output table. The Field 

Types are:

RMS/DeskTop will make a best guess about the field type by sampling the content of the selection during field 
creation. Though this type detection generally works, it is not perfect. One common case where this may be wrong is 
“account” or “customer” numbers. In many cases, example content of these fields may be completely numeric for 
some numbers, but at other times the field may have alphabetic components. For example, 123456789 versus 
123A56789. In this case, if the data selected during field definition is all numbers, a Number type field will be 
selected, but the field is actually appropriately defined as Text. So, the point is, always check the fields types carefully 
to ensure that they match the actual data being collected.

The Substitute field can be used to put user-defined constants in the output. To include a constant, define a place-
holder field of the desired length on the report itself. This place holder field will not be output (the substitute value 
will be substituted for it), but its location and related keyline indicate where and when to output the substituted field.

Field Type Content

Character A sequence of characters which are not necessarily a number or date.

Number A number value with the indicated number of digits after the decimal 
in the output table.

Date A date value. The order may be either: MDY, DMY, or YMD. Dates 
are automatically recognized. If the year in the data stream is in YY 
format and its value is from zero to forty-nine, DeskTop assumes it to 
be a 21st. century year.
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Extracting Data from Reports Reference Guide
Extraction Fields
To specify a substitute string, check the box to the left and fill in the entry area to the right. Any entry can be made in 
the substitute area, and it will be truncated or padded with blanks as necessary to match the length of the marked 
place holder field.

The Output if within range feature can be used to limit output records based on field content. These range 
comparisons are done based on the field type for the field. The following table explains the range value 
interpretations.

The Output Action controls how the fields value will be output, and can cause special actions for the field. The 
following are the output action settings and a description of their behavior:

The Field Location and Size can be used to change the position (start column), length (width), height, as well as the 
associated keyline and line offset from that keyline. These parameters are usually adjusted from the report view by 
directly manipulating the field with the mouse.

Fields are collected when their related keyline matches a given report line. The keyline does not have to be on the 
same line as the field, and the field can even be above the keyline. The field must be on a line which is at a fixed 
offset from its associated keyline.

Field Type Range Comparison

Character Character-by-character comparison is done (the case of the letters is 
ignored).

Number The numeric value of the report field and the From/To entries are 
compared (for example, $1,234.87 is equal to 1234.87).

Date A true date comparison is performed (for example, 9/1/1991 is less 
than 2/1/1992).

Output Action Description

Output field as-is Causes the field to be output without any special processing. The 
field is output in the form it is collected whether the field was 
present or blank.

If blank, output prior 
value

If the field is currently blank, the prior non-blank value is used. 
This feature is typically used to fill in values that occur once for a 
set of detail entries.

If duplicate, output 
blanks

If the field has the same value as in the prior output record, 
output blanks instead.

Output once per 
keyline hit

Will cause the field to be output once after a hit by its associated 
keyline. After output, the field is cleared so that subsequent 
output records will contain blanks for this field until the next 
time the field’s keyline is hit. This feature is typically used to 
prevent sparse detail fields from being output on inappropriate 
detail records.

If duplicate, ignore This feature, which may be used in combination with the above 
features, will cause the output record to be cancelled if the field 
contains a duplicate value when considered against its previous 
value.
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Understanding Keyline/Field Graphics
Understanding Keyline/Field Graphics
When a report view has an open extraction definition, the left margin will contain icons representing the extraction 
definitions’s keylines. The following are the iconic keyline images and what they indicate:

Fields in the extraction definition will be outlined in a thin rectangle which will be either dashed or solid. A solid 
outline indicates a field that is associated with the currently focused keyline. A dashed outline indicates a field that is 
not associated with the currently focused keyline. When a field is selected, which is the case when the cursor is inside 
the field’s bounding rectangle, the field will have size grab handles. The grab handles can be used to resize or 
reposition the field.

NOTE: When repositioning an extraction field, it must be repositioned on a similar field type for the 
extraction to work properly.

A keyline with no warnings.

A keyline with warnings. Use the Extract Keylines dialog to diagnose 
the problem.

A keyline that triggers an output record with no warnings.

A keyline that triggers an output record which currently has some 
warning.
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Understanding Keyline/Field Graphics
Extract Keylines Dialog
Double-click the keyline icons to edit a keyline or use Keylines from the Extract menu to view/manipulate all 
keylines.    

This dialog allows one to view all keylines defined to the current extraction definition. Keylines may be edited or 
deleted. The following is an example of the keylines dialog:
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Understanding Keyline/Field Graphics
The list of keylines indicates the page-line number for each keyline. After the line number, keylines with warnings 
will have an indication of the warning about the keyline. Typically, an accurate extraction will have no keylines with 
warnings.

NOTE: Note: When a keyline is deleted, all of its fields are deleted.

The following warnings may appear next to keylines:

Warning Meaning

(no mask) The keyline has no mask characters. This causes the keyline to match 
every line, which is usually not desired. Technically, it could be the 
desired effect, but in most cases this is not desired. When a keyline is 
created, the mask is automatically set by placing an equality mask (=) 
under all special characters in the template. The special characters are 
period(.), equal(=), colon(:), and forward slash(/). The (no mask) 
warning can be removed by editing the keyline and setting at least one 
valid mask character for the keyline.

(not unique) The keyline mask is not unique when considered against other 
keylines in the current extraction definition. This means that the 
keyline matches a template string in at least one other keyline. This 
typically happens when the automatic mask does not generate a strict 
enough mask for the line. This is generally not a good thing because it 
means that two or more keylines will attempt to collect their fields on 
the same line. This situation can be corrected by editing the keyline 
and providing additional mask characters or by restricting the line 
range in which the keyline is considered for matching.
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Understanding Keyline/Field Graphics
Defining and Editing Keylines and Fields
To create a field, select the data that should be collected, and either click the right mouse button on top of the 
selection to get the pop-up menu or use the Extract menu. Use the New Field menu item to create the new field. At 
this point an Extract Field dialog will appear. Use the Extract Field dialog to set the appropriate options for the field. 

When a field is created on a line that has no keyline, a keyline will be automatically added on the line and the field 
will be associated with the new keyline. During the automatic addition of the keyline, the keyline’s template will be 
set to the contents of the report line where it is defined, and the mask will be automatically set to match any special 
characters on the line. 

NOTE: This automatic masking is only an attempt to produce a reasonable mask. In many cases one 
must refine the mask to appropriately identify the report line of interest.

To create a keyline without creating an associated field, position the cursor to the line the keyline should be created 
on and use either the pop-up menu or the Extract menu to issue the New Keyline command. This can be useful when 
creating Start or Stop keylines that have no associated field.

To edit a keyline or field, simply double click either the field or the small key icon on the left side of the report view 
and the appropriate edit dialog will appear. Alternatively, one may use the Keylines command on the Extract menu to 
access the Extract Keylines dialog which shows and allows manipulation of all keylines. Likewise, use the Fields 
command on the Extract menu to access the Extract Fields dialog which shows and allows manipulation of all fields.

To delete a field, position the cursor inside the field and use the Delete Field command from the Extract menu. 
Alternatively, fields may be deleted from the Extract Fields dialog.

To delete a keyline, position the cursor inside a field associated with the keyline to delete and use the Delete Keyline 
command from the Extract menu. Alternatively, keylines may be deleted from the Extract Keylines dialog.

To adjust the size or position of a field, position the cursor inside the field to be adjusted and use the mouse to drag 
the grab handles as appropriate. Alternatively, field size and position may be altered from the Extract Field dialog.
110 © 2013 Mantissa Corporation. All rights reserved.



R
D

_C
ha

pt
er

_0
4.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3
RMS/DeskTop® Version 3.25 

Reference Guide Extracting Data from Reports
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Moving a Keyline or Merging Keylines
In some situations it may be necessary to move a keyline. This is typically necessary when there is nothing 
particularly characteristic about the line that a field is on, but the line above or below the field has some 
distinguishing characteristic.

Here’s an example of some data that illustrates this condition:

Style          Age  Bedrooms  Full Baths  Half Baths  Exterior                
Country/Farm   15      4         2          0       Green painted wood

If data from the Country/Farm line is needed, the problem is that all data on that line varies in the report. However, 
the line above always has the field titles. 

To move a keyline to a different line, simply drag the key icon up to the appropriate report line. When no special 
characters exist in a new template line, the following message will appear:
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Moving a Keyline or Merging Keylines
This message indicates that the user will need to add keyline mask characters to indicate how the line is to be 
recognized.

In other situations, fields from more than one line may need to be collected from a single keyline. As fields are 
defined, keylines are automatically added at the line on which the fields are defined. When a key icon is moved to a 
line that already contains a keyline, all fields that are associated with the keyline being moved are disassociated with 
the keyline being dragged and associated with the keyline on which the keyline being dragged is dropped. The 
keyline being dragged is then deleted.

Field/Keyline associations can also be changed by editing each field with the Extract Field dialog. 
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Cross Report Indices
From the viewer window, extractions may be performed across one or more reports. This is a very powerful feature 
because it provides a way to create a cross report index (i.e., an index to information that exists within more than one 
report).

To perform an extraction from the viewer, select the report versions for which an extraction is to be performed. Next, 
issue the Extract command from the popup menu, the File menu, or the toolbar. At this point a file selection dialog 
will appear requesting the selection of an appropriate extraction definition file. Once selected, the extraction 
definition will be used to perform an extraction across all of the reports selected.

NOTE: Note: The extraction definition for a multi report extraction must be appropriate for the reports 
selected; otherwise, data will not be collected. Before performing extractions from the viewer, 
ensure that the extraction definition to be used produces expected results from the Report 
Window of the individual reports.

1. Select the reports for the index. 2. Select Extract... from the popup menu.

3. Choose the extraction definition to be run to create the index.
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Cross Report Indices
Once the extraction is begun, a Table Window will appear showing any output data extracted. The table view is 
usable immediately without waiting for the extraction to complete. A progress indication will be shown in the status 
bar when the Table view is focused. To cancel or abandon the extraction simply close the table window.

The tabular results may be manipulated just as other report indices are manipulated including filtering, sorting, 
column rearrangements, saving to external file types, and hyper linking back to the source report information for a 
given record. See information on the Table Window for details on these operations. Additionally, one may save cross 
report indices into the RMS/DeskTop system as an Index Document. This allows the index to be retained for future 
use with or without the reports from which the index was created. 

NOTE: Note: Hyper linking to the report data that created the index will only be possible if the 
referenced report versions are still in the system. Cross Report Index Documents are managed 
separately from the report versions from which they are created.
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C h a p t e r  5 :

The Table Viewing Window

The Table Viewing Window displays information about a report in a row-column, grid-oriented style. Typically, the 
data viewed with the table view window is information which was pulled, or extracted, from a report with the RMS/
DeskTop data extraction tools. The table view window allows the information to be filtered, sorted, and rearranged 
by the user. Additionally, the table may be searched conveniently for text, numbers or dates with ranges. Also, index 
expressions may be used to query the table for complex criteria involving more than one field. 
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Manipulating the display
The table view window has a header which shows the name of each field. The width of the fields may be adjusted by 
clicking in the header between the fields and dragging the field separation as needed. Also, clicking on a field heading 
with the right pointer button will popup a menu that can be used to insert or remove fields from the display. 
Alternatively, fields can be rearranged, added, or removed from the view by using the Fields dialog which can be 
accessed by selecting the Fields menu item under the View menu. 
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Index Fields Dialog
This dialog allows the user to rearrange the presentation order of fields in a table view.

The Fields available lists the fields that exist in the index. The Fields to show lists the each field that will be shown 
in the index view in the order that the fields are shown.

The order of presentation of the Fields to show may be changed by selecting a field and pressing the Up/Down 
buttons.

To add a field to be shown, select the field in the Fields available list and press the >> button. Or simply double click 
the field.

To remove a field from the fields to be shown list, select the field and press the << button. Or simply double click the 
field.

The Sort Order and Filter Expression allow other index viewing option dialogs to be accessed.

Sorting the information
The rows in the table may be sorted using one or more fields as the sort keys. The popup menu for the field can also 
be used to affect sorting.

The rows in the table can be sorted. There are to ways to cause the table to be sorted:

• Single column sort

• Multi column sort 

Single Column Sort
The easiest and quickest way is to right click on a column header. The resultant popup menu will contain menu items 
to sort the rows based on an ascending or descending sort on the column. This will be a single column sort. No 
previous sorting has any effect. Alternatively, to simply sort ascending or descending on a single field, select the field 
to be sorted and select Sort Ascending or Sort Descending from the View menu. 
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Multi Column Sort
Single or multi column sorts can be achieved with the Index Sort Order dialog. From this dialog, simply select the 
fields, in order, for the sort. The fields, from top to bottom will be sorted in a primary key, secondary key fashion.

To access the Index Sort Order dialog, select the Sort menu item from the View menu or press the corresponding 
toolbar button. 

Filtering the information
The rows in the table view can be reduced, or filtered, based on a filter expression to only those rows in which the 
filter expression evaluates to a logical true value. The filter expression can be set or adjusted by selecting the Filter 
menu item from the View menu which will present the index Filter dialog. To remove a filter, use the Filter dialog 
118 © 2013 Mantissa Corporation. All rights reserved.
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and clear the expression. Be patient when filtering. Depending on the speed of your computer, the complexity of the 
filter expression, and the size of the index, a filtered view may sometimes result in sluggish performance. If this 
occurs, try adding a sort, it can, sometimes, actually help performance. 

Report Index Filter Dialog
This dialog allows the user to filter the information shown in the table view using an index expression. Each row in 
the index which resolves to a logical .TRUE. filter expression result will be shown. All other rows will not be shown.

Most of the controls on the dialog are simply conveniences for inserting text into the Filter Expression. In addition to 
using these controls to insert text, the expression can be edited directly by clicking at the appropriate location in the 
text field.

The Field list contains the names of each of the fields in the index. To insert a field into the filter expression at the 
current cursor position of the filter expression, either select the field and press the Insert button or double click the 
field name. The semantics of various operators depends on the data types of the operands. When a field is selected, 
the data type of the field is displayed at the bottom of the dialog.

The Function list contains samples of functions that are available to convert one data type to another or perform 
various operations that can be useful when composing an expression.

The operator buttons insert their labels into the filter expression when clicked.

The Clear button will clear the filter expression when pressed.

The Check button will cause the current filter expression to be evaluated for syntactical correctness. A message will 
appear at the bottom of the dialog indicating whether the expression is valid or not. For help with errors see Index 
Expression Errors.
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Index Expression Errors

Comma or Bracket Expected
A comma or right bracket was expected, but there was none. For example, the expression: TRIM(ABC 
would cause this because there should be a closing parenthesis after the ABC. This can also be caused 
when a balancing quotation mark is missing.

Expression not Complete
The expression was not complete. For example, the expression FIELD_A + would not be complete 
because there should be something after the + operator.
IIF() needs parameters of the same type
The second and third parameters of the IIF() function must be of the same data type and be of the same 
length. For example, IFF(.T., 12, 123) would cause this error because the character value 12 is of length 
two and the value 123 is of length three.

SUBSTR() and STR() need Constant Parameters
The second and third parameters of the SUBSTR() and STR() functions require constant parameters. For 
example, SUBSTR(123, 1, 2) is fine, but SUBSTR(123, 1, a_field) will not work because a_field is not a 
constant value.

Number of Parameters is Wrong
The number of parameters specified for a function is wrong.

Overflow while Evaluating Expression
The expression was too long or complex. Shorten the expression, if possible, and try again.

Right Bracket Missing
The expression is missing a closing parenthesis. Make sure the expression contains the same number of 
open and close parentheses.

Sub-expression Type is Wrong
The wrong data type has been supplied for an operand or function parameter. Operators require operands 
of specific, like types. One example of this error would be using a character constant in a comparison with 
a numeric field. For example, amount = 123, where amount is a numeric field.
Another common example of this problem is when date comparisons are made. For example, shipdate = 
10/13/96 would cause this if shipdate where a date field. This happens because 10/13/96 is a character 
value. To correct this type of problem use CTOD(10/13/1996) to convert the character constant value into a 
date value.

Unrecognized Field Name
An identifier in the expression does not match any field name in the index. This can be a simple typing or 
spelling error in referencing the field name. Another common cause of this error is omitting quotation 
marks from a character constant. The expression parser assumes that a character sequence with no 
enclosing quotation marks is a field identifier.

Unrecognized Function
A specified function was not recognized. For example, SIMPLE() will produce this error.

Unrecognized Operator
An unrecognized operator was found in a position where an operator was expected.
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Unrecognized Value
A character sequence was not recognized as a constant, field name, or function.
There are no unary operators. Attempting to use a unary minus or plus operator will typically produce an 
Unrecognized Value syntax error. To invert the sign of a numeric value, multiply the value by -1.

Unterminated String
This error indicates that there was no ending quote character to match a starting quote character. Once the 
filter expression is ready and syntactically correct, press OK to apply the filter to the index. The Fields and 
Sort Order buttons can be used to access respective dialogs. 
See Index Expressions for more information on expression syntax and semantics.

Index Expressions
The following functions are available for use in converting data types and various other operations that can 
be useful in expressions. The symbols char_value, date_value, num_value, and log_value refer to any 
character, date, numeric, or logical value (i.e., a constant, field, or expression that results in the respecitive 
value).

ALLTRIM( char_value )
The ALLTRIM() function trims both leading and trailing spaces from the character value.

Example: ALLTRIM("    ABC    ") returns "ABC"

CHR( integer_value )
The CHR() function returns the character whose numeric, decimal ASCII code is identical to the given 
integer.  The integer_value must be a numeric value between 0 and 255.

Example: CHR(65) returns the character value A.

CTOD( char_value )
The CTOD() function converts a character value into a date value. This function is commonly used when a 
date constant is needed because there is no syntax for directly expressing a date constant. The character 
value must be formatted as "MM/DD/YYYY", "DD/MM/YYYY" or "YYYY/MM/DD". All of the formats are 
dependent upon the locale's date settings. You will get erroneous results if you use the wrong format. See 
your Control Panel for more information on your locale's settings.
For MM/DD/YYYY format:

Example: CTOD( "11/30/2004")
Example: CTOD("08/09/2003")
Example: CTOD("10/03/2004")

Note that the second example used leading zeros for the month and the day. If you do not, the conversion 
will not be accurate. The third example used a leading zero in the day's field only.

DATE()
The DATE() function returns a date value representing the current system date.

DAY( date_value )
The DAY() function returns the day-of-month for the respective date value. The return value will be a 
numeric value from 1 to 31.

Example: DAY(DATE()) returns 17 if it is the seventeenth of the month.

DTOC( date_value )

DTOC( date_value,1 )
The DTOC() function converts a date value into a character value. The format of the resulting character 
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value is MM/DD/YYYY.
Example: DTOC(DATE()) returns the character value "08/06/2002" if the current date is August 6, 2002. If the optional second 

argument is used, the result will be identical to the results produced by DTOS().
Example: DTOC( DATE(),1)  will return "20020806" if the current date is August 6, 2002.

DTOS( date_value )
The DTOS() function converts a date value into a character value. The format of the resulting character 
value is "YYYYMMDD", "DDMMYYYY", or "YYYYMMDD". The result will match your locale's date setting. 
See your Control Panel for more information.

Example:  DTOS(DATE()) returns the character value "20020806" if the current date is August 06, 2002.

IIF( log_value, true_result, false_result )
The IIF function returns one of two values depending on the content of the logical value. If the logical value 
is TRUE, IIF() returns the true_result value. Otherwise, IIF() returns the false_result value. Both the 
true_result and false_result must be the of the same length and type. Otherwise, an error results.

Example:  IIF( taxrate = A1, 7.5,  9.0 ) returns the numeric value 7.5 when taxrate is A1 and 9.0 otherwise.

LEFT( char_value, num_chars )
The LEFT() function returns a specified number of characters from the beginning of a character value. The 
num_chars should be a numeric value representing a whole number that indicates the number of 
characters to return.

Example:  LEFT( "MANTISSA", 3 ) returns MAN.
The same result could be achieved with SUBSTR( "MANTISSA", 1,3).

LTRIM( char_value )
The LTRIM() function trims any blanks from the beginning (left) of the character value. The result is a 
character value with any leading blanks removed.

Example: LTRIM("  ABC  ") returns "ABC  ".

MONTH( date_value )
The MONTH() function returns the month number of the date value as a numeric value.

Example: MONTH( CTOD( "10/13/2002") ) returns 10 as a numeric value.

STOD( char_value )
The STOD()  function converts a character value into a date value. The character representation should be 
in the format "YYYYMMDD", "DDMMYYYY", or "YYYYMMDD". The format that you use MUST match your 
locale's date setting. See your Control Panel for more information.

Example: STOD("20020806") results in a date value representing August 6, 2002.

STR( num_value, length, decimals )
The STR() function converts a numeric value into a character value. The length should be a numeric, 
constant value representing the number of characters in the converted character value, including the 
decimal point. The decimals should be a numeric, constant value indicating the number of digits that 
should be inserted after the decimal point. If the number is too big for the allotted space, the returned value 
will contain all asterisks (e.g., ***** ).

Example: STR( 5.7, 4, 2 ) returns the character value 5.70.
Example: STR( 5.7, 3, 2 ) returns *** because 3 characters is not wide enough.

SUBSTR( char_value, start_position, num_chars )
The SUBSTR() function will extract and return a substring of the indicated character value.  The substring 
will begin at the start_position and will be num_chars long.  The start_position should be a numeric, 
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constant value indicating the character offset where the substring should begin (1 indicates the first 
character of the char_value).  The num_chars should be a numeric, constant value that indicates how 
many characters to return.

Example: SUBSTR( "LOGO MANTISSA", 3, 11) returns the substring GO MANTISSA.

TIME()
The TIME() function returns the current system time as a character value. The return value will be in an 
HH:MM:SS format.

Example: TIME() returns the character value 13:30:00 if it is 1:30 PM.

TRIM( char_value )
The TRIM() function removes any blanks from the end of the character value.

Example: TRIM("ABC    ") returns "ABC"

UPPER( char_value )
The UPPER() function converts a character value into upper case.

Example: UPPER( "A mixed case string") returns A MIXED CASE STRING.

VAL( char_value )
The VAL() function converts a character value into a numeric value.  The character value must contain 
characters that represent a number.

Example: VAL( "123" ) returns the numeric value 123.

YEAR( date_value )
The YEAR() function returns the year component of a date value as a numeric value.

Example: YEAR( CTOD("10/13/2002") ) returns the numeric value 2002.
Index expressions provide a syntax that allows complex algebraic expressions to be used for searching or filtering 
indices.

The expression is formed by combining algebraic terms with operators to compose the final expression result. The 
terms of the expression can be of varying data types, but the final result of an expression used for searching or 
filtering should be a logical (i.e. .TRUE. or .FALSE.) value. A .TRUE. expression result will indicate a search 
destination match or a row that passes filter criteria.

Field names, constants, and functions may all be used as terms in an expression. Expression terms are combined 
using operators. The semantics of operators and validity of operands varies with the data types of the operands. Each 
expression operates on field values from a single row.

Fields, Data Types, and Constants
Each field in an index has a definite data type. This type may be a character field, a number field, or a date field. The 
operators appropriate for each data type, and the semantics of these operators are described below.

Number fields contain a numeric value and can be compared and operated on with the following 
operators:

+ addition

- subtraction

* multiplication

/ division

**  or ^ exponentiation
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> greater than

< less than

= equal to

<= less than or equal to

>= greater than or equal to

<> not equal to

Numeric comparisons result in a logical value, and arithmetic operations result in a numeric value.
Numbers can be real or whole. A numeric constant may be used directly in an expression anywhere a 
number value is required. Examples of numeric constants are: 5, 7.3, -10.5, and 0. Numeric constants 
should not contain commas, currency symbols or other decorative characters, and should not be enclosed 
in quotes.
Character fields, which are sometimes referred to as text fields, contain a character value which is 
padded with spaces to the respective field width. Character values cannot be used directly in numeric 
comparisons even when a character field actually contains a number. Functions are available to convert a 
character value into number or date values when their value has the appropriate content. Functions are 
also available to remove leading and trailing spaces, and extract substrings from the value.
A character constant is enclosed in quotation marks. For example, 

"Hello"

"1234"

Omitting quotation marks from a character constant in an expression is a common cause of the 
Unrecognized Field Name syntax error. Since the value has no quotation marks, the expression parser 
assumes that the value must be a field identifier, but when there is no matching field name in the index, this 
error occurs.
Character values can be compared and operated on with the following operators:

> greater than

< less than

= equal to

<= less than or equal to

>= greater than or equal to

<> not equal to

$ is contained in

+ normal concatenation

- special concatenation

The comparison operations for character values operates on character strings on a character-by-character 
basis. The results of relative comparisons will depend on the collative order of the characters. In most 
circumstances, a relative comparison should be done on character values of like case. The Upper() 
function can be useful for converting a character value to upper case. The comparison operators result in a 
logical value.
The equal (=) operator has a behavior that may not be obvious. As mentioned above, in an index, 
character fields are padded to their respective field length. The equal test will return.TRUE. when the left 
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operand begins with the right operand. This generally has the desired effect of ignoring trailing blanks; 
however, it can cause bogus .TRUE. results when an explicit test needs to be performed. For example, a 
field that contains GOLDSMITH in some cases and GOLD in others would return .TRUE. for both fields if a 
comparison is performed as:

character_field_nane = "GOLD"

which would return .TRUE. when field contains both GOLD      and GOLDSMITH. There are several ways 
to solve this problem. One way is to use the Left() function to ensure that the first 4 characters are GOLD. 
For example,

Left(character_field_name, 4) = "GOLD"

The is-contained-in ($) operator can be useful for determining whether one character value exists at any 
position within another. For example, to find SMITH in values of SILVERSMITH or GOLDSMITH use a 
syntax of:

SMITH $ <character_field_name>

where, char_fld field contains the character value to search. The is contained in operator results in a logical 
value which is .TRUE. when the left operand is contained in the right operand.
The concatenation operators result in a character value that is a combination of the two character value 
operands. The normal concatenation simply combines the two character values as one would expect. For 
example,

"JOHN"  + "DOE" would produce "JOHN DOE"

The special concatenation operator is slightly different in that any spaces at the end of the first character 
value are moved to the end of the result. For example,

"JOHN"  - "DOE" would produce "JOHNDOE" 

Date fields contain a date value which is internally encoded as an eight character CCYYMMDD value. 
Date values can be compared and operated on with the following operators:

- subtraction

> greater than

< less than

= equal to

<= less than or equal to

>= greater than or equal to

<> not equal to

Date comparisons result in a logical value, and date subtraction results in a numeric value representing a 
number of days.
Date constants cannot be directly expressed. Instead one must use a character constant with the CTOD() 
function to convert the character constant into a date value. CTOD() converts character values formatted 
as MM/DD/YYYY into respective date values. For example, to compare a field to a constant date value one 
would use an expression like:

date_fld > CTOD("10/13/1996")

which would return a logical result indicating whether the contents of the field named date_fld was greater 
than the date 10/13/1996. In order to address 21st. century years you must use four-digit years.
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NOTE: It is important to understand that the conversion process is based on the respective country 
date format loaded on the pc. (i.e., European values would not be of the same format for the 
respective date values.

Logical values, which must be the result of index expressions, are not contained in fields. Rather, they 
must be the result of an expression involving one or more fields. There are two logical constants which 
correspond to the two logical values. They are .TRUE. and .FALSE., and they can be abbreviated as .T. or 
.F. respectively. Logical values can be operated on with the following operators:

.NOT. not

.AND. and

.OR. or

The only thing, perhaps a bit odd, is the requirement that the boolean operators have leading and trailing 
periods. The .NOT. operator inverts the logical value to its right.

Index Expression Operators
The table shows the available operators, presented in order of precedence. Operators higher in the table 
will be evaluated before operators lower in the table. Operators at the same precedence are evaluated 
from left to right.

Symbol Name or meaning per data type

( ) Parentheses force evaluation of the enclosed sub-expression

** Exponentiation (number values)

* Multiplication (number values)

/ Division (number values)

+ Addition (number values), Normal concatenation (character values)

- Subtraction (number or date values), Special concatenation (character 
values)

= Equality test (number or date values), Begins with (character values)

<> Inequality test (number, character, or date values)

< Less than (number, character, or date values)

> Greater than (number, character, or date values)

<= Less than or equal (number, character, or date values)

>= Greater than or equal (number, character, or date values)

$ Is contained in (character values)

.NOT. Logical inversion (logical values)

.AND. Logical AND (logical values)

.OR. Logical inclusive OR (logical values)
Operators require valid, like data types for operands. A common cause of the Sub-expression Type is 
Wrong syntax error is supplying an inappropriate data type as an operand. For example, supplying a left 
operand that is a character value and a right operand that is a number. This type of problem can be caused 
indirectly as a result of a sub-expression.
There are no unary plus or minus operators. Attempting to use a unary minus or plus operator will typically 
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produce an Unrecognized Value syntax error. To invert the sign of a numeric value, multiply the value by -
1.

Index Expression Functions
The following functions are available for use in converting data types and various other operations that can 
be useful in expressions. The symbols char_value, date_value, num_value, and log_value refer to any 
character, date, numeric, or logical value (i.e., a constant, field, or expression that results in the respective 
value).

ALLTRIM(char_value)
The ALLTRIM() function trims both leading and trailing spaces from the character value.

Example: ALLTRIM(   “  ABC  “ ) returns “ABC”.

CHR(integer_value)
The CHR() function returns the character whose numeric, decimal ASCII code is identical to the given integer. The 
integer_value must be a numeric value between 0 and 255.

Example: CHR(65) returns the character value A.

CTOD(char_value)
The CTOD() function converts a character value into a date value.  This function is commonly used when a date 
constant is needed because there is no syntax for directly expressing a date constant.  The character value should 
be formatted as MM/DD/YYYY.

Example: CTOD(“11/30/02”)

DATE()
The DATE() function returns a date value representing the current system date.

DAY(date_value)
The DAY() function returns the day-of-month for the respective date value. The return value will be a numeric 
value from 1 to 31.

Example: DAY(DATE()) returns 17 if it is the seventeenth of the month.

DTOC(date_value)

DTOC(date_value,1)
The DTOC() function converts a date value into a character value. The format of the resulting character value is 
MM/DD/YYYY if the locale settings is in US format.  This value would differ if set to a different locale setting. This 
character format will take on the attributes of the associated country format in the event the format is not US 
formatting.

Example: DTOC(DATE()) returns the character value “08/06/1996” if the current system date is August 6, 1996.
If the optional second argument is used, the result will be identical to the results produced by DTOS().

Example: DTOC(DATE(),1) will return “19960806” if the date is August 6, 1996.

DTOS(date_value)
The DTOS() function converts a date value into a character value. The format of the resulting character value is 
CCYYMMDD.

Example: Example: DTOS(DATE()) returns the character value "20020806" if the current date is August 06, 2002.

IIF(log_value, true_result, false_result)
The IIF function returns one of two values depending on the content of the logical value. If the logical value is 
.TRUE., IIF() returns the true_result value. Otherwise, IIF() returns the false_result value. Both the true_result and 
false_result must be the of the same length and type. Otherwise, an error results.

Example: IIF(taxrate = A1, 7.5,  9.0) returns the numeric value 7.5 when taxrate is A1 and 9.0 otherwise.
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LEFT(char_value, num_chars)
The LEFT() function returns a specified number of characters from the beginning of a character value. The 
num_chars should be a numeric value representing a whole number that indicates the number of characters to 
return.

Example: LEFT(“MANTISSA”, 3) returns MAN.
The same result could be achieved with SUBSTR(“MANTISSA”, 1,3).

LTRIM(char_value)
The LTRIM() function trims any blanks from the beginning (left) of the character value. The result is a character 
value with any leading blanks removed.

Example: LTRIM( "   ABC” ) returns “ABC”.

MONTH(date_value)
The MONTH() function returns the month number of the date value as a numeric value.

Example: MONTH(CTOD(“10/13/1996”)) returns 10 as a numeric value.

STOD(char_value)
The STOD()  function converts a character value into a date value. The character representation should be in the 
format YYYYMMDD  if the locale settings is in US format. This value would differ if set to a different locale setting.

Example: STOD(“19960806”) results in a date value representing August 6, 1996.

STR(num_value, length, decimals)
The STR() function converts a numeric value into a character value. The length should be a numeric, constant 
value representing the number of characters in the converted character value, including the decimal point. The 
decimals should be a numeric, constant value indicating the number of digits that should be inserted after the 
decimal point. If the number is too big for the allotted space, the returned value will contain all asterisks (e.g., 
*****).

Example: STR(5.7, 4, 2) returns the character value 5.70. 
STR(5.7, 3, 2) returns *** because 3 characters is not wide enough.

SUBSTR(char_value, start_position, num_chars)
The SUBSTR() function will extract and return a substring of the indicated character value. The substring will 
begin at the start_position and will be num_chars long. The start_position should be a numeric, constant value 
indicating the character offset where the substring should begin (1 indicates the first character of the char_value). 
The num_chars should be a numeric, constant value that indicates how many characters to return.

Example: SUBSTR(“LOGO MANTISSA”, 3, 11) returns the substring “GO MANTISSA”.

TIME()
The TIME() function returns the current system time as a character value. The return value will be in an 
HH:MM:SS format.

Example: TIME() returns the character value 13:30:00 if it is 1:30 PM.

TRIM(char_value)
The TRIM() function removes any blanks from the end of the character value.

Example: TRIM("ABC     ") returns "ABC".

UPPER(char_value)
The UPPER() function converts a character value into upper case.

Example: UPPER("A mixed case string") returns "A MIXED CASE STRING".

VAL(char_value)
The VAL() function converts a character value into a numeric value. The character value must contain characters 
that represent a number.

Example: VAL(“123”) returns the numeric value 123.
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YEAR(date_value)
The YEAR() function returns the year component of a date value as a numeric value.

Example: YEAR(CTOD(“10/13/1996”)) returns the numeric value 1996.
Index Expression Errors

Comma or Bracket Expected
A comma or right bracket was expected, but there was none. For example, the expression: TRIM(ABC would 
cause this because there should be a closing parenthesis after the ABC. This can also be caused when a 
balancing quotation mark is missing.

Expression not Complete
The expression was not complete. For example, the expression FIELD_A + would not be complete because there 
should be something after the + operator.

IIF() needs parameters of the same type
The second and third parameters of the IIF() function must be of the same data type and be of the same length. 
For example, IFF( .T., 12, 123) would cause this error because the character value 12 is of length two and the 
value 123 is of length three.

SUBSTR() and STR() need Constant Parameters
The second and third parameters of the SUBSTR() and STR() functions require constant parameters. For 
example, SUBSTR(“123”, 1, 2) is fine, but SUBSTR(“123”, 1, a_field) will not work because a_field is not a 
constant value.

Number of Parameters is Wrong
The number of parameters specified for a function is wrong.

Overflow while Evaluating Expression
The expression was too long or complex. Shorten the expression, if possible, and try again.

Right Bracket Missing
The expression is missing a closing parenthesis. Make sure the expression contains the same number of open 
and close parentheses.

Sub-expression Type is Wrong
The wrong data type has been supplied for an operand or function parameter. Operators require operands of 
specific, like types. One example of this error would be using a character constant in a comparison with a numeric 
field. For example, amount = 123, where amount is a numeric field.
Another common example of this problem is when date comparisons are made. For example, shipdate = 10/13/96 
would cause this if shipdate where a date field. This happens because 10/13/96 is a character value. To correct 
this type of problem use CTOD(“10/13/1996”) to convert the character constant value into a date value.

Unrecognized Field Name
An identifier in the expression does not match any field name in the index. This can be a simple typing or spelling 
error in referencing the field name. Another common cause of this error is omitting quotation marks from a 
character constant. The expression parser assumes that a character sequence with no enclosing quotation marks 
is a field identifier.

Unrecognized Function
A specified function was not recognized. For example, SIMPLE() will produce this error.

Unrecognized Operator
An unrecognized operator was found in a position where an operator was expected.

Unrecognized Value
A character sequence was not recognized as a constant, field name, or function.
There are no unary operators. Attempting to use a unary minus or plus operator will typically produce an 
Unrecognized Value syntax error. To invert the sign of a numeric value, multiply the value by -1.
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Unterminated String
This error indicates that there was no ending quote character to match a starting quote character.

Saving the table view
The content of a table view can be saved into the associated RMS/DeskTop system if the user has the rights to do so.  
RMS\DeskTop’s iDT (internet-based release) does not currently allow the saving of indexes by a remote user.

There are two ways to save index (or table) data into the system:

• Save index as an attachment

• Save index as a document

Save index as an attachment
This option is only available when the table view contains data that was extracted from a single report version. To 
save the index as an attachment, select Index... from the File menu’s Save sub-menu. This will present the following 
Index Save dialog. From this dialog, select the Attachment tab to save as an attachment. This tab will only be 
available if the table view being saved is actually associated with a single, specific report version.

This dialog allows a table view to be saved as an index for a specific report. The table will be saved based on its 
current filter and sort settings, and will not contain data rows that are currently filtered. Saving an index as an 
attachment makes the index specifically associated with the report version as shown. In this case the index can be 
thought of as being attached to the report. The only way to view the index after saving is to open the index for the 
130 © 2013 Mantissa Corporation. All rights reserved.
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respective report version by either opening the report version and using the View->Index menu or pointing directly to 
the report version in the Viewer and using the Open Index... pop up menu item. Attached indices are automatically 
deleted when the associated report version is deleted.

Each attached index has a Name by which the indices are distinguished from one another. The top portion of the 
dialog will list the names of any existing attachments for the report. Either select one of the existing names, or type 
the new index name into the Name entry field and press the OK button.

Save index as a document
This dialog allows a table view to be saved as an index into the RMS/DeskTop repository. This dialog is accessed in 
much the same was as the above described Save index as attachment dialog, except that the Document tab should be 
selected. The ability to save an index as a document is controlled by the user’s security rights.  If rights are not 
defined as permitted the user will be unable to perform the task. This save option is available for all table view 
content.

With Save index as document, the table will be saved based on its current filter and sort settings, and will not contain 
data rows that are currently filtered. As a document, the table will be versioned and will be governed by its own 
security settings based on the security access controls. Users will also see the index in the Viewer just like any other 
report or external document. The document will still act as an index and can be used to hyper-link to reports as 
appropriate. This is particularly handy when saving the results of a Cross Report Index, where records in the index 
relate to potentially different report versions.
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To save the report as a document, a Report Series and a Document Name must be provided. Use the tree to select the 
report series or enter a new one in the Report Series field. 

NOTE: Only those report series for which the current user has View, Delete and Import rights will allow 
the document to be saved.  If the correct security rights are not present for the attempting user, 
the user will be receive an Insufficient Prifileges alert as indicated below. 

Use the Document Name field to enter the name of the document. Use the Description field to supply an appropriate 
description for the document. The Business Date field is used by the system to automatically version the documents 
in the repository. As the new document version is saved, the relevant Storage Class system settings will be used to 
delete old versions in the series.

NOTE: Note: If a document is saved into an existing series with a date older than other document 
versions currently in the series, the new document will not be the tip or first document listed in 
the Viewer.

Exporting data from the table view
At any time, the data being viewed by the table view can be exported to a file. RMS/DeskTop supports a variety of 
PC file formats. To save the data in the view, select the Export menu item from the File menu. In the Save dialog use 
the Save File As Type control to select the appropriate file type.

To save the current view inside RMS/DeskTop for easy retrieval at a later time, select Save Report Index from the 
File menu. When prompted, supply a name for the new index. The saved index subset will then be available as an 
alternate index for the associated report.

Printing from the table view
To print the contents of the current table view, use the Print and Print Preview menu items from the File menu. The 
table view will be printed using the current display font. To adjust the font, use the Application menu item on the 
Properties menu and select an appropriate font for the table view. If the table is too wide to fit on the paper selected, 
more than one sheet of paper may be required per logical page.

Column Calculations
Columnar selections of numbers can be calculated by the table view. This feature will produce a sum, max, min, and 
average for the selected numbers. To access this feature, (1) select a column of numbers and (2) click the Column 
Calc menu item from the popup menu for the selection.
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Table View Keys
The following table summarizes the special keys applicable in the table view.

Key Type Key Action

Navigation Page Down Next screen of data

Page Up Previous Screen of data

Home Go to beginning of current row

End Go to end of current row

Ctrl+Home Go to the first row of the view

Ctrl+End Go to the last row of the view

Search F3 Find next (forward)

F4 Find previous (backward)

Ctrl+S Display Search dialog

Selection Shift+Arrow Key Selects a cell at a time

Shift+End Selects data from current cell to end of the row

Shift+Home Selects data from current cell to beginning of the row

Shift+Page Down Selects one full screen down from the current cell

Shift+Page Up Selects one full screen up from the current cell

Ctrl+Shift+Home Selects from the current cell to the first row of data

1

2
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Ctrl+Shift+End Selects from the current cell to the last row of data

Clipboard Ctrl+C Copies the selection to the clipboard

Ctrl+Insert Copies the selection to the clipboard
The tabular results may be manipulated just as other report indices are manipulated including filtering, sorting, 
column rearrangements, saving to external file types, and hyper linking back to the source report information for a 
given record. See information on the Table Window for details on these operations.

Saving Table View Configurations
Once the various sort, filter, and column arrangement settings have been set, it can be desirable to save the settings for 
subsequent use. Table viewing configurations can be saved by accessing the CONFIGURATION sub menu item from the 
SAVE sub menu on the table view’s FILE menu. This will cause a CONFIGURATION SAVE dialog similar to the following 
to be shown: 

Use the NAME text entry control to give the configuration a name. Names may contain spaces. If you loaded an 
existing configuration, DT3 will use the existing configuration name; you have the option of using the same name or 
entering a new name. The name will be presented when later re-opening a configuration for the index.

The DESCRIPTION text entry control can be used to explain in detail the purpose of the configuration.

Checking the DEFAULT field will force DT3 to automatically load the configuration whenever the current index is 
next viewed. To remove the default property uncheck the DEFAULT checkbox and save the configuration.

Loading Table View Configurations
Saved table view configurations including sort, filter, and column arrangements may be re-opened for a given index 
to restore the respective, previous view settings.
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To load a table view configuration click the CONFIGURATIONS menu item from the table view’s VIEW menu and a 
CONFIGURATION LOAD dialog similar to the following will appear. 

Any available configurations will be listed, by name. Select the configuration to load and press the LOAD button, and 
the table view’s sort, filter, and column arrangements will be restored to the configuration’s saved settings.

To delete a previously saved configuration, select the configuration and press the DELETE button.
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C h a p t e r  6 :

Report Printing

RMS/DeskTop has extensive report printing capabilities. Features are available to define and retain logical report 
printing preferences, associate defined logical printing preferences with reports. There are also a number of options 
for printing greenbar and/or annotations.

Logical Printers Overview
Applications generating the reports for RMS/DeskTop to import predetermine the report’s page layout. Reports are 
text-only and contain no font information such as family and size. When RMS/DeskTop is to print a report, font and 
margin information are needed. In addition, the actual Windows printer and page orientation to be used must be 
determined.

To encapsulate all this information and allow for creating named setups that can be recalled and associated with 
specific reports, an RMS/DeskTop LOGICAL PRINTER entity is used. LOGICAL PRINTERS can be grouped together and 
saved as a file in the system directory where they can be shared. All printers defined in these files are referred to as 
SYSTEM LOGICAL PRINTERS.

For each RMS/DeskTop system that the workstation accesses, one of these files is designated as the source of 
LOGICAL PRINTERS for that system. Each SYSTEM LOGICAL PRINTER has already been configured and associated with 
a specific Windows printer. The Windows printer that was associated with the LOGICAL PRINTER may be shared 
differently, or may not be the most convenient printer for all workstations; so, RMS/DeskTop allows the SYSTEM 
LOGICAL PRINTER definitions to be overridden on a per-attribute basis by each workstation. Using this feature, the 
Windows printer that is associated by the system definition can be overridden to become a more desirable printer for 
a given workstation. This method leaves intact any definitions and associations that have been established between 
specific reports and specific LOGICAL PRINTERS. 

The information about the Windows printer that is associated with the logical printer includes more than just the 
name and device of the printer. The Windows printer’s device driver-specific information is also captured. The 
SYSTEM LOGICAL PRINTERS are created in context of the defining workstation and that workstation’s operating 
system. For this reason, SYSTEM LOGICAL PRINTERS in an environment with multiple Windows versions must have 
overrides applied on the workstations that are running a different version of Windows than the workstation used to 
create the system printer definitions.

In these heterogeneous environments, the best approach is to use multiple SYSTEM PRINTER FILES, with one file for 
each Windows version that might access a system’s LOGICAL PRINTERS. This will allow the printer definition files to 
be used “as is” on all homogenous workstations (if all printers are network accessible from all workstations). This 
solution can extend to situations where users of a given system are not physically located together, e.g., first floor vs. 
seventh floor users.

NOTE: At the workstation level, the file that will be used for the SYSTEM LOGICAL PRINTERS must be set in 
the SYSTEM PROPERTIES for each system that is to be accessed. 

Another class of LOGICAL PRINTER is a LOCAL LOGICAL PRINTER. This LOGICAL PRINTER’S definition exists only for a 
given workstation. The only restriction imposed is that the name must not be the same as an existing SYSTEM 
LOGICAL PRINTER. LOCAL LOGICAL PRINTERS can be used only at the workstation on which they are defined. 
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Once logical printers are established, they are available to the User when making a printer selection. 

Printing a Report
From either the REPORT VIEWER or the VIEWER, use the FILE, PRINT menu to invoke printing.

To print a report that is currently open in a viewer, make the REPORT VIEWER the active window and use the FILE, 
PRINT menu.

The PRINT menu item on the FILE or Popup menus will cause one of two dialogs to appear depending on whether one 
or more than one report is selected. In the typical case of printing a single report, the following PRINT DIALOG will 
appear.
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Obviously, there are a lot of features available here, but it’s not really that difficult. Generally, one only needs to 
select a logical printer (if an appropriate one is not already selected), select the desired PAGE RANGE and what to print 
(PRINT WHAT), and press OK. Once the system is properly setup, however, even the logical printer should be selected 
automatically; so, typically the only things that need to be checked are the Page Range and what to print. However, 
many options are available providing for a wide range of specific printing needs.

NOTE: Some options in this dialog are disabled when the logical printer driver’s “BYPASS WINDOWS 
PRINTER DRIVER” option is enabled. For specific information about logical printers, see 
“Manipulating Logical Printers” within this chapter.

Use the PAGE RANGE settings to specify the report pages to be printed. There are four basic options. You can specify a 
default page range of ALL or CURRENT PAGE on a per-system basis in the SYSTEM PROPERTIES dialog.

Page Range Setting Prints

All The entire report from page 1 to N.

Current Page The page on which the caret rests.

Selection The pages that intersect the current selection.
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Use the COPIES are to specify the desired number of copies of each page printed. The COLLATE option, when checked, 
will cause all pages to be printed consecutively for each copy; otherwise, when the collate option is not checked, all 
copies of each page will be printed together.

The PRINT WHAT option is used to specify what, of the report content, should be printed. The following options are 
available:

The PRINT drop down list can be used to manually perform two sided printing. Typically, when normal, single sided 
printing (or printer controlled duplexing) is desired the ALL PAGES IN RANGE selection should be chosen. To manually 
print two sided, first print the pages with the ODD PAGES selection, then put the paper back in the printer upside down 
and print again with the EVEN PAGES selection.

Pages Specifically listed page ranges. This can be a comma separated list 
of pages or page ranges. For example, 1,3,5-7 to print pages 1, 3, 
and 5 through 7. Additionally, page ranges can be specified in 
reverse order, like 7-5, which would cause pages 7, 6, and 5 to be 
printed in that order.

Print what Prints

Report The report content with no annotations and no greenbar or 
“watermelon” effects.

Report with options The report content with the “options” selected on the PRINT 
OPTIONS dialog. The options can include the printing of greenbar 
backgrounds, notes, and bookmarks in various ways.

Annotations Only report annotations will be printed based on the PRINT 
OPTIONS dialog.

Note contents Only notes annotations will be printed based on specific, related 
settings on the PRINT OPTIONS dialog.

Bookmark list Only bookmarks will be printed based on specific, related settings 
on the PRINT OPTIONS dialog.

Page Range Setting Prints
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The Print Options Dialog
The PRINT OPTIONS dialog is reached from the PRINT REPORT dialog by pressing the OPTIONS button. The following is 
an example of the PRINT OPTIONS dialog. 

NOTE: These options do not come into play when the PRINT WHAT selection is REPORT. The print REPORT 
case behaves as if the PRINT REPORT CONTENT ONLY checkbox is checked.

Most of the print options are self explanatory. However, notice that the PUBLIC NOTES, PRIVATE NOTES, and 
MINIMIZED NOTES selection all work together. For example, for a public note to be printed that is currently minimized, 
both the PUBLIC NOTES and MINIMIZED NOTES checkboxes must be checked. The same applies to the PRIVATE NOTES 
and MINIMIZED NOTES checkboxes. By minimizing specific notes that one does not want printed and unchecking the 
MINIMIZED NOTES checkbox one can avoid printing specific notes.

The GREENBAR selection controls whether the horizontal bars will be printed. The colors used will be the colors 
currently selected in the view.
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When notes are printed with report content the note area outline will be drawn on the report, but the actual note 
content will be printed either on a page following the report page on which the note is located, or on pages printed 
after all report content is printed depending on the NOTE PRINTING OPTION selected. The same applies to bookmarks 
based on the BOOKMARK PRINTING OPTION selected.

Print Examples
The following are some examples of the type of output one can obtain from RMS/DeskTop report printing.

Basic Report Printing, no options:
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Report Printing with options, but no annotations: 

Printing the annotations only: 
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When ANNOTATIONS, NOTE CONTENTS, or BOOKMARK LIST are printed, no report content is printed, but rather only the 
respective annotations will be printed. The exact annotations printed will be determined by the specific settings 
selected on the PRINT OPTIONS dialog, and the PAGE RANGE selected.

Manipulating Logical Printers
From either the Print Report dialog or the Print Setup dialog, one may manipulate logical printer definitions. The 
following is an example of the PRINT SETUP dialog, which only includes the logical printer setup portion of the PRINT 
REPORT dialog. 

When printing, this is typically the first attribute to inspect or select. To select or change the logical printer to be used, 
first select the Logical Printer from the LOGICAL PRINTER - NAME drop-down list. This list will contain all defined 
logical printers. If the settings for a given logical printer, for example the DEVICE or TYPE, need to be changed, click 
the PROPERTIES button with the printer selected in the drop down list, and the associated LOGICAL PRINTER SETUP 
dialog will appear.

To add a new logical printer, click the New button. You will first be prompted for the name of the logical printer, 
which must be unique among all defined logical printers. Next, the LOGICAL PRINTER SETUP dialog will appear. The 
type, System or Local, of logical printer created depends on the whether the USE SYSTEM PRINTERS checkbox is 
checked. With the USE SYSTEM PRINTERS checkbox checked, the new printer will be a SYSTEM LOGICAL PRINTER, and 
once saved will be available to all users of the system. With the USE SYSTEM PRINTERS checkbox unchecked, the new 
printer will be a LOCAL LOGICAL PRINTER, and the printer will only be defined and available on the workstation on 
which it is created.

To delete a logical printer, first select the logical printer from the drop down list, and the Delete button will enable or 
disable as appropriate depending on whether you are allowed to delete the printer. System printers may only be 
deleted by users that have the PRINTER ADMINISTRATOR privilege.

The USE SYSTEM PRINTERS checkbox is only enabled for users with the PRINTER ADMINISTRATOR privilege. When 
this checkbox is checked, only System Logical Printers will appear in the Logical Printers drop down list. Also, any 
changes made to the logical printers while the Use System Printers checkbox is checked (including adding logical 
printers) will be affecting changes to the system setup. So, this is how a Printer Administrator makes system wide 
changes.

Note that as any changes are made, they are only saved permanently if the SAVE CHANGES checkbox is checked. 
Otherwise the changes are only held in memory.
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System printers that are not used by a given user may be hidden. Any logical printer may be hidden by checking the 
HIDDEN checkbox on the printer’s LOGICAL PRINTER SETUP dialog. This can be a useful feature for removing 
unwanted or unused system printers (which cannot be deleted), from the list of printers. The SHOW HIDDEN checkbox 
causes hidden printers to be added to the logical printers drop down list when checked. To un-hide a logical printer, 
first click the SHOW HIDDEN checkbox, then select the hidden printer from the list and access the printer’s properties 
to uncheck the HIDDEN attribute.

The Print Report dialog includes a PRINT TO FILE checkbox that can be checked to cause the report content to be sent 
to a file instead of the listed printer device. A prompt will appear when printing to a file that requests the name of the 
file to be written. The information printed will be formatted appropriately for the selected device, but will be stored in 
a file instead of being sent to the printer.

The Logical Printer Setup Dialog
The LOGICAL PRINTER SETUP dialog is accessed from either the PRINT REPORT dialog or the Print Setup dialog by 
either clicking the PROPERTIES button for an existing logical printer, or by creating a new logical printer. The 
following is an example of the LOGICAL PRINTER SETUP dialog.    
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This dialog can be a bit confusing unless you understand the way that RMS/DeskTop manages logical printer 
definitions. At any given time, a user may be:

• Editing a system defined printer, but applying changes as local overrides for specifically changed attributes

• Editing a system defined printer, and applying changes to the system wide definition

• Editing a locally defined printer

The dialog’s caption will indicate which of these three cases, (override), (system), or (local), applies and will be 
similar to the following: 

When applying edits that will override an existing system printer, the DEFAULT SETTINGS button is enabled. When 
pressed, all overridden attributes will revert to the system defined settings. In addition to the name, the LOGICAL 
PRINTER has a DESCRIPTION to further define printer’s purpose.

The LOGICAL PRINTER’S FONT is with the standard Windows font dialog. 

NOTE: The font selection is limited to fixed pitch fonts.
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Spacing between each consecutive character on a line can either be set to NATURAL or a CHARACTERS PER INCH VALUE. 
NATURAL uses the spacing as defined by the character size of the font selected. The CHARACTERS PER INCH value 
specifies the character spacing indirectly by allowing the number of characters per inch to be specified. The 
CHARACTERS PER INCH value can be calculated by taking the maximum number characters needed to print a report line 
divided by the page width available to the printer in inches. For example, with a 132 column report in landscape on 
8.5 x 11 inch paper, assuming 1 inch is lost to margins and unprintable areas on the paper, the cpi value would be 132 
/ 10, or approximately 13 characters per inch. If the characters per inch value is set incorrectly, the characters will 
overlap or the end of the line will be clipped.

Spacing between consecutive lines can be set in one of three ways. If NATURAL is selected, the line spacing will be 
determined by the character size of the selected font. To deviate from natural, either LINES PER INCH or POINTS PER 
LINE can be selected. The LINES PER INCH specifies the line spacing indirectly by allowing the number of print lines 
per inch to be specified. To calculate the LINES PER INCH value, the maximum number of lines required on the page 
should be divided by the page length in inches. For example with a 56 line report in landscape on 8.5 x 11 inch paper, 
assuming 1 inch is lost to margins and unprintable areas on the paper, the value would be 56 / 7.5, or approximately 
7.5 lines per inch. The POINTS PER LINE allows for setting the absolute line spacing in points between consecutive 
lines. This is useful for trying to print on pre-printed forms that are set up in point spacing per line.

The top and left margins can be set in inches. The right and bottom margins are determined by font selection and 
spacing.

The Windows printer to be used is set by invoking the Windows standard print setup dialog using the SETUP button. 
In addition to capturing the Windows printer selected, all device-specific information for the printer is captured. This 
is useful for creating such things as a DeskTop logical printer that does “4-up” printing by associating the logical 
printer with a Windows printer that has this support. The same Windows printer can have many personalities that are 
utilized by many DESKTOP LOGICAL PRINTERS.

Optionally, the PAGE WIDTH and/or the PAGE LENGTH may be set in the PAGE SIZE FOR AUTO SELECT. The printers are 
evaluated in the following order for best fit: LOGICAL PRINTERS with both members set, width only set, length only 
set. If neither value is set, the printer will not participate in PAGE SIZE FOR AUTO SELECT. Refer to Automatic Printer 
Selection for more details on PAGE SIZE FOR AUTO SELECT.

Using Impact Printers
Dot matrix printers can be used by RMS/DeskTop in two ways. First, the standard Windows printer driver for the 
printer may be used. Using this printer driver, applications such as MS-Paint will be able to send graphics to the 
printer. RMS/DeskTop can also use this driver to print reports. However, the printer’s rated speed will never be 
reached due to everything, even text-only reports, being printed in the printer's graphics mode.

The other method to use a dot matrix or impact type printer is to enable the BYPASS WINDOWS PRINTER DRIVER option. 
This option causes RMS/DeskTop to direct the report's raw ASCII text content directly to the Windows print spooler, 
using the selected Windows printer driver to specify the target printer's location. If you don't have a Windows printer 
driver for your printer, you may use the “Generic/Text Only” driver. Remember, the driver is only used to specify the 
printer's location when the BYPASS WINDOWS PRINTER DRIVER.option is selected.
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You may optionally have the page breaks (inserted into the report during the import process of RMS/DeskTop) sent 
to the printer by checking SEND FORM FEED AFTER EACH PAGE.

When the Windows printer driver is bypassed, characters are sent to the printer in the printer's native mode. This 
allows the rated print speeds of the printer to be achieved. However, using the printer’s internal printing capabilities 
causes all of the font, spacing and margin information in the logical printer setup to be ignored.

To control the printer's font formatting and print orientation, the printer's native escape sequences must be used. 
These setup strings are placed in the logical printer’s INIT field and sent to the printer on the start of all print jobs. To 
send an initialization string that contains only printable characters, simply enter the characters in the INIT field. To 
enter non-printable characters encode them as their decimal equivalent using a \ prefix. For instance the ESC 
character, which is typically used in printer command strings, has a decimal value of 27 and a hexadecimal value of 
1B. To send this to the printer in the Init string, you would enter \027.

NOTE: You can use the “Calculator” program to convert hexadecimal values to their decimal 
equivalents. Select it’s “View-Scientific” menu option and the “Hex” entry option. Enter the 
hexadecimal code, then select the “Dec” option to see it’s decimal equivalent.

The CLOSE string is sent after all pages requested to be printed are sent to the printer.

NOTE: When using the \ decimal operator, all three digits need to be present. Pad the value with 
leading zeros to make it three digits (\027 not \27).
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The following example is for an Epson DFX-5000+. The printer is to be sent a re-initialization followed by a 
command to place it in double strike and condensed mode. The printer’s command guide states that the initialize 
command is ESC@. The printer has a Master Select command where an integer is built that contains an aggregate of 
the requested command codes. The commands are: 

The command to send the Master Select is ESC followed by an exclamation point “!” followed by the command 
integer. The double strike command is 16 and the condensed command is 4. Adding these together, we need to send a 
20. The entire sequence to be sent is shown in the dialog.

Previewing Printing
From either the REPORT VIEWER or the VIEWER, use the FILE, PRINT PREVIEW menu to preview the print. In the 
VIEWER, a single report must have the selection to enable the PRINT PREVIEW menu command. If multiple reports are 
selected, the PRINT PREVIEW menu command will be disabled. 

To preview the print of a report that is currently open in a viewer, make the REPORT VIEWER the active window and 
use the FILE, PRINT PREVIEW menu command. 

0: 10 cpi 4:condensed 32: double width

1: 12 cpi 8: emphasized 64: italic

2: proportional 16: double strike 128: underline
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The Print Preview window displays the report pages as they will appear if printed using the current print settings. You 
can change the settings while remaining in Print Preview mode by clicking the SETTINGS button on the button bar 
across the top of the window. Any configuration changes will be immediately reflected in the Print Preview window.

Once you’re satisfied with the configuration, click the PRINT button to add the job to the print queue.
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Automatically Selecting Logical Printers
When a report is to be printed either from the VIEWER or the REPORT VIEWER, a LOGICAL PRINTER must be assigned. 
There are two methods to do this automatically.

If the report has a REPORT SERIES DEFINITION, the LOGICAL PRINTER property can be set to associate the REPORT 
SERIES to an explicit printer. 

If no explicit logical printer association is found, DeskTop will search through all the LOGICAL PRINTERS that have 
either their WIDTH or HEIGHT, PAGE SIZE FOR AUTO SELECT attributes completed, searching for the best fit. The best 
fit algorithm attempts to find the most restrictive printer using the width and length attributes of the logical printer.
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C h a p t e r  7 :

System Setup

This chapter contains a description of RMS/DeskTop systems. Understanding the different kinds of data that control 
an RMS/DeskTop system is fundamental to understanding how to successfully administer these systems. This 
chapter covers the basic terms and concepts that an administrator will encounter in RMS/DeskTop Enterprise 
Edition.

Overview
An RMS/DeskTop system is a logical collection of reports arranged in a hierarchical node structure, and a set of 
administrative attributes that control the storage, access, and use of those reports. Each RMS/DeskTop system is 
autonomous, and is configured and maintained separately from all other RMS/DeskTop systems.

Many administrative functions may be administered via the RMS\DeskTop Viewer component or the Importer 
component.

An RMS/DeskTop system resides in a file directory. To access an RMS/DeskTop system, the system's directory 
must be listed in the workstation's Systems Path.

The following topics define terms useful in understanding an RMS/DeskTop system.

Report Series
A report series is a sequence of one or more versions of a report. Each version in a report series has the same Report 
ID and is located in the same node. The version order is determined primarily by a descending sort on the business 
date, and secondarily by a descending sort on the import time.

EXAMPLE: Two report series: 
“\Accounting\Balances\401.RPT”  
“\Accounting\Balances\406.RPT” 

Report Series Specification
A report series specification is a string that specifies a specific report series by name. The string must start with a 
backslash and contain a sequence of zero or more node names separated by backslashes. The last component of the 
report series specification is the report ID. The report series specification is sometimes referred to as a report 
specification or series specification, and specification is sometimes abbreviated as SPEC.

Report specifications may contain spaces and mixed case, which will be preserved. However, any time a match is 
performed against a report specification, spaces are collapsed, and case is ignored. Therefore, the report specification 

\A mixed case spaced out spec

is the same as

\AMIXEDCASESPACEDOUTSPEC

The valid characters for a report specification are the letters A through Z and a through z, the numeric digits 0 
through 9, space, period (.), and colon (:).

Creating Report Series Definitions for Multiple Nodes
A single REPORT SERIES DEFINITION can be created that will cover multiple nodes that have the same sub nodes.
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For example if a system’s nodes had various sub nodes but also one sub node that appeared in every one, rather than 
create several REPORT SERIES DEFINITIONS one can be created that will cover all the different nodes. 

This is an imaginary list of nodes that all have “admin” as a sub node

\ADMIN\ADMIN\reports

\DAVE\ADMIN\reports

\MANAGEMENT\ADMIN\reports

\SALES\ADMIN\reports

\SUPPORT\ADMIN\reports

Here each node has an admin sub node and they all need to be kept for the same period of time.

The user can create the following REPORT SERIES DEFINITION that will allow them to bracket all the admin sub nodes 
together – as shown below the definition is set up as:

\*\admin\* which means that the first node can be called whatever but all admin sub nodes take on these attributes.
154 © 2013 Mantissa Corporation. All rights reserved.
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If the user had a set of nodes that started GRP100 and ended at GRP 109, they could set up the following REPORT 
SERIES DEFINITION to cover all nodes:

\GRP1?9\ADMIN\*

Also if the user wanted to keep 2 of these nodes for a certain period of time and the rest for another period of time the 
following two REPORT SERIES DEFINITIONS could be set up

\GRP1?2\ADMIN\*

\GRP*\ADMIN\*

Report Mask
A report mask is a special type of report specification that can include wild card characters, and therefore may 
identify one or more report series.

In addition to the characters allowed in a report specification, report masks may also contain asterisks (*) and 
question marks (?).
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A question mark (?) will match any one character.

An asterisk (*) will match zero or more characters up to the next backslash. An asterisk must either end a report mask 
or must be followed by a backslash.

Report masks always match recursively. For example, \FOO\BAR will match a report series of \FOO\BAR or any 
report series that begins with \FOO\BAR\. There cannot exist both a node \FOO\BAR and a report \FOO\BAR in 
a single RMS/DeskTop system.

Any mask that ends in “\*” is the same as the mask with the trailing “\*” removed. Both masks will match any report 
in the indicated node or any subnode thereof.

System Components
The following figure illustrates the major components of an RMS/DeskTop system.   

RMS/DeskTop programs create, use, and modify various components of RMS/DeskTop systems. The following 
illustration shows which programs use which system components.

Logical Printers Extraction Definitions

System DefinitionRepositoryImport Definition Databases

Security Setup

Import Control Database

• Import Directories
• Name Translation Rules
• Import Variables

• Catalog Database
• Physical Report and  

Index Storage

• Report Series Definitions
• Storage Classes
• Object Stores
• Date/Time Locators

• Import Problems
• Import Arbitration

• Logical Printer Files • Extraction definition files

• Users
• Groups
• Report Access Records

ICAV1.DBF Default.dtp EXTDEFS

Sysdef.dbfCatalog.mdb

Admin.db / Admin.pdb

Default.idb
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System Definition
Each RMS/DeskTop System has a system definition file (SYSDEF.DBF). This file is created by SYSGEN when a 
new system is created. It may then be edited by either IMPORTER or RMS/DeskTop as necessary. The system 
definition file contains definitions that define and control the storage of data in a system. System definitions do not 
control security. 

The system definition file is processed both when opening a system for the first time, and while running if changes 
are made to the file. The file contains rules needed by the system during the import process for determining things 
such as storage requirements and definitions for any indices to be automatically produced. The definition file is also 
referenced during printing to determine if an explicit printer binding exists for a report series. The storage 
requirements are also referenced if post-import associations are added to a report so that the association can be 
assigned the same storage class as the related report.

Object Stores
Object Stores supply physical storage for repository data. An RMS/DeskTop system can store its information in any 
number of object stores. Object Stores only need to be understood by administrators of an RMS/DeskTop system. 
Users, who view and manipulate report data, are not burdened with understanding where and how data is physically 
stored. Object Stores allow the physical storage mechanisms to be abstracted so that storage and retrieval can be, 

System Definitions

Import
Control

Database

Import
Definition
Database

IMPORTER
Application *

SYSGEN
Application *

RMS\DeskTop
Application

Security Filtering

Security 
Setup Logical 

Printers
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effectively, media independent. Some information in a system may be routed to an object store that places data on 
optical disks. At the same time, other information in the system may be routed to an object store that places data on 
magnetic disks.

When a report is imported, the actual report data is broken apart, encrypted, compressed, and turned into objects to be 
placed into an object store. By fragmenting the report data, each object store can manage its unused space more 
efficiently. Also, when retrieving data from an optical disk, each file object retrieved must be completely read from 
the optical disk into a magnetic cache. By ensuring that no report object is more than some reasonable fixed size, the 
retrieval time can be faster since only one object at a time ever needs to be recalled from disk.

To have a functional system, at least one object store must be defined.

Storage Classes
Storage Classes define logical storage groups that have similar storage requirements. Each storage class uses the 
physical storage supplied by an object store. Any number of storage classes may use the same object store.

Storage classes are typically used to provide retention characteristics. This is referred to in the storage class setup as 
Automatic Deletion criteria. When a new report is added to a system, the report’s storage class is used to route the 
report data to physical storage. In addition, the storage class’s automatic deletion criteria will be used to automatically 
delete old versions of the report based on a version limit, an age limit, both, or neither. To this end, one may create 
storage classes named “12 versions”, “6 months”, “1 Year”, “Permanent”, etc.

In some cases, storage classes may provide additional criteria to the underlying object store such as routing 
information. This routing information can be used to group reports by frequency or other criteria so that data can be 
routed to separate physical media. To this end, storage classes might be named “Daily”, “Monthly”, and “Quarterly”. 
In this scenario, when using optical disks, one could route daily data to separate media from the infrequent data. This 
would allow a single disk mount access to several quarters’ worth of infrequent information.

To be able to add a report to a system, at least one storage class must be defined. Storage classes have no role in 
retrieving a report from the repository because only object store references are kept in the catalog database.

Report Series Definitions
Report Series Definitions specify how every report of a particular report series should be handled by the system. A 
report series is the collection of all versions of the same report. The report’s ID and node path uniquely identify its 
series. Each version of a report series is unique.

Each report series definition has a report series mask. This may be either an explicit report series specification or, 
with wild cards, may apply to more than one report series. The system definition contains an ordered list of report 
series definitions. When an attribute for a particular report series is needed, the report series definitions are searched 
to find the first report series definition that matches the report series in question. Typically, explicit series definitions 
will appear before wild card definitions.

A report series definition is critical when a report is imported. The report series definition indicates which storage 
class a report should use, and how the business date for the report should be set. Additionally, the report series 
definition may define one or more indices that should be automatically produced for a new report. The definition may 
also specify the logical printer that should be used when printing.  Form assignments may also be defined to ensure 
reports are displayed or printed on specific statements.  Auto Exporting is also assignable.  This is performed by  
selecting the source of the data, the exported file's location and its data type.

The report series definition used for a particular report series can change over time. For example, a report may have 
matched a wild card report series definition when it was first imported. After it is already in the repository, a more 
specific, explicit report series definition may be created that will match and govern the report series thereafter. The 
storage class referenced by a report series definition may also change over time, and will only affect new imports of 
the report.
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Date/Time Locators
Reports in RMS/DeskTop are versioned according to their business date. To ensure proper versioning, it is very 
important that this date be established properly based on the actual business date for a particular report. Date/Time 
Locators allow one to define rules for scanning the content of a report, “feeling” for dates in a particular area of the 
report of a particular format. Multiple formats, or parsing templates, can be defined for each date/time locator, and in 
many cases a generic date/time locator can be used for a number of report series. Once a date/time locator is defined, 
it can be referenced by a report series definition.

System Definition Entity Relationships
The following figure graphically illustrates the entity relationships that exist between system definition objects. 

Extraction Definitions
Extraction Definitions are files that contain a set of rules that are to be used to extract data from a report. Extraction 
definition files typically have .EXI  or .EX$ file extensions. Each definition will contain baseline definitions and 
field definitions. Extraction definitions are created by the EXTRACT application.

Indices for a given report are created by applying an extraction definition to a report while importing the report. A 
report’s report series definition may reference as many extraction definitions as necessary to produce the needed 
indices for the report. Extraction definitions that are referenced by a report series definition normally reside in the 
EXTDEFS subdirectory of the system’s directory. Extraction definitions may now be saved to any directory by a 
user with administrative privileges.  

NOTE: It is important to understand that the location in which the extraction definitions are saved must 
be an absolute path and relative to the machine. 

A storage class 
must use 1 and only 

1 object store.
An object store can 
be used by multiple 

storage classes.

A report series 
definition must use 1 

and only 1 storage class.

A report series definition can 
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For more information about extraction definitions, see “Extracting Data from Reports”, Chapter 4.

Repository
The repository is the name given to the components that manage and control the storage and retrieval of report data 
for the system. The repository consists of the system’s catalog database and the physical report and index data 
storage.

Catalog Database
The catalog database organizes and keeps up with every object in the system’s repository. Each repository has exactly 
one catalog. It is very important that the catalog be protected from deletion or corruption.

There are currently two types of catalogs:

• ACCESS

• SQLSERVER

An ACCESS type catalog database is stored in a Microsoft Access (.MDB) database in the system’s directory. This 
type of catalog database can be used without a separate database server. Each workstation can directly manipulate the 
database without the help of a server program. For this reason, this is commonly referred to as a single-tier database. 
This is much easier to set up and maintain than a SQLSERVER type catalog, but may be less robust than 
SQLSERVER-based catalogs.  The catalog database file for an ACCESS type catalog resides in the system’s 
directory.

A SQLSERVER catalog database is stored in a Microsoft SQL Server database. This type of catalog database can 
only be accessed through a database engine separate from RMS/DeskTop. There are several reasons why a 
SQLSERVER type catalog may be desirable, such as speed, database replication, backup, etc. However, setting up a 
SQLSERVER type catalog is more complex and will require a database administrator for the SQL server that is used.

NOTE: If a single RMS\DeskTop system cannot be maintained at a size equal to or less than 100 MB 
we advise the use of SQLSERVER catalog database. 

Object Store Physical Storage
Object store physical storage is where report and index data objects are stored for a given system. The physical media 
may be magnetic or optical, and is determined by the system’s object store definitions. The physical storage used by 
one system may be spread across more than one physical device or media type when more than one object store is 
defined.

Import Definition Databases
Import definition databases contain rules that control the behavior of IMPORTER. There can be more than one import 
definition database per system. The import definition databases for a system must reside in the system’s directory.

Import Directories
Import directories are directories defined in an import definition database. IMPORTER will scan import directories at a 
specified poll rate. When a file is found by IMPORTER in an import directory, IMPORTER will attempt to import the file.

Name Translation Rules
Name translation rules are defined in an import definition database. They are used to identify reports by filename or 
RMS report name.

Before a file can be imported by IMPORTER, there must exist a name translation for the file. Name translations assign 
a report series specification for reports as they are identified. There are two types of name translation rules: 
FILENAME TRANSLATIONS and RMS REPORT NAME TRANSLATIONS.
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Import Variables
Import variables are used in name translations to perform text substitution when generating a report series 
specification or description for a report. There are two types of import variables: implicit and user-defined. Implicit 
variables are defined automatically by IMPORTER when a file is found. User-defined import variables are explicitly 
defined in an import definition database.

Import Control Database (*)
Each system has one import control database. This database is used by all instances of IMPORTER for two purposes: 

1. to ensure that a single report is not imported simultaneously by two different instances of 
IMPORTER

2. to record files that cannot be imported due to some error so that IMPORTER will not continuously 
retry the import.

The import control database is kept in a file (ICAV.DBF) in the system’s directory.

NOTE: Import database corruptions are resolved by moving both the ICAV1.DBF and ICAV1.MDX from 
the most recent backup cycle.  Both must be from the same system name as that which has 
been corrupted and both ICAV*.* files must be from the same backup time frame.
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An Illustrated Import (*)
The following illustration shows how information from an import definition database and the system definition are 
used to import a report: 

1. A file appears by some means in an import directory defined in the import definition database.

2. IMPORTER polls the import directory and finds the file. IMPORTER checks the import control data-
base and determines that no other instance of IMPORTER is importing the file, and that the file is not 
held due to a previous import error.

3. IMPORTER scans the appropriate name translations from the import definition database and finds a 
matching name translation which is used to produce a report series specification for the new report.

4. IMPORTER scans the report series definitions and finds a matching definition for the new report’s 
report series specification.

5. After compressing and fragmenting the report, and after producing any optional indices, the storage 
class referenced by the report series definition will be used to look up the appropriate object store. 
The compressed objects will be written to the physical media referenced by the object store and ref-
erenced for retrieval in the catalog database.

6. After compressing and fragmenting the report, and after producing any optional indices, the storage 
class referenced by the report series definition will be used to look up the appropriate object store. 
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The compressed objects will be written to the physical media referenced by the object store and ref-
erenced for retrieval in the catalog database.

7. After compressing and fragmenting the report, and after producing any optional indices, the storage 
class referenced by the report series definition will be used to look up the appropriate object store. 
The compressed objects will be written to the physical media referenced by the object store and ref-
erenced for retrieval in the catalog database.

8. After writing the new report and associated objects to the catalog database and object store physical 
storage, the deletion criteria in the referenced storage class will be used to delete old versions of the 
report series as appropriate.

Security Setup
The data contained in an RMS/DeskTop system is secure. It is not possible to view or access data in the repository 
except through the RMS/DeskTop application. The application creates a security profile for each user when they log 
into a system. This profile defines which reports the user can view and what functions the user can perform. The 
security attributes for the system are stored in the security database (ADMIN.DB).
The security database is located in the system directory, and is edited by RMS\DeskTop. There are three main 
entities involved in system’s security setup: users, groups, and report access records.

It is important upon installation of any new DeskTop system, an administrative password be added. Without 
administrative rights the administrator will not have access to the system functions needed to be modified in the 
course of the install. Also, keep in mind that if this administrative password is deleted or changed, the administrative 
rights may no longer be valid.

Users
An individual user of an RMS/DeskTop system, from a security point of view, is known to RMS/DeskTop by a User 
ID, which is a sequence of characters uniquely identifying the user.

In addition to a User ID, a user may have a password. If so, the password must be supplied for the user to gain access 
to the system.

Some users may also have administrator privileges. Only users that have Security Administrator privileges may view 
and modify the security setup for a given RMS/DeskTop system. The only exception is when there are no users with 
Security Administrator privileges. In this case, any user may access the security setup.

Groups
A group is a security-related entity that allows multiple users to be identified and referenced collectively. A group can 
have any number of member users, and a user can belong to more than one group. A group is referenced by name.

Report Access Records
A report access record represents the combination of a report mask and the privilege settings for each group and user 
report series governed by the mask.

Report access records are implicitly ordered by the report mask from more specific to more general.

A report access record may define as few or as many privileges as needed. Any privilege which is left blank is not 
defined, and must be resolved by a more general report access record.

NOTE: The Admin.db and Admin.pdb contain those files which make up the administrative logins and 
passwords.  If system coruption occurs, the administrator would be required to replace both files 
in unison.  These files must also be from the same system from a most recent backup.
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Logical Printers
A logical printer is a combination of settings to be used in printing a report. So why do logical printers exist in RMS/
DeskTop? Well, when printing a report, there are many considerations beyond selecting a Windows printer and the 
related Windows printer setup.

First of all, for the report data to fit onto a printed page, an appropriate margin setting, character spacing, and line 
spacing must be used. These settings can be particularly sensitive when printing report data on pre-printed forms. 
Also, the font one would like to use when printing is not necessarily the same font one prefers for on-line viewing.

Secondly, for impact printers, which are sometimes used for printing on multi-part forms, one often needs to bypass 
the Windows graphics print subsystem in order to achieve reasonable print speeds. To accomplish this, one can select 
the Generic Text printer driver, then change the appropriate INIT and CLOSE strings for the beginning and end of 
print jobs, respectively. The driver uses these strings to send special printer setup codes which, in turn, control the 
printer’s print mode.

And lastly, for a particular RMS/DeskTop system there may be many report layouts requiring special print 
considerations. A user should not have to continually re-specify how a report should be printed. Fortunately, logical 
printers only need to be defined once, at a system level by a user with Printer Administrator privileges, and may be 
used by any RMS/DeskTop user. 

A logical printer encapsulates all of these properties into a single entity. Because each workstation’s connection to all 
available printers can be different, RMS/DeskTop has a multi-layered approach to logical printers. Logical printers 
may be one of three types:

The ability in RMS/DeskTop for a user to override individual attributes of a system-defined logical printer is built-in. 
If a user simply needs to select a different Windows printer, this can be done without affecting the system printer’s 
definition. In addition, logical printers can automatically be selected for a report by either a best-fit page size lookup, 
or by an explicit reference to the logical printer in a report series definition.

System definitions of logical printers are stored in the RMS/DeskTop system’s directory in a file that typically has an 
extension of DTP. When a new system is created, the default system-defined logical printer file is DEFAULT.DTP. 
A user can select a different logical printer file from the SYSTEM PROPERTIES dialog in RMS/DeskTop. Local printer 
definitions and system printer definition overrides are stored in each workstation’s data directory. 

There can be more than one set of system-defined logical printers. This can be desirable when a mixture of versions 
of Windows workstations are using the same system. 

TYPE DEFINITION

System Printer The entire logical printer definition is at the system level, and is 
shared by all users of the system.

Local Printer The entire logical printer definition is on the workstation. The logical 
printer is not shared by other users.

Local Override A system printer with local (workstation) overrides for selected 
logical printer attributes.
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Editing System Definitions
System definition-related settings are edited by the SYSTEM PROPERTIES dialog and a series of other dialogs that may 
be accessed from both RMS/DeskTop and IMPORTER. To edit, a user must be logged into RMS/DeskTop. Go to the 
PROPERTIES menu and click on the system you wish to edit, and the SYSTEM PROPERTIES dialog will appear. Items that 
are edited via other dialogs are grouped together in the SYSTEM SETUP area of the dialog. In IMPORTER, the items are 
accessible under the EDIT menu after opening an import definition database. 

To Set Per-Workstation Settings
Per-workstation settings include local printer override storage and disk cache parameters.

You can specify the file name used to store local logical printer definitions (and system overrides) on a per-
workstation basis by entering the file name in the LOGICAL PRINTERS FILENAME (.DTP) edit field.

Disk Cache Settings
The Disk Cache directory is used to store extracted repository objects like page/line indices for reports and 
compressed user index objects.

RMS/Desktop® uses a shared cache mechanism so that either one user, or more than one user can share the same 
cache directory for the same “system”. Users can also each use a different “system”.
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To access the DISK CACHE dialog click on the DISK CACHE button found in a “systems” PROPERTIES dialog. The DISK 
CACHE dialog appears  

Disk cache settings are controlled via the DISK CACHE dialog. This dialog allows changes in the magnetic cache 
controller settings for the respective system. The indicated directory is used to store extracted repository objects like 
page/line indices for reports and compressed user index objects. RMS/DeskTop uses a shared cache mechanism so 
that more than one user can share the same cache directory for the same system. Each user can also use a different 
directory if necessary. However, pressing UPDATE CACHE DATABASE NOW will cause memory updates to be flushed to 
the disk database.

Several limits may be set on the cache directory. The TOTAL CACHE STORAGE sets a limit on the total amount of storage 
that may be used by the cache. Likewise, the TOTAL NUMBER OF FILES can be used to limit the number of files in the 
directory. When a limit violation occurs, a least recently used strategy will be used to reclaim the indicated percentage 
of storage in use.

As RMS/DeskTop uses the cache, an internal memory database is kept that is used to update the disk based cache 
database. The disk update generally does not occur until the application is closed. However, pressing UPDATE CACHE 
DATABASE NOW will cause memory updates to be flushed to the disk database.
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Changing the Current User’s Password
You may change the current user’s (presumably yourself) password by clicking the CHANGE PASSWORD button. The 
CHANGE PASSWORD dialog will be displayed, allowing you to make the change. However, you must enter the current 
password in order for a new password to be accepted.

Performing Manual Aging of System Reports
The aging process allows you to delete a group of reports from the system. To accomplish this, you select or define 
selection criteria that will select the candidate reports for deletion. The selection criteria is used to build a list of 
reports that match the selection criteria. The selected reports are displayed in a table view. From the table view, one 
can visually confirm the reports to be deleted by selecting or deselecting individual report versions. Once the 
selection is confirmed, the selected reports will be deleted.

NOTE: NOTE: “Manual Aging” can only be done with system administrator privileges. 
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If you want to perform a manual aging of a system’s report content, click the PERFORM AGING button. The SYSTEM 
PROPERTIES dialog will be closed and the AGING SELECTION CRITERIA dialog will be displayed. This is the start of the 
aging process. 

The BASE DATE combo box allows you to set the base date to be used in selection criteria comparisons. You may 
specify either an actual date or select the keyword TODAY. Selecting TODAY sets the base date to the current system 
date.
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You may fill the SELECTION CRITERIA FILENAME edit field by typing a file name, selecting one by clicking the 
BROWSE... button: 

or creating a new selection criteria file by clicking the NEW button.

 If you select NEW or EDIT, the SELECTION CRITERIA dialog is displayed, showing either an empty criteria list or the 
contents of the selected criteria list. The selection criteria file is used to determine which report series and report 
versions are to be selected for deletion. 
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You may enter a descriptive name for the selection criteria list in the DESCRIPTION edit field. Reports that don’t match 
the specified criteria items may be either excluded or added to the results list, depending on your selection in the 
UNMATCHED REPORTS ARE radio buttons.

Finally, you may add new selection criteria by clicking the NEW button or edit existing criteria by clicking the EDIT 
button. Selecting either of these items results in the REPORT SELECTION CRITERION dialog being displayed.

All of the selection components are cumulative. A match is only made when all checked criteria options are met (i.e. 
if DESCRIPTION INCLUDES is checked and the given string is not part of the report’s description, the report does not 
match even if the other selected criteria match).

The REPORT MASK edit field specifies the report series that this criterion will be applied to. This field must be filled 
in. All other criteria are optional and must have their respective checkboxes checked to be evaluated.

The DATE criteria specifies a date range that must be met for either the business or import date properties of each 
report version. A match occurs when the business or import date is within some time frame prior to a specified date. 
Choose either BUSINESS DATE or IMPORT DATE as the date to be used for the SELECT WHEN combo box. Specify a 
number and a quantity time span for the IS WITHIN controls. Finally, specify the reference date in the PRIOR TO combo 
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box. TODAY will cause the current system date to be used. BASE DATE causes the date from the PERFORM AGING dialog 
to be used. CUSTOM DATE allows you to customize your selection by specific date. This is a great way to set up 
relative selection criteria. An explicit date may also be used.

The VERSION NUMBER criteria allows an explicit test on the version sequence number. The most current, or tip, version 
of a report is version number 0. The next version is 1, and so on. Select the appropriate operator and version number.

The DESCRIPTION INCLUDES criteria allows the description to be scanned for a particular text string. The search is case 
insensitive.

The USER FIELD CONTAINS criteria allows the user information to be scanned for a particular text string. The search 
is case insensitive.

If the definition is new and must be saved, the SAVE AS will appear when saved:

When a report matches all of the specified criteria, the report’s selection or exclusion will be determined by the 
MATCH ACTION radio buttons. If a report does not match all of the supplied criteria, the search will continue with the 
next report selection criterion in the list.

Once report mask definitions have been selected and approved for deletion, use the Delete Selected item under the 
EDIT menu in RMS\DeskTop to delete the selected entries.
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Specifying a Default Printing Range
A default print range of ALL or CURRENT PAGE may specified on a per-system basis. This setting controls the default 
print range selected when a report view is active and the PRINT command is selected. This setting does not affect the 
default print range when the PRINT command is selected when the Viewer view is active because there is no “current 
page” available.
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This can also be set on a “system” PROPERTIES dialog. 

If the DEFAULT PRINT RANGE is changed, this means that whenever a user opens a report and selects the print option 
from File on the menu bar the default option will be whatever is checked here.

To Add, Modify, or Delete an Object Store
To add, modify, or delete object stores, access the OBJECT STORES dialog using the appropriate method as indicated 
above depending on whether access will be from IMPORTER or RMS/DeskTop. This dialog allows the user to manage 
all of the system’s object stores.

The OBJECT STORES dialog shows and allows the administrator manage the object stores.

NOTE: NOTE: All Storage Classes referencing a Object Store must be changed before RMS/DeskTop 
will allow a Storage Class to be deleted. 
 
Great care should be taken when modifying or deleting an object store because access to 
system information can be damaged if an object store with existing report references is deleted.
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Use the NEW, EDIT, and DELETE buttons to manipulate object stores as needed. 

Use IMPORT to import Object Stores created in .xml format into your new system.  A single object store or multiples 
may be imported.  Our example indicates a single object store:  
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Use IMPORT or EXPORT to export the list's Object Stores. The exported list can then be used as an imported listing 
into another system. Single or multiple selections may be selected.  Use CHECK ALL to select all, or UNCHECK 
ALL to deselect all.    

The OBJECT STORE dialog is used to define new object stores.   
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The OBJECT STORE dialog is also used to edit existing object stores.

The NAME gives a descriptive title to the object store. This name can be changed without affecting existing references 
to the object store.

The MAX OBJECT SIZE specifies a size limit in kilobytes for individual report objects stored in this object store. The 
report’s compressed data is broken into as many objects as are needed to contain the entire report. Since some 
implementations of object stores may need to recall an entire object/file when a read request is made, this can be used 
to limit the size of each recall. To support this fragmentation, the RMS/DeskTop report viewing architecture does not 
require all of the report to be available directly. Only individual blocks from an object are needed to satisfy a cache 
request. Therefore, during the read of a 50 MB file that was broken into multiple 5 MB objects, only a portion of the 
first object would have to be restored to show the first section of the report.

Object stores may be of two TYPES: Direct File Storage or Disk Extender Storage. Once defined, an object store’s 
TYPE cannot be changed.

DIRECT FILE STORAGE objects are written directly to the file system, which is either local or networked. This can be 
used to interface with some storage managers as well.

DISK EXTENDER STORAGE objects are written to an OTG Disk Extender storage manager. Disk Extender is an add-on, 
server subsystem for RMS/DeskTop that manages optical storage. It requires a PC running Windows Server.

The DIRECT STORAGE DIRECTORY PATH indicates the directory that supplies physical storage for an object store. This 
path can be either explicit or relative to the system’s directory.

To Add, Modify, or Delete a Storage Class
To add, modify, or delete a storage class, access the STORAGE CLASSES dialog using the appropriate method as 
indicated above depending on whether access will be from IMPORTER or RMS/DeskTop. The STORAGE CLASSES 
dialog shows and allows manipulation of the currently defined storage classes.
176 © 2013 Mantissa Corporation. All rights reserved.



R
D

_C
ha

pt
er

_0
7.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3
RMS/DeskTop® Version 3.25 

Reference Guide System Setup
Editing System Definitions
Use the NEW, EDIT, and DELETE buttons as appropriate to change the storage class setup. 

Use IMPORT to import a single  Storage Class or multiple Storage Classes into another system. When IMPORT is 
selected an OPEN dialog is first presented to allow your selection:
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Select the File name and select Open. The Select Items for Import/Export are presented.  Check All or Uncheck All as 
you wish to apply.  In this example we select one selection that applies and select OK: .

When the operation of import is successful the following message will be presented:
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Use EXPORT to export the list’s Storage Classes. The SAVE AS dialog allows the administrator to save the listing as 
an .XML file as indicated below in our example:

The exported list can then be used as Storage Classes within another system by importing them into the new system 
using the Import option.

RMS\DeskTop will message the administrator when the export is saved successfully as well:

The STORAGE CLASS PROPERTIES dialog is used to define new storage classes or to edit existing storage classes. 
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General Tab
The NAME is used to describe the storage class. This name and can be changed without affecting existing references to 
the storage class.

The OBJECT STORE drop-down list allows selection of the object store that provides physical storage for this storage 
class. This reference only affects future imports, and has no effect on retrievals.

The ROUTE is optional information which is provided to the referenced object store. Its use is object store type-
dependent. At present, this value is ignored by all object stores.

Import Filters Tab
Filters are used to delete reports that are deemed wasteful and as defined by retention records. The first filter that we 
offer is for business dates.

BUSINESS DATE FILTER will allow you to discard duplicate reports for the same business date. Discarded reports are 
NOT archived because they are deleted before aging & archiving properties are applied.  Set the number of versions 
that you wish to keep for the same business date. A value of one will discard ALL duplicate reports.
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If you are archiving reports, it is necessary that a time is considered after which the final version(s) is likely to be in 
place. The reason this is necessary for archiving reports is because the archiving product can mistakenly archive a 
report that could be replaced by a newer report with the same business date in the near future. You should enter a time 
limit that the filter remains actively filtering for reports with the same business date. If you feel that the final version 
of any report is likely to be in place 30 days after its business date, set the property to 30 days.

One storage class in the system may be marked as the DEFAULT, and report series definitions may select Default as 
the their related storage class.

Automatic Deletion Tab
This dialog allows the user to define or edit the aging properties for the storage class.

Automatic deletion is performed for a report series after successfully importing a new report version. There are three 
possible settings: no deletion criteria, version limiting, age limiting, or both version and age limiting.

When no deletion criteria is specified, there will be no automatic deletion of report versions. Old versions must be 
manually deleted by a user with appropriate delete privileges.

When the DELETE ALL ABOVE VERSIONS checkbox is selected, the value specified will be used to delete any reports 
whose version number is above this version. 

When the DELETE VERSIONS OLDER THAN checkbox is selected, the age values specified will be used to delete any 
reports whose business dates are older than the indicated value.

When both DELETE ABOVE VERSIONS  and DELETE VERSIONS OLDER THAN  are selected, a version will be deleted if its 
version number is higher than the supplied version limit OR if the version is older than the indicated age limit.

ARCHIVE BEFORE AGING will instruct the Importer to not age reports. If you are running the Archiver for this system, 
the aging is performed by the Archiver.

NOTE: NOTE: All report series referencing a storage class must be changed before RMS/DeskTop will 
allow a storage class to be deleted.

To Add, Modify, or Delete a Report Series Definition
To add, modify, or delete a report series definition, access the REPORT SERIES DEFINITIONS dialog via the SYSTEM 
PROPERTIES DIALOG in RMS/DeskTop or via the Importer. The REPORT SERIES DEFINITIONS dialog shows and allows 
manipulation of the currently defined report series definitions.
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Use the NEW, EDIT, DELETE and SORT buttons as appropriate to change, delete or sort the report series definition 
setup.

Use UP and DOWN to reorder the report series definitions for the appropriate precedence. Explicit report series 
definitions are generally placed higher than wild card report series definitions. When searching for a report series 
definition for a particular report series, the first definition whose SERIES SPEC matches the report series, searching 
from top to bottom, will be used.

The REPORT SERIES DEFINITION dialog is used to create new report series definitions and to edit existing report series 
definitions. A shortcut to the REPORT SERIES DEFINITIONS dialog exists from the PROPERTIES->REPORT PROPERTIES-
>REPORT SERIES dialogs in RMS/DeskTop. This shortcut will take you to an existing explicit definition or let you 
create a new one for a report series that has no explicit report series definition. From REPORT PROPERTIES select 
Report Series. This brings up the REPORT MASK PROPERTIES DIALOG that contains four tabbed pages: GENERAL, 
INDICES, FORMS and AUTO EXPORTS. 

Use IMPORT to import Report Series Definitions into the list.

Use EXPORT to export the list's Report Series Definitions. The exported list can then be used as an imported listing 
into another system.

SORT is used to place the listed items in their proper sequence. The sorting actually fixes any erroneously placed 
masks so that the most explicit ones are placed above least explicit ones.
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The GENERAL tab applies to general properties of all report series definitions. The GENERAL tab of the REPORT MASK 
PROPERTIES dialog is shown below. 
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The INDICES tab lists indices to be produced for each report during import. Use the buttons to move, edit, and create 
indices. The order of the indices in this list is the order that they will appear when presented for a report. Place the 
primary index at the top of the list. 

The following is an example of the INDICES tab. 
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The FORMS tab lists forms that may be attached to each report controlled by this series definition. Multiple forms may 
be specified. A “default” form may also be specified. Users are allowed to switch between different assigned forms 
while viewing a report via the “Form Properties” property sheet.

The following is an example of the FORMS tab. 
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The AUTO-EXPORT tab is used to automate the distribution of a report and/or its indexes to specific locations in the 
LAN. The export operation is performed shortly after the Importer (*) has processed the report. If you wish to 
automate exporting of data that you are manually doing on a regular basis, you may want to consider using an Auto-
Export definition. There is no limit on how many definitions you can create.

The following is an example of the AUTO EXPORTS tab. 

NOTE: NOTE: See complete functionality of each tab in the Report Mask Properties dialog in Chapter 9 
of this manual.
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To Add, Modify, or Delete a Date/Time Locators
To add, remove, edit, import or export date/time locators, select Date/Time Locators from the Edit menu.  A list of 
locators will appear:         

These Date/Time Locator Properties dialog allows the user to specify a method for locating date/time information 
from the body of a report while importing the report.  Date/time locators are used by the report series definitions to 
determine the business date for reports.  It's composed of two pages/tabs.
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The GENERAL tab details the general properties of a date/time locator. .      

The Name is used to give the date/time locator a descriptive title.  The name can be changed without affecting 
existing references to the date/time locator.

The Report Area to Scan specifies the area of the report that will be searched for the date/time locator.  Typically, the 
business date for a report will be somewhere near the top of the report.  The Start/End Line and Column settings form 
a rectangular area that will be searched for the date.

The Start/End Line settings indicate the starting and ending lines inclusive.

The Start/End Column settings indicate the columns inclusive.  The optional end of line checkbox can be used to 
specify that the end column is the end of each line.

The date choice pop down list allows a choice of dates when more than one date is found within the scan area.  
Options include selecting the 1st to the 9th sequential date, or the oldest, newest or last date encountered.
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The FORMATS tab allows an edit to the various date/time formats:  

This dialog allows one or more parsing formats for date recognition to be entered.  Parsing formats are created by 
combining characters that define how a date/time is to be interpretted.  See the Date/Time format dialog.

When scanning for a date, report content is tested against the formats in the order listed; therefore, make sure that 
more specific formats are listed before less specific formats.

This button is used to move an item down in the list.  Using the mouse, you may also move an item by 

dragging and dropping it onto its desired order in the list.

This button is used to move an item up in the list.  Using the mouse, you may also move an item by 
dragging it and dropping it onto its desired order in the list.

This button is used to delete the selected format from the list.

This button is used to create a new date/time format.

This button is used to edit the selected format.  You may also double-click on the format to edit it.The 
Date/Time Locator format dialog is used to edit or define a format for a date/time locator.
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C h a p t e r  8 :

Security

This section is a reference for RMS/DeskTop security. It covers both RMS/DeskTop security concepts, as well as, 
in-depth discussion of “How to” subjects. The SYSGEN program, which provides a way to create new systems, is 
also covered.

Where are the Security Controls
There are two aspects of RMS/DeskTop security: 

• Creating new Systems

• Manipulating a System’s Security Settings 

New systems are created with the SYSGEN component/program. SYSGEN has no other purpose, and is not used 
by most users. Some system administrators may even choose to remove this program from their installation.

Security settings are manipulated with RMSDT32 (i.e., the main RMS/DeskTop program). To gain access to an 
RMS/DeskTop system’s security settings, a valid user ID and password for a user that is granted Security 
Administrator privileges for the system will be required.

Security Components
The RMS/DeskTop security system has three main components which are users, groups, and report access records. 

Of these three, REPORT ACCESS RECORDS are central to accomplishing the main purpose of RMS/DeskTop security. 
A security setup can have many report access records. These records are all used to calculate the final access 
privileges for a specific user to a specific report. For more information, see HOW PRIVILEGES ARE DETERMINED in 
this chapter.

A security setup will typically contain a number of users which are assigned membership in groups that are 
appropriate for the security needs of the system. For example, one may define an “Accounting” group that is used to 
grant access to accounting-related information. Each user that has a need for accessing accounting information would 
be a member of the “Accounting” group. Users may be a member of more than one group, and will be granted access 
based on their membership.

Report access records can have explicit user privilege settings. However, this often leads to a security setup that is 
more difficult to maintain over time. Also, if a system has a large number of users, the security setup can become 
quite large. 

NOTE: Unless you have very special circumstances, use group privileges instead of user privileges. 
This produces a security setup that is easier to define and maintain, and the underlying security 
records are kept small and, therefore, quick to evaluate.  Those administrators that choose to 
define individual users records not associated to groups will cause degradation in login 
performance.

The Default User
When a system has no defined users, a “Default” user is automatically added and cannot be deleted. This user initially 
has no password. Under this scheme, the system always has at least one defined user. This is the case for a new RMS/
DeskTop system.
© 2013 Mantissa Corporation. All rights reserved.  191



R
D

_C
ha

pt
er

_0
8.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3

RMS/DeskTop® Version 3.25 

Security Reference Guide
The Administrator
An Administrative User record should be added to each new RMS/DeskTop system immediately after installation. 
Without the default administrative user, no administrative rights will exist for the system administrator. Also, if this 
administrative password is deleted or changed, the administrative rights may no longer be valid. It is imperative that 
the administrator first assigns an administrative login.  

NOTE: If a security administrator is not added to each system at installation time no edit/create system 
definitions such as Report Series Definitions, Filename Translations, etc. can be performed.

Secure and Non-Secure Systems
RMS/DeskTop systems may be secure or non-secure. An RMS/DeskTop system is non-secure if the only user in a 
security setup is the “Default” user with an empty password. In this case, when the system is accessed, the user is not 
burdened with a logon dialog. The user is automatically granted access to the system as the “Default” user. This 
feature is useful in situations where an RMS/DeskTop system needs no security. After creation, a new RMS/
DeskTop system is non-secure.

If any change is made to the “Default” user or if new users are added to the security setup, the system will no longer 
be non-secure.  Gaining access to the system will require a valid User ID and password.

NOTE: If a security administrator is not added to each system at installation time no edit/create system 
definitions such as Report Series Definitions, Filename Translations, etc. can be performed.  
This means no administrative ability is available to allow system modifications.  A reinstall would 
be required if entry for system edits are disallowed.

Report Access Record
A report access record contains the combination of a report mask, and privilege settings for each group and user. A 
given report access record will apply to all report series governed by the mask.

A report access record may define as few privileges as needed. Any privilege which is left blank is not defined, and 
must be resolved by a more general report access record.

Report access records are central to accomplishing the main purpose of RMS/DeskTop security. A security setup can 
have many report access records. These records are all used to calculate the final access privileges for a specific user 
to a specific report.

How are Privileges Determined?
When a given privilege for a given user and report series is needed by RMS/DeskTop, the privilege will be 
determined by searching the report access records from most restrictive to least restrictive for a record that defines the 
privilege for the report series.

As each report access record is encountered, first the report mask is tested to see if the report access record applies to 
the report series in question. If the report mask matches the report series, first the user’s explicit privilege is checked; 
if the user’s explicit privilege is empty, all groups of which the user is a member are checked for the privilege setting. 
If all member group’s privilege settings are empty, the search continues with the next report access record. If any 
member group has an explicit privilege setting, the users privilege will be determined by the least restrictive privilege 
for a member group at that report access record.

When no other report access record establishes a privilege, the default report access record’s [Everyone] group 
privileges will supply the privilege.

The [Everyone] Group
The [Everyone] group is automatically created and maintained by RMS/DeskTop and cannot be deleted. Every user 
is automatically a member of the [Everyone] group.
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To Access a System’s Security Setup
The [Everyone] group is very useful for denying or granting access privileges to all users at any level. Also, the 
[Everyone] privileges in the default report access record (\*) must be either Yes or No, and cannot be unspecified. 
This setting, in the default report access record establishes the basic strategy used for the system (e.g. permissive, 
restrictive, or mixed).

Report Access Privileges
Report Access Privileges are the individually controllable capabilities that may be granted to or denied from users for 
each report.

A security setup will typically contain a number of users, which are assigned membership in groups that are 
appropriate for the security needs of the system. For example, one may have an Accounting group that is used to grant 
access to accounting related information. Each user that has a need for accessing accounting information would be a 
member of the Accounting group. Users may be a member of more than one group, and will be granted access based 
on their membership.

Report access records can have explicit user privilege settings; however, this is typically more difficult to maintain 
over time. Using group privileges produces an easier security setup to define and maintain.

All users are always a member of the [Everyone] group.

Security Strategies
There are basically three strategies that can be taken for a security setup: permissive, restrictive, or mixed.

A permissive strategy is one where the default report access record’s [Everyone] group grants all privileges. This 
means that unless overridden with more specific report access records, all users will have full access to all reports in 
the system. This is a good approach if most data is non-sensitive, but some data may be restricted to some users. This 
is the default strategy for new systems.

A restrictive strategy is one where the default report access record’s [Everyone] group denies all privileges. This 
means that unless overridden with more specific report access records, no users will have any access to report data. 
This is a good approach if most data is sensitive, and requires that explicit rules be setup to grant access to reports.

A mixed strategy is one where the default report access record’s [Everyone] group grants the View privilege, but 
denies some other privileges like the Delete privilege. This is a good approach for situations where you generally 
want to grant access, but don’t want users to be able to accidently or intentionally delete report information from the 
system.

To Access a System’s Security Setup
In the past, the system's security properties were edited with SYSGEN. Now, the SYSGEN system generator is used 
only for the creation of new systems.

To Open a System’s Security Setup
The security setup for a given RMS/DeskTop system is contained in a security setup database (ADMIN.DB). Security 
settings are manipulated from the main RMS/DeskTop program (RMSDT32.exe).

NOTE: If the admin.db becomes corrupted and needs replacement due to a corruption both the 
Admin.db and Admin.pdb must be moved in unison from the same cycle backup.  Login will be 
disallowed if they are not moved/replaced in this manner.
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To Access a System’s Security Setup
To open a security setup, open RMS/DeskTop and ensure that the system for which security settings are to be 
manipulated is shown in the Viewer View. If the system is not shown, the Systems Path, which is accessed via the 
Application Properties dialog may need to be updated to include the directory of the system to manipulate. Once the 
system to manipulate is found, either use the System’s popup menu from the Viewer’s node view, or use the 
respective System Property menu item from the Properties menu.
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To Access a System’s Security Setup
This interaction will cause the respective System Property dialog to appear. 

If the current RMS/DeskTop system is secure, a valid User ID and password for a user who has Security 
Administrator privileges will be required. After passing the administrator logon, the system’s security setup will be 
open and accessible.
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The Security Properties Dialog
The Security Properties Dialog
From the System Properties dialog, press the Security button to access the security settings for the system. 

As can be seen above, the Security Properties dialog has several tabbed sections, which provide access to all of the 
RMS/DeskTop security settings.

NOTE: The MDAC verion posted is the MDAC version resident on this local machine.  MDAC fixes 
should not be applied from the installation CD unless directed by Mantissa Customer Support.  
Upgrading MDAC versions could cause applications to fail.  RMS\DeskTop is tested with a 
specific version of MDAC and dlls.  We recommend that these be used and not modified unless 
directed to do so.

Select the appropriate tab to view or modify the respective security settings.
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The General Tab
The General Tab
The general tab provides view only access to the system’s name and catalog type. This is for information purposes 
only. There is no input control allowed. 

System Name and Cache ID
To the right of the System Name in the Security Properties dialog you will notice a numerical value within 
parentheses. This number is the Numerical ID that links the system to the application. Each time a new system is 
created a numerical ID is created as a subdirectory of the DATA directory, which maintains the system’s Cached 
links.

The Users Tab
The USERS TAB shows all of the users that are defined in the system. When the USERS TAB is the focused view, users 
may be added, modified, or deleted.  Specific USERS may be focused by selecting the USER ID from the user list.    

The view contains several columns of information about each user, and can be sorted or scrolled as necessary. To 
change the width of a column, press and drag the pointer on the edge of the column header to resize.
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The Users Tab
 This button will print the grid's content.

 This button is used to delete the selected user from the list. You may also press the [Del] key on the 
numeric keypad to delete a user.

 This button is used to edit the selected user. You may also double-click on the user. When editing a 
user the User Profile Dialog will appear.

 This button is used to create a new user. You may also press the [Ins] key on the numeric keypad to 
create a new user.

 This button is used to import user lists from one system’s directory to another with the same attributes, 
or with minor edits.

The following table lists and describes each field in the USERS TAB.

Field Action

User ID Displays the user’s User ID. This is how the user is identified in the 
system. A user’s User ID cannot be changed.

Administrator If the user has been designated as a security administrator, check is 
placed in this column.

Name Displays the user’s name as entered on the user profile dialog.

Groups Displays all of the groups to which the user belongs. All users belong 
to the [EVERYONE] group. There is no way to exclude a user from the 
[EVERYONE] group.
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The Users Tab
To Add, Change, or Delete a User
Users may be added, changed, or deleted from the security database when the USERS TAB is the focused view. There 
are several ways to affect changes including using the New, Edit, and Delete command buttons, using the popup 
menu for a given user row, or double clicking the user row. As appropriate, the User Profile dialog will appear for 
changes to be made. 

The USER ID is an identifier that will uniquely distinguish the user with the security setup. Once defined, a USER ID 
cannot be changed.

The NAME field within this dialog is descriptive.  The field entry will be used on the user’s Notes heading.

The SECURITY ADMINISTRATOR PRIVILEGE may be granted or denied to individual users. This privilege governs the 
ability to access the system’s security setup and import definition databases. If no users are granted security 
administrator privilege, all users have administrator privilege.

The PRINTER ADMINISTRATOR PRIVILEGE governs the ability to define, edit, and delete system printers. Users who do 
not have PRINTER ADMINISTRATOR privilege may still create logical printers; however, their printer definitions will not 
be shared with other users.

The SYSTEM SETUP ADMINISTRATOR PRIVILEGE governs the ability to define, edit, and delete system setup attributes. 
These include Object Stores, Storage Classes, Report Series Definitions, and Date/Time Locators. Users who do not 
have System Setup Administrator Privilege may view, but not modify, the system setup. This privilege also controls 
whether a user can modify import definition setups which include Name Translations, Import Directories, and Import 
Variables. For more information on these attributes see help in DtImport or RMSDT.
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The Users Tab
The ARCHIVE SETUP ADMINISTRATOR PRIVILEGE governs the ability to create profiles for archival purposes. This right 
is used with the Archiver add-on to RMS/DeskTop.

The DISTRIBUTION SETUP ADMINISTRATOR PRIVILEGE governs the ability to create profiles for distribution purposes. 
This right is used with the Archiver add-on to RMS/DeskTop.

The IMPORT button allows an administrator to import a user's rights from a previously saved text file. The EXPORT 
button allows you to export the security rights of the user to a file.

The SELECTED GROUPS list shows the groups of which the user is a member. The AVAILABLE GROUPS list shows the 
groups to which the user is not a member. To change group membership, select the group to move and press either << 
to remove membership or >> to gain membership. Note that membership in the [EVERYONE] group cannot be 
removed.
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The Users Tab
Importing User’s Rights
If the administrator wishes to take advantage of importing user’s rights he may do so by importing a text file.  Using 
the IMPORT button, import the desired text listing.  The dialog below is presented for file selection:

NOTE: The administrator MUST ensure that the first line of the .txt file selected for import defines the 
order of the fields that are being imported.

RMS\DeskTop currently uses two fields: "userid" and "username".   We also use the first line to determine the 
character delimiting the fields. DeskTop will look for the first comma, tab, or space character to determine the field’s 
delimiter.  This flexibility allows you to place the 'userid' and 'username' fields anywhere on the line and ignore any 
extra fields. Second and subsequent lines in the file will contain the users--one per line!  Some examples follow:
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EXAMPLE: Use comma for delimiter.
        userid, username
        mfickling, Mike Fickling
        jfernandes, Jack Fernandes

EXAMPLE: Use comma and reverse the fields.
        username,userid
        Mike Fickling, mfickling, 
        Jack Fernandes, jfernandes

EXAMPLE: Use space and reverse the fields.
        username userid
        mfickling MikeFickling
        jfernandes JackFernandes

EXAMPLE: Use a comma and ignore some fields.
        username,,,,userid
        Mike Fickling, Finance+AP, Night shift, full-time, mfickling
        Jack Fernandes, AR+AP, Night shift, part-time, jfernandes

To Create a User’s Password
A user’s password may be created by an administrator. If a user forgets their password, the administrator can reset it 
for them.  A user’s password can be altered without their permission by any user granted security administrator 
privileges. The user may also have permission to modify his or her own password by selecting Edit Rights and 
selecting User can change password at anytime.

The PASSWORD  button on the USER PROFILE dialog presents the PASSWORD PROPERTIES dialog.
202 © 2013 Mantissa Corporation. All rights reserved.
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The Users Tab
To set a new password, enter the new password in both the “Password” and “Confirm Password” boxes and press the 
OK button. CANCEL will abort the process and leave the password unchanged.

Use this dialog to set the password's expiration, its minimum length, and how often the user needs to change it. The 
dialog is divided into two sections. The Edit Rights section allows you to select whether the user can change the 
password that is initially issued. You can also force the user to change the password on a periodic schedule. Another 
property is the length of the password that a user must enter whenever the password is changed. The Duration section 
allows you to control when the password expires.

NOTE: Users may change their own password for a particular RMS/DeskTop system from the RMS/
DeskTop application’s SYSTEM PROPERTIES dialog, but they must first log onto the system.

To Change a User’s Existing Password
A user’s password may be changed by a user if they know their old password. If a user forgets their password, the 
administrator can reset it for them. Also, a user’s password can be altered without their permission by any user 
granted security administrator privileges. The CHANGE PASSWORD  button on the SYSTEM PROPERTIES dialog presents 
the CHANGE PASSWORD dialog.

To set the new password, enter the old password and then enter the new password in both the “new” and “verify” 
boxes and press the OK button. CANCEL will abort the process and leave the password unchanged.

Users may change their own password for a particular RMS/DeskTop system from the RMS/DeskTop application’s 
SYSTEM PROPERTIES dialog, but they must first log onto the system.
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The Groups Tab
This tab shows all of the groups that are defined in the system. Use this tab to add, edit, or remove groups. For easier 
viewing the groups may also be sorted by Group ID. To sort simply click on the respective column with the mouse 
pointer. By default, the groups are sorted in ascending order by Group ID.    

A user can belong to more than one group. Groups allow report access control to be easily applied to several users at 
once. By setting up most report access control records for groups, the access privileges for an individual user can be 
modified simply by changing the user’s group membership.

 This button is used to delete the selected group from the list. You may also press the [Del] key on the 
numeric keypad to delete a group. The [Everyone] group can never be deleted.

 This button is used to create a new group. You may also press the [Ins] key on the numeric keypad to 
create a new group.
204 © 2013 Mantissa Corporation. All rights reserved.
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The Groups Tab
 This button is used to edit the selected group. You may also double-click on the group. When editing a 
group the Group Profile Dialog will appear.

 This button will print the grid's content.

To Add, Change, or Delete a Group
Groups may be added, changed, or deleted from the security database when the GROUPS TAB is the focused view. 
There are several ways to affect changes including using the New, Edit, and Delete command buttons, using the 
popup menu for a given user row, or double clicking the user row. As appropriate, the Group Profile dialog will 
appear for changes to be made. 

The NAME is a unique identifier for the group. Once the group name has been established, it cannot be changed. 

The SELECTED USERS list shows users that are members of the group. The AVAILABLE USERS list shows users that are 
not currently members of the group. To change the group’s membership, select the user to move and press either << 
to remove membership or >> to gain membership. 
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The Report Tab
The Report Tab
This view shows all of the report access records defined in the system. The records are automatically sorted from 
most specific to least specific. This order, from top to bottom, is the order that the access records will be searched 
when determining a privilege for a given user. 

A report access record grants or limits the access privileges for a user or group over a specific report series or a group 
of report series. 

 This button is used to delete the selected report from the list. You may also press the [Del] key on the 
numeric keypad to delete a report. 

 This button is used to create a new report. You may also press the [Ins] key on the numeric keypad to 
create a new report.

 This button is used to edit the selected report. You may also double-click on the report. When editing a 
206 © 2013 Mantissa Corporation. All rights reserved.
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The Report Tab
report the Report Mask Dialog will appear.

 This button will print the grid's content.

To Add, Change, or Delete a Report Access Record
Report Access Records may be added, changed, or deleted from the security database when the REPORTS TAB is the 
focused view. There are several ways to affect changes including using the New, Edit, and Delete command buttons, 
using the popup menu for a given user row, or double clicking the user row. As appropriate, the Report Access dialog 
will appear for changes to be made.

Note that the default report access record (\*) cannot be deleted. 

When adding a new report access record, supply the REPORT MASK indicating the report series or group of report series 
for which access is to be controlled. When editing a report access record, this field cannot be changed.

The report access dialog shows either GROUP privilege settings or USER privilege settings. Use the GROUPS button to 
view group settings. Use the USERS button to view user settings. Generally, using group privileges to control a 
security setup produces a system that is easier to define and maintain. However, circumstances may dictate that 
explicit user privilege settings be used.

The first column of the PRIVILEGE TABLE lists the system’s defined groups or users based on the current viewing 
selection. For each group/user, the current settings of each privilege are displayed. A privilege setting of Yes or No 
explicitly defines the privilege at this record. A blank privilege will cause this record to have no definition for the 
associated privilege and user or group.  By default this record will take on the privileges of the default [Everyone] 
Group. To change a privilege setting, click the left pointer button in the appropriate cell. As the pointer is clicked, the 
privilege setting for the cell will toggle through Yes, No and blank values.
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The Report Tab
Report Access Privileges
Report access privileges are the individually controllable capabilities that may be granted or denied users for each 
report.

The following table lists each privilege and what it controls.

How Privileges are Determined
When a given privilege for a given user and report series is needed by RMS/DeskTop, the privilege will be 
determined by searching the report access records from most restrictive to least restrictive for a record that defines the 
privilege for the report series.

As each report access record is encountered, first the report mask is tested to see if the report access record applies to 
the report series in question. If the report mask matches the report series, first the user’s explicit privilege is checked; 
if the user’s explicit privilege is empty, all groups of which the user is a member are checked for the privilege setting. 

PRIVILEGE CONTROLS

View Controls access to the report. If one cannot view a report, one cannot 
access the report in any way. Note: if a user is unable to view a report, 
then none of the other access controls are meaningful because to 
manipulate a report, a user must be able to first see that the report 
exists in a chooser.

Print Controls whether the user can print the report.

Delete Controls whether the user can delete the report. This applies to both 
direct attempts to delete report from the chooser and indirect attempts 
to delete the report through the aging process.

Hide Controls whether the user can mark any of the report versions as 
“hidden” through the REPORT PROPERTIES dialog in the application. 
Consult the application’s online help for more information on hidden 
reports and other report properties.

Date Controls whether the user can change the business date of the report. 
Changing the business date for a report will cause the versions for the 
report series to be re-sequenced.

Info Controls whether the user can alter the report’s Description or User 
Info properties.

Copy Controls whether report data may be copied to the windows clipboard 
or not.

Export Rpt Whether the user is allowed to export the report to a text file

Export Table Whether the user is allowed to export tabular (index) report data

Save Table Whether the user is allowed to save indices into the repository

Arrange Cols Whether the user is allowed to re-order the report columns

Extract Whether the user is allowed to perform data extractions for the report

Edit Annt Whether the user is allowed to edit annotations for the report

View Annt Whether the user is allowed to view annotations for the report

View Arch Whether archived reports are displayed in the DT Explorer window. 
This privilege is turned off by default when a new system is created.

Import Files Whether the user can import files. This right only applies to the ad-
hoc import function in the DT Explorer window.  
This privilege is turned off by default when a new system is created.
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If all member group’s privilege settings are empty, the search continues with the next report access record. If any 
member group has an explicit privilege setting, the users privilege will be determined by the least restrictive privilege 
for a member group at that report access record.

When no other report access record establishes a privilege, the default report access record’s [Everyone] group 
privileges will supply the privilege.

To determine the access privileges for a given user and report series, use the Check Access Tab which can be accessed 
from the Security Properties.

To Test User Access to Reports
RMS/DeskTop security setups can be as simple or complex as required. After security setup changes are made, it is a 
good idea to test the security that has been defined. This can be done with the USER ACCESS Tab without having to use 
the RMS/DeskTop application. 

To check access privileges, supply the REPORT SERIES SPECIFICATION that should be tested. A report mask may also be 
supplied. Select the USER whose privileges are to be checked for the indicated REPORT SERIES SPECIFICATION.
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Security Reference Guide
The Report Tab
Press the CHECK ACCESS button to update the display.

The ACCESS for each individual privilege will indicate Yes or No.

The USER/GROUP column indicates the user or group privilege setting that supplied the privilege.

The REPORT ACCESS RECORD column indicates the report access record that supplied the privilege setting.
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Reference Guide Data Import (*)
Overview
C h a p t e r  9 :

Data Import (*)

Overview
This section is a reference for the RMS/DeskTop import program. It provides a detailed reference for configuring 
and running the importer.

What does Importer do?
RMS/DeskTop Import (IMPORTER) is a program that is responsible for bringing reports into an RMS/DeskTop 
system. It is a Windows application, and has a visual interface. Once IMPORTER is properly configured, it can be run 
in a minimized window, requiring only an occasional need for human intervention.

IMPORTER is responsible for the following:

• monitoring directories for the arrival of reports that should be imported

• identifying reports that should be imported by filename or RMS report identification

• assigning an RMS/DeskTop report series specification for reports

• determining the BUSINESS DATE and IMPORT DATE for reports

• producing INDICES for reports

• producing exports for Indices or reports

• compressing, cataloging, and writing data into an RMS/DeskTop system

• allowing import definitions to be created and/or edited

• aging of reports if aging is on and the associated object store notes report should be aged.

At any one time, a IMPORTER may only be operating on behalf of one RMS/DeskTop system. Therefore, a single 
instance of IMPORTER cannot be simultaneously importing reports into two RMS/DeskTop systems.

How does Importer work?
IMPORTER retrieves its setup instructions from an import definition file. Import definition files typically have a .IDB 
file extension and is housed in the system’s home directory to which it applies. RMS/DeskTop. 

NOTE: One should not copy an import definition file from one RMS/DeskTop system directory to 
another RMS/DeskTop system directory.

An import definition file may be opened either by command line parameter (the -i option) or by using the FILE menu 
after IMPORTER starts. 

New import definitions may be created using the NEW command on the FILE menu. An administrator logon will be 
required for the associated system. Import definition files may be opened and run by any user, however, since an 
ability to change report name translations could affect access privileges, only users with administrative privileges are 
allowed to change or create import definitions. 

When the -i command line option is used to open an import definition file on start-up, the importer will automatically 
enter RUN mode without user intervention. When an import definition file is opened via the FILE menu, the importer 
leaves RUN mode so that import definitions can be modified, if necessary, prior to any attempts to poll the import 
directories.
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Data Import (*) Reference Guide
Overview
When running, IMPORTER “polls” the defined import directories at their respective polling frequencies. When a file is 
found in one of the import directories, the importer will first check the import control database (ICAV1.DBF) to see if 
the newly discovered file needs to be imported. If no other importer is importing the file, and if the file was not 
previously recorded as not being importable (i.e., some error prevented a successful import), IMPORTER will write a 
record to the import control database indicating that an import is in progress for the file. The importer will associate 
its name with the import-in-progress record for the file so that other importers will not attempt to process the file. 
This arbitration mechanism makes it possible to have more than one importer operating at the same time without 
danger of a file being accidentally imported twice.

The first thing the importer must do with a newly discovered file is find an appropriate name translation rule for the 
file. This is done based on the type of the file. If the file is an RMS report, the RMS report name translations will be 
searched from top to bottom looking for a rule that matches the report’s location, class and report ID attributes. The 
first matching rule found will be used. Likewise, if the report is not an RMS report, the filename translations will be 
searched for a match on the filename. If a name translation rule cannot be found, a record will be written to the import 
control database indicating that a report name translation could not be found for the file, and the IMPORT PROBLEMS 
PANE in the import window will indicate the problem. Once the error is corrected, one can select the line showing the 
problem and press RETRY to have the importer retry the import for the file.

Once a valid name translation has been found for the report, the importer looks up a report series definition in the 
system’s configuration for the report series specification produced by the name translation rule. The report series 
definitions are searched from top to bottom, and the first report series definition with a matching SERIES SPEC will be 
used to import the report. If no matching report series definition is found, an import error is recorded indicating 
theproblem, and no further action is taken for the file until the user requests a RETRY.

Once a valid report series definition is found for the report, IMPORTER will begin processing the report data. During 
processing, the report will be compressed, segmented into multiple file objects, scanned for a business date, and 
indexed. All these actions are controlled by the report series definition, and if any error is encountered (can’t 
determine business date, extraction definition doesn’t exist for an index, etc.), an appropriate error is recorded as 
mentioned above.
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Reference Guide Data Import (*)
To Launch Importer
Finally, once the entire report has been successfully compressed and indexed, and once a valid business date has been 
established, the individual file objects that comprise the report and its indices are written into the system’s repository 
and cataloged for access. The type of storage that will be used to store the report and its associated indices is 
determined by the storage class referenced in the report series definition used to import the report. The storage class 
may, in addition to routing the report onto an object store for physical storage, specify automatic deletion criteria. 
After a successful import, automatic deletion criteria are evaluated and, as a result, some versions of the report may 
be deleted. Automatic deletion may be controlled by a version limit (e.g., delete versions above version 10), an age 
limit (e.g., delete any report whose business date is more than 10 months old), both, or neither.

The system configuration may be changed from both IMPORTER and the RMS/DeskTop application. Whenever 
IMPORTER needs to look up a configuration object, it first checks the system definition database file (SYSDEF.DBF) 
for changes. If this database has been updated on disk, its contents will be refreshed in memory.

To Launch Importer
From your Windows PROGRAMS menu select RMS/DeskTop 3.0 and IMPORTER. The Importer’s main window will 
appear. 
© 2013 Mantissa Corporation. All rights reserved.  213



R
D

_C
ha

pt
er

_0
9.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3

RMS/DeskTop® Version 3.25 
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Importer Window Components
Importer Window Components
The IMPORTER application window is divided into three panes:

• the IMPORT PROBLEMS PANE 
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Importer Window Components
• the IMPORT DIRECTORY MONITOR PANE 
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Importer Window Components
• the IMPORT PROGRESS MONITOR PANE.

The Import Menu Bar

This Menu Bar provides functionality within the Importer window.

 OPEN - This button allows you to OPEN a new Importer System.

 START - This button allows you to START/RUN the currently open Importer definition.

 STOP IMPORTER - This button allows you to STOP running the currently open Importer definition.

 VIEW TABBED PANELS - This button allows you toggle to TABBED PANELS  view. 

VIEW TRIPANE - This button allows you to VIEW the Importer window in the three panel mode

 TALK TO MANTISSA - This button allows you to TALK  to MANTISSA SUPPORT.
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Reference Guide Data Import (*)
Importer Window Components
NOTE: NOTE: The “Tripane and “Tabbed” interfaces provide an easy way to change the application 
layout, depending on the information the user is interested in. 

The Import Problems Pane
The IMPORT PROBLEMS PANE lists files that could not be imported due to some import error. The pane can show either 
problems that are limited to this particular importer, or problems for all importers. Simply select the desired viewing 
selection from the top of the pane.   

Each item in the list shows a brief description of the problem. For more details, simply review the DETAILS item 
listing positioned at the right of the ERRORS.
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Importer Window Components
The DETAILS dialog is a modeless dialog and may remain visible while selecting other items from the problems list. 
The DETAILS dialog will update based on the currently selected problem item. The DETAILS dialog may be sized by 
dragging the mouse on either the right or left side of the dialog.

The IMPORT PROBLEMS PANE may be used to determine the reason that a file cannot be imported. The RETRY button 
causes IMPORTER to retry importing the selected files in the problem list. The RETRY ALL button causes IMPORTER to 
retry all files in the problems list.
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Importer Window Components
The IMPORT PROBLEMS PANE will automatically refresh as problems occur if the AUTO REFRESH ACTIVITY VIEW menu 
item is checked on the VIEW menu. Automatic refresh may be disabled by unchecking this menu item. At any time, 
the REFRESH button in the IMPORT PROBLEMS PANE may be used to refresh the problems list.

NOTE: As a general rule, the import problems list should be kept empty. If a file arrives in an import 
directory that should not be imported, use File Manager, Windows Viewer, or another similar 
application to delete the file from the import directory. Otherwise, the file will be deleted after 
Importer successfully imports the file.

The Import Directory Monitor Pane
The IMPORT DIRECTORY MONITOR PANE shows each directory that is currently defined to the importer. Each directory 
will indicate its current status as shown below. No interaction is performed with the IMPORT DIRECTORY MONITOR 
PANE. It is a view-only pane. If viewing this pane is unnecessary or undesired, it can be hidden (or shown) with the 
IMPORT DIRECTORY MONITOR menu item toggle by selecting the VIEW TABBED PANE icon on the MENU BAR. 
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Importer Window Components
The Import Progress Monitor Pane
The IMPORT PROGRESS MONITOR PANE shows the progress details of each individual import. No interaction is 
performed with the IMPORT PROGRESS MONITOR PANE. It is a view-only pane. If viewing this pane is unnecessary or 
undesired, you may toggle out of this view by selecting the VIEW TRIPANE icon on the MENU BAR.

Some examples of information that may be obtained from the IMPORT PROGRESS MONITOR are compression ratios for 
specific reports, index record counts, index file sizes and compression ratios, and the original file sizes of reports. 
Additionally, the IMPORT PROGRESS MONITOR is useful in verifying system definition settings being used for a given 
report such as the report series definition, the business and import timestamp methods, and the index definitions.

The IMPORT PROGRESS pane consists of three tabs: The IMPORTS tab, AUTO EXPORTS tab and the ACTIVITY LOG tab.

The IMPORTS tab details the source file, its import destination, the report series definition or filename translation and 
its time of import.

The AUTO EXPORTS tab details those reports that are defined as automatic exports.
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Reference Guide Data Import (*)
Getting Started
The ACTIVITY LOG tab details all importer activity. The ACTIVITY LOG tab, when selected, is the default tab until the 
user selects the IMPORTS or AUTO EXPORTS tab. The application automatically switches back and forth between the 
IMPORTS and AUTO EXPORTS tabs to display the current application when the IMPORTER is running.

This window now allows the user to scroll when needed to view all of the current import/export directory stats.

To Rearrange the Importer Window
The IMPORTER window can be rearranged by dragging the splitter bars that separate the component panes.

VIEW TRIPANE PANELS or VIEW TABBED PANELS may be selected from the VIEW menu. You may also request an Auto 
Refresh by selecting the AUTO REFRESH ACTIVITY VIEW.

Additional VIEW menu items are available to hide or show the toolbar and status bar.

LOG allows the user to bring the LOG ACTIVITY tab to the front for review of importer activity.

Getting Started
IMPORTER operates based on an import definition database for a given RMS/DeskTop system to which it should be 
importing files. To begin using IMPORTER, an import definition file must be opened or created.
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Getting Started
To Open an Existing Import Definition File
An import definition database will typically have a .IDB file extension. These database files must exist in the RMS/
DeskTop system’s directory for the systems to which they apply. 

To open an import definition file that has been opened recently, simply select the import definition database (.IDB) 
file from the bottom area of the FILE menu. 

To open an import definition file that does not appear in the recent file area of the FILE menu, select OPEN from the 
FILE menu, and the SYSTEM SELECTOR dialog will appear. This dialog is provided to aid you in navigating to a given 
RMS/DeskTop system’s directory. 

NOTE: If an open attempt fails to list a system within the System Selector after attempting a File-Open, 
however, you are able to view the system within the Viewer, we advise that you review your LAN 
rights for the importer. You must have change rights to the importer so that it can be written to. 
The reason that the system is available within the Viewer is because its users only require LAN 
read rights to view reports.

If no systems appear in the SYSTEM SELECTOR dialog and you have verified that you currently have LAN rights 
correct, there are no RMS/DeskTop systems that exist in any of the directories listed in the SYSTEMS PATH. 

To obtain access to RMS/DeskTop systems, see TO CHANGE THE ACCESSIBLE RMS/DeskTop SYSTEMS in this 
chapter. 

Once a system is selected, an OPEN dialog will appear showing import definition files from the associated RMS/
DeskTop system’s directory. Usually, there will be only one import definition file, and it will typically be named 
DEFAULT.IDB. Select the desired import definition file and click OK. The import definition will be opened, but 
IMPORTER will be changed to a Not Running, or Paused, mode. The RUN menu item toggle under the FILE menu is 
used to cause IMPORTER to start or stop performing imports.
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Getting Started
To Create a New Import Definition File
More than one import definition file may be created for an RMS/DeskTop system. This can be useful in situations 
where separate workstations have different drive redirection needs for the import directories, or in situations where 
there are separate, unrelated import scenarios.

To create a new import definition file, select NEW from the FILE menu, and the SYSTEM SELECTOR dialog will appear. 
As with opening import definition files, this dialog is provided to aid you in navigating to a given RMS/DeskTop 
system’s directory. After an RMS/DeskTop system is selected, a SAVE AS dialog will appear showing import 
definition files from the associated RMS/DeskTop system’s directory. Choose a new name for the import definition 
file and press OK. The filename must specify a .IDB extension and must be created in the respective system’s 
directory.

NOTE: If the RMS/DeskTop system selected is a secured RMS/DeskTop system, a User ID and 
password for a user which has administrator privileges will be required.

To Automatically Open and Run an Import Definition on Startup
Once an import definition is defined for an RMS/DeskTop system, it may be desirable to have IMPORTER 
automatically open and start importing based on a certain import definition. The -I or -i command line option is used 
for this. IMPORTER will attempt to open and run an import definition file supplied after the -I command line switch on 
startup.

The command line switch should be followed by a space and then followed by the absolute path specification for the 
import definition file to load. For example:

Importer32.exe -I c:\...\DTDEMO\default.idb
This can be useful in situations where IMPORTER is automatically started by a scheduler or at Windows start-up time.
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Getting Started
To Cause the Importer to Retry All on Startup
In some situations, it may be desirable for IMPORTER to RETRY ALL failed imports at start-up. The -C or -c command 
line switch can be used. The C stands for clear the import control database. This command line switch has no 
additional argument, and would typically be used like this:

DTImport.exe -C -I c:\...\DTDEMO\default.idb

This would only be useful in combination with automatically opening an import definition on startup with the -I 
switch as shown above.

You can also place a number next to the -C like -C23 to force the Importer to clear the import control database every 
X minutes. Do not put a space between the -C and the number. This is useful to automate the importer’s retries of any 
errors that it might encounter.

An alternative to the command line switch is a manual RETRY or RETRY ALL  buttons found on the importer pane..
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Modifying an Import Definition
To Set the Name for Importer
More than one copy of IMPORTER may be run for an RMS/DeskTop system at the same time. However, for two or 
more instances of IMPORTER to cooperate when polling the same import directories, an arbitration scheme must be 
used to keep more than one instance of IMPORTER from importing the same file at the same time. For this purpose, 
IMPORTER supports a -N or -n command line switch that allows a name to be given to IMPORTER on start-up. If no -N 
command line switch is provided, Default will be the name used. 

The command line switch should be followed by a space and then the name to be used. The name should contain no 
spaces and should be no longer than 31 characters. The following is an example of how to supply a name to 
IMPORTER:

Importer32.exe -n Importer_1

NOTE: This can be very useful in situations where the volume of information flowing into an RMS/
DeskTop system is too great for one PC to handle in a timely fashion. This would improve 
import performance.

Modifying an Import Definition
Import definitions contain four entities that can be altered by an RMS/DeskTop user with administrative privileges. 
These entities are:

• import directories

• filename translations

• RMS report name translations

• import variables.

To Add, Change, or Delete an Import Directory
As mentioned in the overview, IMPORTER polls directories at a periodic rate to discover files to import into an RMS/
DeskTop system. These directories are referred to in IMPORTER as import directories. Each import definition file can 
define any number of directories to be polled, but typically, for a given RMS/DeskTop system, there will only need 
to be one directory where files to be imported are placed.
© 2013 Mantissa Corporation. All rights reserved.  225



R
D

_C
ha

pt
er

_0
9.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3

RMS/DeskTop® Version 3.25 

Data Import (*) Reference Guide
Modifying an Import Definition
To add or change an import directory, first open the related import definition file. Next, select IMPORT DIRECTORIES 
from the EDIT menu. If the current RMS/DeskTop system is secure, a User ID and password for a user who has 
administrator privileges will be required. After passing the administrator logon, the IMPORT DIRECTORIES dialog will 
appear. 

From this dialog, import directories may be added, deleted or modified. The IMPORT DIRECTORY EDIT dialog allows 
specific properties of an import directory to be adjusted. 
226 © 2013 Mantissa Corporation. All rights reserved.



R
D

_C
ha

pt
er

_0
9.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3
RMS/DeskTop® Version 3.25 

Reference Guide Data Import (*)
Modifying an Import Definition
The NAME is typically used only for reference in the IMPORT DIRECTORY MONITOR PANE. However, the name can also 
be used in variable substitution for a report name translation. The import directory name for the directory where the 
current file was found is available in the IMP variable during name translation.

The DIRECTORY PATH specifies the directory that will be polled and is usually specified relative to the RMS/DeskTop 
system’s directory. Of course, absolute directory paths may be used if necessary.

The POLL RATE specifies the rate, in seconds, at which IMPORTER will poll this directory while running.

The ENABLE POLLING checkbox can be used to selectively disable an import directory. Note that all IMPORTER activity 
can be stopped by unchecking the RUN menu item on the FILE menu.

To Add, Change, Delete, Import or Export Filename Translations
As mentioned in the overview, when IMPORTER finds a file in an import directory, it must use a name translation rule 
to translate the file’s filename or RMS report’s LOCATION/CLASS/REPORT ID into an RMS/DeskTop report series 
specification. IMPORTER will first determine whether the file contains an RMS report (downloaded using RMSP3) or 
whether the file is simply a text or binary file.

To add a filename translation, first open the related import definition file. Next, select FILENAME TRANSLATIONS from 
the EDIT menu. If the related RMS/DeskTop system is secure, a User ID and password for a user who has 
administrator privileges will be required. After passing the administrator logon, the FILENAME TRANSLATIONS dialog 
will appear.

Filename Translations Dialog
This dialog displays and allows manipulation of the filename translations defined in the current import definition file.

This dialog shows and allows manipulation of the filename translations defined in the current import definition.

Filename translations are used to translate a filename into an RMS/DeskTop report. RMS/DeskTop reports are 
identified by a report series specification.

When searching for a name translation rule for a file, filename translations are searched from top to bottom and the 
first rule whose filename mask matches the filename will be used.

Use the buttons to re-order the items as appropriate for correct matching. Generally, explicit rules should be above 
wildcard rules.

 This button is used to move an item down in the list. Using the mouse, you may also move an item by 
dragging and dropping it onto its desired order in the list.

 This button is used to move an item up in the list. Using the mouse, you may also move an item by 
dragging it and dropping it onto its desired order in the list.

 This button is used to delete the selected translation from the list.

 This button is used to create a name translation

 This button is used to edit the selected translation. You may also double-click on the name translation 
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Modifying an Import Definition
to edit it.The Filename Translation dialog is used to edit or define a name translation. 

From this dialog, filename translations may be added, deleted, modified, imported or exported. The following dialog 
allows specific properties of a filename translation to be modified:

The FILENAME MASK should contain text that will match only the filename and extension components of the file of 
interest (no directory components). An asterisk (*) may be used as a wild card for matching zero or more characters, 
and a question mark (?) may be used as a wild card to match any single character.
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Modifying an Import Definition
The TRANSLATED REPORT NAME should contain the desired report series specification for the RMS/DeskTop report. 
Report series specifications should always begin with a leading backslash, and backslashes separate each RMS/
DeskTop node. Spaces are allowed. Variable substitution can be used to form the report series specification. See 
Using Variables In Name Translations in this chapter. If the report is being translated into a report series whose type is 
External Document, it must have the file extension representing the file type. See External Documents Setup

The DESCRIPTION is optional. If left empty, the description will default to the name of the file being imported. 
Variable substitution can be used in descriptions if necessary.

The EXPORT button is used to selectively export any or all filename translations from one system for use as an import 
file into a new system that requires like translations.  The IMPORT button in turn will allow import of translation lists 
from other systems.

The following variables are automatically set by DTIMPORT when a file is found: 

VARIABLE VALUE

DOS The complete path specification for the file being processed  
(e.g., C:\DT3\DEMOSYS\IMPORT\FILE.EXT)

REP The filename and extension of the file being processed  
(e.g., FILE.EXT)

DES The filename and extension of the file being processed  
(e.g., FILE.EXT)

NAM The filename not including the extension of the file being processed 
(e.g., FILE)

EXT The extension of the file being processed (e.g., EXT)

HDRDAT The date of the file being processed in mm-dd-yy format

HDRTIM The time of the file being processed in hh:mm:ss format

IMP The name of the importer that is processing the file. If you name your 
importer using the -N switch, this variable has the name. If do not 
name your importer, this variable contains the value Default.

FILETIM Same as HDRTIM

FILEDAT Same as HDRDAT

NOWTIM Import time in hh:mm:ss format

NOWDAT Import date in mm-dd-yy format.

EXPPATH The report's full path in the Explorer. Variable is defined AFTER the 
report is successfully imported. Thus, it can not be used in a Filename 
Translation or RMS Report Name Translation. It can be used in an 
Auto-Export definition. If a report is translated to 
\RMS\CASTRN\QT133HSA, this variable will be set to 
\RMS\CASTRN\.

EXPNAME The report's name in the Explorer. Variable is defined AFTER the 
report is successfully imported.Thus, it can not be used in a Filename 
Translation or RMS Report Name Translation. It can be used in an 
Auto-Export definition. If a report is translated to 
\RMS\CASTRN\QT133HSA, this variable will be set to QT133HSA.
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Data Import (*) Reference Guide
Modifying an Import Definition
To Add, Change, Delete, Import or Export an RMS Report Name Translation
As mentioned in the overview, when IMPORTER finds a file in an import directory, it must use a name translation rule 
to translate the file’s filename or RMS report’s LOCATION/CLASS/REPORT ID into an RMS/DeskTop report series 
specification. IMPORTER will first determine whether the file contains an RMS report (downloaded using RMSP3) or 
not.

To add an RMS report name translation, first open the related import definition file. Next, select RMS REPORT NAME 
TRANSLATIONS from the EDIT menu. If the related RMS/DeskTop system is secure, a User ID and password for a user 
who has administrator privileges will be required. After passing the administrator logon, the RMS REPORT NAME 
TRANSLATIONS dialog will appear.

Use the buttons to re-order the items as appropriate for correct matching. Generally, explicit rules should be above 
wildcard rules.

 This button is used to move an item down in the list. Using the mouse, you may also move an item by 
dragging and dropping it onto its desired order in the list.

 This button is used to move an item up in the list. Using the mouse, you may also move an item by 
dragging it and dropping it onto its desired order in the list.

 This button is used to delete the selected translation from the list.

 This button is used to create a name translation

 This button is used to edit the selected translation. You may also double-click on the name translation 
to edit it.The
RMS Report Name Translation dialog is used to define, edit, import or export name translations.
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Modifying an Import Definition
From this dialog, RMS report name translations may be added, deleted, modified, imprted, exported and sorted. 

The IMPORT  button is used to import RMS Report Name Translations lists into the system.

The EXPORT button is used to export RMS Report Name Translations out for use in other systems.

The SORT button is used to sort and place the items in their proper places. The sorting actually fixes any erroneously 
placed masks so that the most explicit ones are placed above least explicit ones.
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Modifying an Import Definition
The following dialog allows specific properties of an RMS report name translation to be modified:

The LOCATION, CLASS, AND REPORT ID MASKS should contain text that will match the report or reports of interest. An 
asterisk (*) may be used as a wild card for matching zero or more characters, and a question mark (?) may be used as 
a wild card to match any single character.

The translated report name should contain the desired report series specification for the RMS/DeskTop report. 
Report series specifications should begin with a leading backslash, and backslashes separate each RMS/DeskTop 
node. Spaces are allowed. Variable substitution can be used to form the report series specification. See USING 
VARIABLES IN NAME TRANSLATIONS in this chapter for more information.

The DESCRIPTION is optional. If left empty, the description will default to the description from the RMS report header. 
Variable substitution can be used in descriptions if necessary.

The EXPORT button is used to selectively export any or all RMS translations from one system for use as an import file 
into a new system that requires like translations.  The IMPORT button in turn will allow import of RMS translation lists 
from other systems.

The following variables are automatically set by IMPORTER when an RMS report is found.

Variable Value

DOS The complete path specification for the file being processed (e.g., C:\DT3\DEMO-
SYS\IMPORT\FILE.EXT)

LOC The location specified in the RMS report’s header
CLA The class specified in the RMS report’s header
REP The complete report ID from the RMS report’s header (e.g., REPORT.ID)
NAM The report ID not including the extension (e.g., REPORT)
EXT The extension of the report ID (e.g., ID)
DES The description specified in the RMS report’s header
HDRDAT The date from the RMS report’s header in mm-dd-yy format
HDRTIM The time from the RMS report’s header in hh:mm:ss format
JNM The job name from the RMS report’s header
JNU The job number from the RMS report’s header
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FRM The form specification from the RMS report’s header
FCB The contents of the forms control buffer from the RMS report’s header
IMP The name of the import directory in which the file was found
NOWTIM Import time in hh:mm:ss format
NOWDAT Import date in mm-dd-yy format
FILETIM File's time in hh:mm:ss format
FILEDAT File's date in mm-dd-yy format

Variables
Import variables are useful in building translated report names algorithmically. For example, one may want to use the 
filename or report ID of the file currently being imported in the translated report name. This can significantly reduce 
the number of name translations required for a system.

Some variables are automatically defined by IMPORTER when a file is found. Others can be user-defined. Any 
variable, whether implicit or user-defined, can be used in a translated report name.

Using Variables in Name Translations
When a text or RMS report file is found, the import variables are assigned appropriate values. First, all automatic 
variables are established. Next, the user-defined variables are evaluated in the order that they are defined. Values 
referencing variables are recursively evaluated until there are no further variable references encountered. Literals 
(text enclosed in double quotes) can be used in variable values to delay recursive substitution if necessary (see the 
complex name translation scenario below). Variables that will not be used are not required to successfully evaluate. 
Finally, the TRANSLATED REPORT NAME and DESCRIPTION are evaluated. Any variable used in a TRANSLATED REPORT 
NAME or DESCRIPTION must have a valid value.

To cause a variable’s value to be inserted, surround the variable name with parentheses and prefix the open 
parenthesis with a dollar ($) sign. For example, to substitute the value of an RMS report’s location, one would use the 
syntax

$(LOC)

wherever the location should appear.

To use only a portion of a variable’s value in a substitution, variables may be subscripted by appending a character 
index or character index range surrounded by square brackets to the variable name. For example, to select the first 
character of the report ID for an RMS report, one would use the syntax

$(REP[1])

To select the first four characters, one would use

$(REP[1-4])

An asterisk may be used as an “end-of value” indicator in ranges. For example, to substitute all characters from the 
third character on, one would use

$(REP[3-*])

These syntax and substitution rules allow for complex name translations. Consider a situation that may occur in a 
bank where a portion of a report ID indicates a certain branch ID. For this example, let’s assume the first two 
characters are the branch ID and the rest of the report ID is an actual report number. Furthermore, assume that there 
are branches with IDs of 10, 11, and 12, and assume that these branches are named “East Lake”, “Irondale”, and 
“Hueytown”, respectively. Variables could be used to substitute the text names for the branch IDs.

Let’s assume we have these report IDs to be translated:
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10STMTS 
11STMTS 
12STMTS

To accomplish this, first, one would define variables to hold the names of the branches. The variable names would be 
carefully chosen to end in the respective branch ID. For example:

BRANCH10=East Lake 
BRANCH11=Irondale 
BRANCH12=Hueytown

After these variables, another variable would be defined to use the two characters of the report ID to assemble a 
reference to the branch lookup variables. For example:

BRANCHNAME=“$(BRANCH”$(REP[1-2])“)”

And finally, the branch name could be used in a report name or description by using the variable above. For example:

\$(BRANCHNAME)\$(REP[3-*])

This would result in the translated report names of

\East Lake\STMTS 
\Irondale\STMTS 
\Hueytown\STMTS

The System Definition
Each RMS/DeskTop System has a system definition file (sysdef.dbf). This file is created by SYSGEN when a new 
system is created. It may then be edited by either Importer or RMSDT as necessary. The system definition file 
contains definitions that define and control the storage of data in a system. System definitions do not control security. 

The system definition file is processed both when opening a system for the first time, and while running if changes 
are made to the file. The file contains rules needed by the system during the import process for determining things 
such as storage requirements and definitions for any indices to be automatically produced. The definition file is also 
referenced during printing to determine if an explicit printer binding exists for a report series. The storage 
requirements are also referenced if post-import associations are added to a report so that the association can be 
assigned the same storage class as the related report.

There are four types of entities in the system definition:

• Report Series Definitions

• Date/Time Locators

• Storage Classes

• Object Stores

To edit any of these setup elements for the RMS/DeskTop system associated with the current import definition file, 
use the Edit menu for each element’s respective dialog.

Report Series Definitions
Report series definitions specify how every report of a particular report series should be handled by the system. A 
report series is the collection of all versions of the same report. The reports ID and node path uniquely identify its 
series. Each version of a report series is unique. 
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Each report series definition has a report series mask. This may be either an explicit report series specification or, 
with wild cards, may apply to more than one report series. The system definition contains an ordered list of report 
series definitions. When an attribute for a particular report series is needed, the report series definitions are searched 
to find the first report series definition that matches the report series in question. Typically, explicit series definitions 
will appear before wild card definitions.

A report series definition is critical when a report is imported. The report series definition indicates which storage 
class a report should use, and how the business date for the report should be set. Additionally, the report series 
definition may define one or more indices that should be automatically produced for a new report. The definition may 
also specify the logical printer that should be used when printing.

The report series definition used for a particular report series can change over time. For example, a report may have 
matched a wild card report series definition when it was first imported. After it is already in the repository, a more 
specific, explicit report series definition may be created that will match and govern the report series thereafter. The 
storage class referenced by a report series definition may also change over time, and will only affect new imports of 
the report.

To add, remove, modify, import or export report series definitions, select Report Series Definitions from the Edit 
menu and the Report Series Definitions dialog will appear.

Date/Time Locators
Reports in RMS/DeskTop are versioned according to their business date. To ensure proper versioning, it is very 
important that this date be established properly based on the actual business date for a particular report. Date/time 
locators allow one to define rules for scanning the content of a report, feeling for dates in a particular area of the 
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report of a particular format. Multiple formats, or parsing templates, can be defined for each date/time locator, and in 
many cases a generic date/time locator can be used for a number of report series. Once a date/time locator is defined, 
it can be referenced by a report series definition.

To add, remove, edit, import or export date/time locators, select Date/Time Locators from the Edit menu and the 
Date/Time Locators dialog will appear.

Storage Classes
Storage classes define logical storage groups that have similar storage requirements. Each storage class uses the 
physical storage supplied by an object store. Any number of storage classes may use the same object store.

Storage classes are typically used to provide retention characteristics. This is referred to in the storage class setup as 
Automatic Deletion criteria. When a new report is added to a system, the reports storage class is used to route the 
report data to physical storage. In addition, the storage classes automatic deletion criteria will be used to 
automatically delete old versions of the report based on a version limit, an age limit, both, or neither. To this end, one 
may create storage classes named 12 versions, 6 months, 1 Year, Permanent, etc.

In some cases, storage classes may provide additional criteria to the underlying object store such as routing 
information. This routing information can be used to group reports by frequency or other criteria so that data can be 
routed to separate physical media. To this end, storage classes might be named Daily, Monthly, and Quarterly. In this 
scenario, when using optical disks, one could route daily data to separate media from the infrequent data. This would 
allow a single disk mount access to several quarters worth of infrequent information.
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To be able to add a report to a system, at least one storage class must be defined. Storage classes have no role in 
retrieving a report from the repository because only object store references are kept in the catalog database.

To add, remove, modify, import or export storage classes, select Storage Classes from the Edit menu and the Storage 
Classes dialog will appear.

Object Stores
Object Stores supply physical storage for repository data. An RMS/DeskTop system can store its information in any 
number of object stores. Object Stores only need to be understood by administrators of an RMS/DeskTop system. 
Users, who view and manipulate report data, are not burdened with understanding where and how data is physically 
stored. Object Stores allow the physical storage mechanisms to be abstracted so that storage and retrieval can be, 
effectively, media independent. Some information in a system may be routed to an object store that places data on 
optical disks. At the same time, other information in the system may be routed to an object store that places data on 
magnetic disks.

When a report is imported, the actual report data is broken apart, encrypted, compressed, and turned into objects to be 
placed into an object store. By fragmenting the report data, each object store can manage its unused space more 
efficiently. Also, when retrieving data from an optical disk, each file object retrieved must be completely read from 
the optical disk into a magnetic cache. By ensuring that no report object is more than some reasonable fixed size, the 
retrieval time can be faster since only one object at a time ever needs to be recalled from disk.
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To add, remove, import or export object stores from Importer, select Object Stores from the Edit menu and the Object 
Stores dialog will appear.

 MOVE DOWN - Moves an item down in the list. Using the mouse, you may also move an item by 
dragging and dropping it onto its desired order in the list.

 MOVE UP - Moves an item up in the list. Using the mouse, you may also move an item by dragging it 
and dropping it onto its desired order in the list.

 DELETE - Deletes the selected specification from the list. This action does not delete any existing 
indices from the system's catalog. It will only delete the production of an index for subsequent imports.

 CREATE - Creates a new index specification.

 ACTIVATE - Activates the selected index for editing. You may also double-click on the index to edit it. 
The Index Definition dialog will appear when the specification is being edited.

To Configure Automatic Backup
Backup Issues
RMS/DeskTop contains several files in the system directory of each system that must not be lost. Loss of or damage 
to these files can occur because of media failure, program malfunction or an erroneous edit. Some of these files are 
constantly being modified as reports are added to the system. To guarantee that the system is in a stable state, all 
RMS/DeskTop users and all instances of Importer would need to be terminated before a normal disk backup could be 
performed. Usually the backup would be run at night; however, in some situations, Importer is active during this 
period processing new reports arrivals. This creates a difficult problem for the system administrator because there is 
no way to easily perform reliable backups for the system.
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To solve this problem an unattended, disk-based backup can be performed of the critical system files by the RMS/
DeskTop programs. The actual backup operation is performed by the Importer, but program logic in RMSDT 
constantly monitors each system for a backup activity. When Importer’s backup signal is detected by RMSDT, 
RMSDT will momentarily disconnect from the system’s databases. When the backup is finished, RMSDT will 
automatically reconnect to the system databases as necessary. This causes the system to be unavailable to all end 
users during the backup cycle, but allows a clean, consistent copy of the system’s databases to be made.

The backup can be configured to cycle in a sequential fashion through multiple target backup directories before 
cycling back to a starting directory. This prevents a single backup from promoting a corrupt file into the backup 
directory, thereby destroying the backup image during a single backup. Multiple backup time windows 
(opportunities) can be configured. This allows for performing a backup at the end of a working day and again after 
the downloads have occurred. To assist in trying to perform a backup after the downloads have occurred, the backup 
configuration supports a minimum idle time that must be attained before the backup is actually started.

In addition to the ability to make a disk based backup of the critical system files, RMS/DeskTop includes a way to 
schedule periods of system inactivity, during which your normal LAN or system backup tool can be used to backup 
your entire system including object store directories. See the “remain disconnected” option on the BACKUP 
OPPORTUNITY dialog below.

The automatic backup configuration is maintained in the import definition database file.

What Does Automatic Backup Save?
The automatic backup feature only save the key system databases and files from the RMS/DeskTop system’s 
directory. It does not save the contents of the system’s underlying object stores (which is where document content 
resides). Automatic backup is only concerned with making copies of the key system databases and files. To make a 
complete backup, your normal LAN or system backup tool must be used in combination with the “remain 
disconnected” backup opportunity feature.

What Does Automatic Backup NOT Save?
Automatic backup does not save object store (i.e., report data) content. These directories should scheduled for backup 
as a normal part of the environment’s backup procedures (i.e., your normal LAN or system backup tool). It is 
recommended that a backup opportunity be created about your normal system backup period, with your backup 
system configured to backup all RMS/DeskTop system files including the system’s object store directories.

Automatic System Backup Dialog
To configure automatic system backup use the Automatic Backup dialog which can be accessed via the Automatic 
Backup menu item on the Edit menu, which causes the Automatic System Backup dialog to appear.
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To Configure Automatic Backup
This dialog allows control over Importer’s ability to create backups of certain key system files.

The BACKUP ENABLED check box enables or disables the backup system. It can be used to leave the backup 
configured but not active. 

The BACKUP BASE DIRECTORY field is used to establish the root of all the backup history versions. To guard against 
media failure this directory should be on a different disk drive than the system. The free space on the disk specified 
by the BACKUP BASE DIRECTORY should be large enough to hold the system directory size times the number of 
versions requested. 

Use the KEEP [] HISTORICAL VERSIONS to set the version count which establishes the number of backups that will 
performed before a previous backup will be overwritten. Each version will be placed into a subdirectory of the 
backup base directory named by concatenating the cycle number to the word cycle (e.g. cycle1, cycle2, etc...). To 
determine the most recent version of the backup, check the file dates inside each subdirectory.

To run a backup automatically the importer has to meet the requirements specified by one of the backup 
opportunities. These requirements specify an amount of time that the importer must be idle within a certain time 
window before a backup can be done. The idle time specification is used to help in configuring a backup that runs 
after all files have been imported during a nightly download.
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Backup Opportunity Dialog
This dialog allows individual backup opportunities to be configured. The term backup opportunity is appropriate 
because the system must become idle within the scheduled time period for a backup to actually be accomplished. 

Set the desired amount idle time (no import has been performed for) to a reasonable value based on the frequency of 
your report arrivals in the import directory. If this value is zero, the backup will be performed as soon as any active 
imports finish inside the time window.

The time window must be for a period less than one day and can cross midnight. A backup will occur a maximum of 
one time during the time window.

NOTE: If the system never becomes idle for the specified idle time, no backup will occur for the backup 
opportunity.

At least one of the backup action checkboxes must be checked.

Check the COPY SYSTEM FILES INTO THE NEXT AVAILABLE BACKUP CYCLE DIRECTORY checkbox to cause a copy of the 
system files to be made.

Check the REMAIN DISCONNECTED FROM THE SYSTEM FILES FOR THE ENTIRE PERIOD checkbox to cause RMSDT and 
Importer to remain disconnected from the system files for the entire backup period. This option can be useful if an 
administrator would like to ensure that Importer and RMSDT are disconnected from the system’s files during a given 
time window so that conventional backup can be performed on the RMS/DeskTop system’s files, perhaps including 
object store directories in addition to system files.

To Restore from an Automatic System Backup
As described above, the automatic system backup feature can be used to cause Importer to copy critical system files 
to a backup directory at specified times. Once backup cycles have been created by the automatic backup feature, the 
system can be restored to one of the backup cycles using the SYSTEM RESTORE feature. 

To access the System Restore feature, first stop all system activity including any RMS/DeskTop viewing of system 
files and all instances of Importer for the system. Next, start Importer and select SYSTEM RESTORE from the EDIT 
menu. This will cause the RMS/DeskTop SYSTEM RESTORE wizard to appear, which will guide you through the 
restoration process. The various steps of the restoration process are shown below.
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The System Restore - Warning Page
The following warning appears when the System Restore wizard is started.

While the intent of system restoration is to repair a broken system, this is an operation that can cause damage or loss 
of information, especially if performed incorrectly. Only system administrators familiar with the system's backup 
strategy should perform this function.

This operation will cause files in your RMS/DeskTop system directory to be replaced. It will also cause any reports 
imported since the time of the backup to be lost.

To perform this operation you will need to know the location (directory) that your system was configured to place its 
backup cycles. You will also need to know the location (directory) of the system itself. Additionally, you must have 
permission to write and create files in the system directory.
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The System Restore - Directory Page
The system restoration process restores files from a backup directory into the system directory. Therefore, one must 
supply both of these directories for the operation. The following screen is where the directories are supplied to the 
restore process.

Use the ellipses (“...”) buttons to cause a directory selection control to appear or type the directory paths directly into 
the text entry fields.

The BACKUP CYCLE DIRECTORY should be the directory that contains the backup cycle subdirectories. When the 
Automatic Backup feature is configured, a backup directory is specified. This directory is where each backup cycle is 
placed. Each time the automatic backup feature performs its function, it places the contents of the system directory 
and other related files into one of the cycle subdirectories underneath the backup directory. The number of cycle 
directories that are used by the automatic backup feature is a configuration setting of automatic backup.

The backup directory to specify is the directory that contains the cycle directories, not the cycle directories 
themselves.

The RESTORATION TARGET SYSTEM DIRECTORY should be the directory that contains the RMS/DeskTop system to be 
restored. It should be a directory that contains the critical system files like catalog.mdb, sysdef.dbf, and admin.db 
among many others.

The System Restore - Cycle To Restore Page
When the automatic backup feature performs a backup, the contents of the system directory are copied to one of the 
backup cycle subdirectories of the system's designated backup directory. The cycle directory that receives the files is 
determined by cycling through each subdirectory in a circular fashion. The reason for more than one backup cycle 
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To Restore from an Automatic System Backup
directory is to ensure that a single bad backup doesn't destroy the only good copy of a system file. Generally, unless 
something very unusual has occurred, one should restore from the most recent backup. The following screen allows 
one to select the backup cycle from which to restore. 

The BACKUP CYCLE TO RESTORE list contains a most recent to least recent list of the backup cycle directories 
available. If any of the critical system files not present or are zero length in a backup cycle, a warning message will 
appear to the right of the cycle directory.

Select the most recent, good backup for the restoration process and press the NEXT button.

The System Restore - Restoration Choices Page
The system has many different types of files that can be selectively restored. The following screen presents the 
choices available and allows one to select the specific system components to be restored.
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To Restore from an Automatic System Backup
Check or uncheck the restoration categories as applicable and press the NEXT button.

Catalog Database
Selecting this category will cause the system's catalog (Viewer View) database to be restored. This is only possible 
for single tier system type (as opposed to a SQL Server based system).

The most common problem that causes the need for system restoration is a corruption of the system's catalog 
database (catalog.mdb). The catalog.mdb database holds the catalog of available reports for a single-tier RMS/
DeskTop system, which is the most frequently used type of system. With a single tier system, each RMS/DeskTop 
program directly manipulates the catalog database file. This is generally a great thing because there is no dependency 
on a server process or computer. Though rare, because of this, any time a computer crashes, is powered off, or 
encounters a network problem while manipulating this file, there is a chance that corruption can occur. Restore this 
component if your system appears to be having trouble accessing its catalog (i.e., the viewer view contents).

System Setup
Selecting this category will cause the system's setup/property database to be restored.

The system setup file contains the system's object store, storage class, report series definitions, and date time locators. 
These are critical setup properties of your system.

Security Setup
Selecting this category will cause the system's security database files to be restored.

The security file contain user, group, and report access record settings and additionally user passwords. Without these 
files, access to your system will be impossible.
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To Restore from an Automatic System Backup
Import Definitions
Selecting this category will restore all import definition databases.

Import definition databases define the rules for a given import scenario. Each system can have more than one, but 
typically there is only one, which is named Default.idb. Without an import definition, Importer has no rules about the 
files to be imported, and therefore cannot perform its function.

Printer Definitions
Selecting this category will restore all system printer definition files that have a .dtp extension.

System printer definitions are stored in the system directory in files that conventionally have a .dtp extension. Users 
may have local overrides to system printers, but their local overrides are stored on their respective data directories, 
which are typically on their individual workstations.

Extraction Definitions
Selecting this category will restore all extraction definitions that exist within the system's EXTDEFS directory.

Any extraction definitions that are stored in the system's EXTDEFS subdirectory are backed up when the system files 
are backed up. Extraction definition files do not have to be located in the system's EXTDEFS directory for interactive 
use, but they do have to exist in the EXTDEFS directory to be used as automatic indices, which are produced during 
import.

Other System Files
Selecting this topic will restore any system files not restored by the other categories. 

There aren't may files that fit this category; however one example would be system printer definitions that are not 
named with the conventional extension of .dtp.

The System Restore - Confirmation Page
This screen presents the restoration choices that have been selected and allows one final check prior to performing the 
restore action.

Make sure that the selections presented on this screen match your intentions prior to pressing FINISH. When the 
FINISH button is pressed, the restore process will begin, which will perform the following:

1. An Archive directory will be created in the system directory.

2. A subdirectory will be created underneath the Archive directory and named based on the current 
date and time.

3. The current content of the system directory will be copied to the archive directory created above.

4. The files represented by the categories selected for restoration that exist in the backup cycle direc-
tory will be copied to the system directory.

5. Transient system files will be deleted to ensure that clean system restart can occur.

6. The system's object stores will be scanned to update the catalog so that any abandoned catalog 
entries will be avoided on future file imports.

If any error is encountered, the restore will be abandoned at that point and the System Restore Progress/Result screen 
will show the error.

The System Restore - Progress/Result Page
This screen shows each step of the restoration process. To the left of each of these steps either a check mark or an 
indication that the step failed will appear. The bottom of the screen will indicate the overall success or failure of the 
restore process, and if a failure has occurred, the reason for the failure will also be presented.
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Database Repairs
The following is an example of how the screen should appear after a successful restore. 

At this point, use RMS/DeskTop to explore the system to ensure that the restore operation yielded the desired result. 
Remember that an archive of the system’s content prior to the restore is saved underneath the Archive system 
subdirectory; so, nothing should be lost in the restore procedure.

Database Repairs
NOTE: WARNING: DO NOT run the database repairs until you have discussed this topic with someone 

in Mantissa's Customer Support Group.

There are several reasons why a system's database may need repairs. Some of the corruption is related to the Importer 
being shutdown in a sudden and unplanned manner. When such an event occurs the system's database can become 
slightly corrupted. At other times, the administrator restores the system's critical files from a tape backup. Finally, a 
backup made by the Importer is restored via Windows Explorer instead of the Importer's Backup/Restore facility.
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Database Repairs
Before proceeding with this operation we HIGHLY recommend that you close any other importer processing reports 
for this particular system. This operation can be performed while users are viewing reports. 

Synchronize with reports in Object Store
Check this field if you have restored from tape or copied the critical files using the Windows Explorer. This field re-
synchronizes a counter in the database with the reports stored in the Object Stores' folder(s). If you are getting an 
error like <ERROR: The file X already existed in the Object Store> in the importer's error pane, you should check 
this field.

Remove orphaned nodes
Check this field in order to delete a terminating node in the Explorer's tree that simply has no reports. No node should 
exist in the tree without having any reports underneath it. Such nodes are found on the end of the tree's branches and 
cannot be deleted manually because there is no facility in the DeskTop Viewer to delete them. This condition is very 
rare but it has happened enough times to be considered a problem.

Remove invalid reports from Object Store
Check this field to remove reports that do not contain valid data headers. This condition is also very rare but it helps 
to clean up junk from your Object Stores' folder(s). This operation will delete reports from the system.

Rebuild catalog’s indexes
Check this field to rebuild a SQL-based catalog. If you recently migrated your Access-based catalog to Microsoft 
SQL Server 7.0 or 2000, the converter does not create the indexes that RMS/Desktop uses to access the data tables. 
The absence of the indexes does not affect its operation. However, it does affect performance and we highly 
recommend that you utilize this facility to correct the problem.
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Reference Guide Application Settings
C h a p t e r  1 0 :

Application Settings

This chapter contains information about various application-wide settings.

Setting Per-Workstation Application Settings
Each RMS/DeskTop user may establish personal preferences for the application’s behavior. To do so, select 
APPLICATION from the PROPERTIES menu within the Viewer. The APPLICATION PROPERTIES dialog will be displayed.

The APPLICATION PROPERTIES dialog allows you to set defaults for font preferences, control specific application 
behaviors, assign archive paths, viewer plugins, WebAccess addresses and iDT Server connections. The functions are 
defined within eight property entry tabs.

There is no need to log onto a “system” to set these properties.
© 2013 Mantissa Corporation. All rights reserved.  249



R
D

_C
ha

pt
er

_1
0.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3

RMS/DeskTop® Version 3.25 

Application Settings Reference Guide
Application Properties Dialog
Allows the user to set properties that affect the entire application. These properties include fonts and directory paths.

Systems Paths Tab
DT Systems Folders This window allows you to enter the path(s) that DeskTop will search for 

repository systems. The DT Systems Folders directory list box contains a 
list of directory paths that contain RMS/DeskTop systems to be 
accessed. Only systems found in the specified path(s) can be accessed 
by DeskTop. This setting is shared between Archiver add-on and all 
other RMS/DeskTop programs. The use of UNC paths are not advised.

Clean Up Cache The Clean Up Cache checkbox is selected only if you wish to delete old 
cached data from unused systems. We have found this operation to be 
very important in cleaning up hard drives from systems that are no longer 
accessible.  
IMPORTANT: Do not perform this operation if any of your systems are 
currently inaccessible or offline.  This will cause their respective stored 
filters to be lost. 
This operation will not harm any currently accessible systems. 

Find The Find button can be used to access the “Find Systems” Dialog, which 
can be used to scan disk for RMS/DeskTop repositories on any path 
accessible by a DOS drive letter.

Viewer Plugins Tab
IE Viewer Plugins This window is used to add documents' extensions for external 

document viewing. If an extension is defined, RMS/Desktop launches its 
plugin for viewing. RMS/Desktop allows you to view the document inside 
the viewer without launching the external software. Keep in mind that it is 
your responsibility to find and install the plugin.

NOTE: If you currently have the application installed you need only edit the Viewer Plug dialog and add 
the respective application extensions to take advantage of the viewer plugins.  Contact 
Mantissa Customer Support for more information.

Import Allows the import of the .INI file associated with viewer plugin definitions. 
For example, if you require the same plugins, importing the .INI would 
make redefining the plugins unnecessary. 

Export Allows export of the .INI file that contains the viewer plugin definitions on 
your pc to be exported to any other file location for retrieval by any other 
user pc. 

WebAccess Tab(*)
Allows the user to define a list of web addresses that contain WebAccess 
systems. If more than one address is entered, Desktop will prompt the 
user to choose the WebAccess system to log into. You may add 
additional addresses by selecting the Insert button, just to the right of the 
RMS/WebAccess Server Addresses: text. You may also delete an 
address by selecting the desired path in the list and clicking on the 
Delete button (the red “X”).
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Archive Paths Tab(*)
This window contains a list of paths that may contain RMS/DeskTop 
archived sets. Only sets found in the specified path(s) can be accessed 
by DeskTop. You may add additional paths by selecting the Insert button, 
just to the right of the DT Archives Folders text. You may also delete a 
path's specification by selecting the desired path in the list and clicking 
on the Delete button (the red “X”).

iDT Server Connections (*)
This window is used to manage the internet connections to iDT servers. 
Use the list to select a connection and view the systems available from 
the server. Once you see the Desktop system that you wish to access, 
click the square box next to it to select it. You will see the newly selected 
systems in the Explorer until next time that you run this application.

Properties This button allows you to edit the connection's name, server's address, 
and Secure Socket Layer (SSL) properties.

New This button allows you add new server connections.  A port and ip 
address are required. If an SSL certificate is required the certificate must 
be defined to this connection.

Delete This button allows the user to delete a server connection previously 
defined.  The user will be messaged once after delete is selected.  OK 
will delete each entry for this server connection.

Option This button allows you edit the workstation's communications 
parameters.

Directories Tab
Temporary Directory This directory path is used by RMS/DeskTop for storing transient data to 

disk. The storage requirements of this directory area will vary depending 
on the size and number of indices that are opened simultaneously by the 
workstation. 

Workstation Data Directory This directory path is used by RMS/DeskTop to store persistent 
workstation-based information. Each RMS/DeskTop workstation must 
use separate application directories. For example, one should not supply 
directory paths that another RMS/DeskTop workstation is using.

Feature Deny Tab
Feature Deny file name This dialog allows control over specific features available in RMS/

DeskTop. This is intended for use in organizations where the expansive 
features of RMS/DeskTop can cause undue help desk burdens, or where 
some features may confuse or distract certain users. Note: this only 
controls various RMS/DeskTop workstation capabilities, there are many 
other controls which are defined and maintained by the Security dialog 
within the System Properties of the system. To deny a set of features for 
a given workstation, simply click the white box to enable or disabled the 
feature. When the OK button is pressed and there is no file selected, a 
File Save dialog will be presented. Using Reset will clear the selected 
items for reselection.

App Feature Password Password protects the feature deny settings
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Preferences Tab
Table Headers and Table Rows Control the fonts that are used in column headers and rows in table or 

grid oriented views. This includes explorer views and table views. The 
change button brings up the standard windows font selection dialog. An 
example of the font is displayed under the title.

Notes Controls the fonts that are used in notes. The change button brings up 
the standard windows font selection dialog. An example of the font is 
displayed under the title.

Minimize Explorers On Use Controls whether explorers will be minimized after a double click action 
inside the windows. When this option is set, explorers will minimize 
automatically after a double click is used to open a report. This can be a 
useful option because it removes these windows from the list of windows 
to be tiled. When using this option the Explorer toolbar button is handy to 
bring the most recently used explorer back into view.

Show copyright on startup Controls whether the Mantissa copyright splash window will be displayed 
when the application begins.

Prompt for Bookmark Title Controls the display of the “Insert Annotation” dialog when a new 
bookmark annotation is created in the report view.

Enable Print Queue Polling Controls polling behavior in the Print Dialog. In the upper-left corner of 
this dialog the printer's queue status is shown. The status is updated 
every X seconds for obvious reasons. However, some sites experience 
abnormal terminations when RMS/Desktop queries the printer's driver for 
its status; in such cases, users can not print because the Print Dialog 
stops RMS/Desktop from printing due to the abnormal termination.

Toolbar “Print” displays dialog Controls the display of the “Print Report” dialog when the “Print” toolbar 
button is clicked. If this option is unchecked, the selected report(s) 
content will be printed in their entirety using the default logical printer and 
last-used print options.

 

Prompt for Highlight Title Control the display of the “Insert Highlight” dialog when a new highlight 
annotation is created in the report view.

Accessible RMS/DeskTop Systems
Each RMS/DeskTop system is stored in its own directory tree. For more than one workstation to be able to access an 
RMS/DeskTop system, the system’s directory must be shared using a file sharing protocol such that each workstation 
needing access to the system can read and write to the directory and all subdirectories thereof.

The RMS/DeskTop systems accessible from an RMS/DeskTop workstation must be listed in the workstation’s 
SYSTEMS PATH. The SYSTEMS PATH is a directory path that lists each directory that RMS/DeskTop should search in 
for an RMS/DeskTop system. This path is stored in the RMSDT32.INI file in the Windows directory under the 
[DFS] topic and SYSTEMSPATH variable.

In RMS/DeskTop, press the SYSTEMS PATH button in the APPLICATION PROPERTIES dialog and the SYSTEMS PATH 
dialog will appear.
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In Importer, to access or change the accessible RMS/DeskTop system directories, select SYSTEMS PATH from the EDIT 
menu, and the SYSTEMS PATH dialog will appear.

If you wish to delete old cached data from unused systems, check the field CLEAN UP CACHE. This operation will 
clean up the hard drives from systems that are no longer accessible. This operation will not harm any currently 
accessible systems.
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You can add additional paths by selecting the Insert button, just to the right of the DT Systems Folders text. Selection 
of the NEW icon will bring up the SELECT DIRECTORY dialog. 
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Once you have selected the directory path for the system you wish you may find that the system is on the network. 
Accessing the network is accomplished by selecting the NETWORK button. You will then be presented with the MAP 
NETWORK DRIVE dialog.
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You may also delete existing path specifications by selecting the desired path in the list and selecting the Delete 
button (the red “X”) from the SYSTEMS PATH dialog.

The FIND button can be used to access the FIND SYSTEMS dialog, which can be used to scan disk for RMS/DeskTop 
repositories on any path accessible by a DOS drive letter.

Finding RMS/DeskTop System Directories
Use the FIND and FIND SYSTEMS dialog to locate RMS/DeskTop Systems for addition to the systems path.

The DRIVE TO SCAN drop-down list allows selection of a specific drive. Press the START/STOP SCANNING buttons to 
start or stop scanning on a drive. The SYSTEMS FOUND list will show the directory path of any systems found. Select 
directories that should be added to the systems path and press the Add Selected button.

The CLEAR button can be used when necessary to clear the systems found list.

 

RMS/DeskTop Workstation Directories
RMS/DeskTop requires two directories on each workstation. One is needed for temporary file storage, and the other 
for persistent workstation data. The setting for these directories is stored in the RMSDT32.INI file in the Windows 
directory under the [DFS] topic. The temporary directory is stored in the TEMPDIR variable, and the data directory 
is stored in the DATADIR variable.

NOTE: The TEMPDIR and the DATADIR paths should never be the same. Doing so will cause 
intermittent failures and data corruption.
256 © 2013 Mantissa Corporation. All rights reserved.



R
D

_C
ha

pt
er

_1
0.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3
RMS/DeskTop® Version 3.25 

Reference Guide Application Settings
Select the DIRECTORIES button in the APPLICATION PROPERTIES dialog in RMS/DeskTop or the APPLICATION 
DIRECTORIES menu command from Importer’s EDIT menu and the APPLICATION DIRECTORIES dialog will appear. 

NOTE: If the INI file paths are changed, then the changed INI file overwrites  your existing INI file. You 
will then be prompted to add a TEMP directory to your local workstation, and a dialog appears 
asking you to confirm the new location of your TEMP directory.

Specify absolute directory paths for the directories RMS/DeskTop should use. If a nonexistent directory is supplied, 
the directory will be automatically created.

Application Directories
Two directories are required by RMS/Desktop® on each workstation. They are a Temporary Directory and a 
Workstation Data Directory. 

One is needed for temporary storage and the other for persistent workstation settings. 

The settings for these files are stored in the file rmsdt32.ini under the DFS topic.

The Workstation Data Directory stores the following information for the local machine. 
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• It keeps a synchronized copy of the nametree.dat and nametree.sno files which it synchronizes with the main 
“system” copies on the server when the user logs onto a “system”.

• It keeps a local copy of the Explorer.dte file.

• It has a CACHE subdirectory that stores local copies of the most used reports for faster access and less 
network traffic.

If any problems ever arise with the Explorer View of RMS/Desktop® it will normally be because the synchronization 
of the files between the client and the server is not correct.

These directories can be accessed either via the Importer or via the RMS/Desktop® Viewer. 
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The Application Directories dialog appears showing the path to the two files. 

Below is a copy of rmsdt32.ini showing the two directory paths. 

This path can be changed to another directory on the same local drive with no problems.

If the user wanted to change these directories to another machine they would need to use special care. 
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NOTE: NOTE: Only the Workstation Data Directory can be successfully changed to a server, for 
example, but only if the folder is created first on the server, shared and then a drive mapped on 
the client. Putting in a UNC path does not work properly.

Denying Application Features
The APPLICATION PROPERTIES dialog also allows you to deny some of the RMS/DeskTop application features without 
having to establish security rights for the user. To do so, click the FEATURE DENY button. The FEATURE DENY 
CONTROL dialog will be displayed. 

This dialog allows control over specific features available in RMS/DeskTop. It is intended for use in organizations 
where the expansive features of RMS/DeskTop can cause undue help desk burdens, or where some features may 
confuse or distract certain users.

Please be aware that this dialog only controls various RMS/DeskTop workstation capabilities. The security system 
that is built into RMS/DeskTop provides more powerful and flexible control over a user’s rights in the application. 
For more information on security, refer to Chapter 8, “Security”.
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To deny a set of features for a given workstation, check the items that you wish to deny or select a specific denial file 
using the SELECT FILE button indicated with the three dots (...). Select the OK button. If the OK button is pressed 
without a specified denial file name, a FILE SAVE dialog will be displayed. Specify the desired filename and location 
for the denial file. Otherwise, the dialog’s settings will be stored in the specified denial file.

Denial files should have a filename that has a .INI extension. If the default directory is used during the file saving 
operation, the denial file will be stored in the workstation’s Windows subdirectory and will be named DENY.INI. 
There may be any number of denial files stored in any accessible directory. To share a common set of attributes, place 
the denial file in a shared directory and select the file from any workstation that should use the common settings.

Use the APP FEATURE PASSWORD edit field to specify a password that will be required for returning to the FEATURE 
DENY CONTROL dialog. The password may be empty. The password will be required to unlock or edit the 
workstation’s feature control settings. When feature control is in effect, the password must be supplied to the 
APPLICATION FEATURE CONTROL dialog in order for the FEATURE DENY to be displayed once again.  
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Using the Operations Logging Capability
The RMS/DeskTop, Importer and DTAdmin applications provide a diagnostic facility that records operations 
performed by the applications. This can be very useful in the event that a problem is experienced with the 
applications.

The contents of the output log are stored in a standard ASCII text file of your choosing. The file location, maximum 
allowable size and other logging options are specified via the LOG OPTIONS dialog. 

This dialog is used to specify options for all output logging operations. The dialog's settings are stored from one 
session to the next. Each application’s settings are stored separately, allowing you to specify different settings for 
each application.

NOTE: Having a very large log file can impair IMPORTER and DeskTop performance. An entry of 
50,000 is sufficient. It is important that all log options are selected to ensure that all errors are 
written to the log. For import error diagnosis this log will be requested by Mantissa Support. Be 
sure to save the diagnostic log before cycling the application, otherwise the log will be 
overwritten.

You can view the log's contents in an ASCII text viewer, such as the Windows Notepad program, or in the 
applications’ integrated LOG window. You can display the LOG window by selecting the WINDOW - LOG menu 
command in RMS/DeskTop and SYSGEN or the VIEW - LOG menu command in Importer.
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The CATEGORIES checklist box lists the available logging categories. Different portions of the applications’ 
functionality are divided into logical groups that can be selectively enabled/disabled. By selectively enabling logging 
for application operations that are related to the problem you're experiencing, you can minimize the potential log size.

The OUTPUT FILE OPTIONS group allows you to specify the location and name of the output log file, the maximum 
number of entries stored in the log (to limit the log file's maximum size) and whether or not the log contents are 
cleared or appended to from one session to another. Keep in mind that the log file can grow to a substantial size over 
time if you don't limit it's maximum size and the log is appended to from one session to another.

The SELECT ALL button selects all available logging categories in the CATEGORIES checklist box. This option makes it 
convenient to quickly check/uncheck all of the logging categories.

The RESTORE button restores the enabled/disabled state of all available logging categories to their default 
programmed state.

The FONT button displays the standard Windows “Font” dialog, allowing you to choose the font used to display the 
log contents in the applications’ integrated log window.
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Reference Guide Creating RMS/DeskTop Systems (*)
C h a p t e r  1 1 :

Creating RMS/DeskTop Systems (*)

A special program is provided with RMS/DeskTop for creating new RMS/DeskTop systems. The program’s name is 
SYSGEN and it may or may not be available on all installations.

How to Create a New RMS/DeskTop System
New RMS/DeskTop system’s are created from the SYSGEN. If your administrator has chosen to provide this 
program on your installation, it will be in the “RMS DeskTop 3.0 32-bit” program menu.

To create a new RMS/DeskTop system, select New from the SYSGEN File menu, and the New RMS/DeskTop 
System Dialog will appear.

After supplying a name for the system, a directory path for the system, and selecting the type of catalog the system 
should use, press OK. The new system will be created.

By default, the new system will be non-secure, and can be used immediately. To make changes to the security 
settings, open the system from RMSDT and modify the security from the System Properties dialogs.

New RMS/DeskTop System Dialog
The New RMS/DeskTop System dialog allows one to create a new RMS/DeskTop system. 
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This dialog allows one to create a new RMS/DeskTop system.

For the SYSTEM NAME, supply the name for the new system. Note: RMS/DeskTop system’s must have a unique 
name. When more than one system in a workstations systems path has the same name, only one of the systems will be 
accessible.

For the SYSTEM DIRECTORY, type the directory path for the location of the new system. This must be a non-existent or 
empty directory to which read/write/create privileges are granted. The directory will automatically be created if 
necessary.

If the new system is to be accessed by other RMS/DeskTop workstations, supply a directory that can be accessed by 
the appropriate users/workstations.

For the CATALOG TYPE, select from the drop down listing that RMS/DeskTop can utilize: a Microsoft Access 
database (.mdb) shared file or a Microsoft SQL Server database.

NOTE: If use an Access database, you have two options: 1. File Format 3.0: Checking this selection 
you must know the MDAC being used currently on your workstations. The right portion of the 
dialog when checked alerts you that this particular file type is only compatible with workstations 
using MDAC 2.50 SP2 (v. 2.52) or higher.   2. No file format selected: If File Format 3.0 is not 
checked for catalog type creation this catalog that may not be writable from workstations 
running Windows 2K SP3 or Windows XP. With this file format we suggest that you install 
MDAC 2.50 SP2 (v. 2.52) or higher on all computers.

The RMS/DeskTop install provides this MDAC on the installation CD for your convenience, or from the 
ftp.mantissa.com web site. If you are unsure about the MDAC release your workstations use please load the MDAC 
Checker provided on the RMS/DeskTop installation CD. The checker will scan the files to determine the latest 
MDAC currently loaded.

Ensure that the RMS/DeskTop system folder on the server is shared. RMS/DeskTop requires that the Importer have 
write access to the RMS/DeskTop system(s) so that it will perform as it should. If the importer is not provided the 
rights for write access the RMS/DeskTop system will not be available in the system selection list using File-> Open. 
Also ensure that the system folder on the server is shared and that the importer

A Client-Server, SQL Server database can be defined, but it requires that a Microsoft SQL Server exist on your LAN, 
and that a database administrator allocate a database for use by RMS/DeskTop. See How to Create SQL Server 
based Catalogs for a step by step description of how to create a SQL server database for an RMS/DeskTop system’s 
catalog.

When the SQL Server type catalog is selected, supply the server name, database name, database owner User ID and 
password for RMS/DeskTop’s access to the allocated database. Individual user’s will not be required to login to the 
database, RMS/DeskTop will store and use the supplied database owner User ID and password for all users.

After creation, the creating workstation will have the new system’s directory added to its systems path; however, 
other workstations will not. To access the new system from another workstation, add the new system’s directory to 
the workstations systems path.

How to Create SQL Server based Catalogs
The following details the things that need to be done to create an RMS/DeskTop system that uses a SQL Server 
catalog database. Skip any steps that are have already been performed.

Create the database that will be used for the catalog.

7. Install SQL Server on the server PC.  
No special options needed. Remember the name of the PC on which the SQL Server is running. For 
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Migrating RMS\DeskTop from MS Access Server to SQL Server
example, “THESQLPC”.

8. Using SQL Enterprise Manager: 
Create a database device or make sure that sufficient database storage is allocated for the catalog 
database you will create (I recommend at least 50MB for starters).

9. Using SQL Enterprise Manager: 
Create a database to hold the catalog database. Use the data storage allocated or found in step 2. 
Remember the database name: let's say “DFSCatalog”.

10. Using SQL Enterprise Manager: 
Create a login for the database that has the database ownership (DBO) alias. Here is a way to do this:

• Use Manage->Logins and a login dialog will appear. Type the login name you will give to RMS/DeskTop 
and remember the name, let’s say “DTDBUSER”. Type a password and remember it. Let’s say “DTDBPW”.

• Click in the “Permit” cell for the catalog database (DFSCatalog maybe). This should leave a check mark in 
the cell.

• Click in the “Alias” cell and a combo should appear that contains an alias of “dbo”. Select “dbo”.

• Make sure you leave the dialog by clicking the “Add” button.

You are now done with the database creation phase. Note that RMS/DeskTop will dynamically create 
the tables it needs when it connects to the catalog database for the first time.

11. Go to any computer that can connect to the SQL Server computer on the network. 
If RMS/DeskTop is on the same computer that is fine as well.

12. Run SYSGEN and use the File->New command to open the New System dialog.

• Use the data collected above to fill in the SQL Server part of the dialog:

Server Name THESQLPC

Database Name DFSCatalog

Database UID DTDBUSER

Database PW DTDBPW
When the SQL Server type catalog is selected, supply the server name, database name, database owner User ID and 
password for RMS/DeskTop is access to the allocated database. Individual user’s will not be required to login to the 
database, RMS/DeskTop will store and use the supplied database owner User ID and password for all users.

After creation, the creating workstation will have the new system’s directory added to its systems path; however, 
other workstations will not. To access the new system from another workstation, add the new system’s directory to 
the workstations systems path.

Migrating RMS\DeskTop from MS Access Server to SQL Server
Mantissa engineering advises RMS\DeskTop users to use the following guidelines when migrating RMS/DeskTop 
from MS Access database one Server A to an SQL Server on Server B:

1. Before you begin this migration it is very important that you ensure that you have a backup copy of all 
critical system files. Specifically, save the system's admin.db, admin.pdb and sysdef.dbf files.  In the 
event the conversion is damaged in some manner these files will be required to revert back in time 
prior to the conversion attempt to MS Access type catalog.
© 2013 Mantissa Corporation. All rights reserved.  267



R
D

_C
ha

pt
er

_1
1.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3

RMS/DeskTop® Version 3.25 

Creating RMS/DeskTop Systems (*) Reference Guide
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2. Copy RMS/DeskTop system files from Server A to Server B. The time of copying will vary depending 
on the content of the Object Stores' directories.

3. Run the RMS/DeskTop Viewer.

4. Modify the Systems Path within the System's Application Properties to look for the system's folder for 
the path to Server B, then remove the existing path to the system previously located on Server A.

5. Exit the RMS/DeskTop Viewer.  This will flush out any extraneous system from the Explorer.

6. Create your SQL database per the SQL instructions provided by Microsoft. Follow by importing the 
Microsoft Access file.

7. Run the RMS/DeskTop Viewer.  Define the Viewer using the -S3 switch and modify the system's type to 
SQL. Enter the pertinent information for SQL type.

8. Exit the RMS\DeskTop Viewer.

9. Rename the 'catalog.mdb' file to 'xcatalog.mdb'.

10. Run the Viewer and attempt to log into the system. If you enter the correct UID, PWD, DB name, and 
computer name, you should be successful. Otherwise, copy the saved system files noted above in 
step 1 and rename the 'xcatalog.mdb' back to 'catalog.mdb'; re-launch the Viewer with the "-S3" switch 
and re-enter the SQL information.

 If migrating SQL to SQL:
 When migrating from an SQL database to a second SQL database we will make two specific 
assumptions before continuing:

• You have access to the system residing on Server X via the viewer that you are about to use.

• You can log into the system from the viewer that you are about to use.

1. Copy the data from Server A to Server B.

2. Copy the SQL database to Server B.

3. Run the RMS\DeskTop Viewer with the -S3 switch and modify the Systems Path to look for the 
system's folder on B. Remove the path to the system on server A. When you exit the dialog, the Viewer 
will warn you that one system will be offline. This is expected.

4. At this point the Explorer lists two RMS\DeskTop systems.

5. Log in to the system with the (1) next to the system name. 

6. Change the SQL information. This system has its data and configuration files now on Server B.

7. Exit the Viewer.

8. Shut down the MS SQL running on Server A.  We now want to test to ensure that the SQL entries are 
directing RMS\DeskTop to log into the MS SQL running on Server B.

Migrating Microsoft Access catalogs to Microsoft SQL Server 2000
In order to migrate an Access-type catalog to a SQL Server 2000 one must first create the database on the SQL Server 
2000 and a user. For our example below we are going to port the DTDEMO database that is installed with our base 
installation. One last thing, the client PCs must be upgraded with the SQL Server 2000 driver. You can install the 
driver using the SQL Server 2000 Installation CD.
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How To Create a SQL Server 2000 Database
The following details the steps needed to be done in order to create an RMS/DeskTop system that uses a SQL Server 
2000 database.

1. Install SQL Server 2000 on the server PC and remember the name of the server on which the SQL 
Server is running. For our example, we named our server ENGTEST1\DT3SQL2K. 

2. Make sure that the SQL Server security is configured to use Windows authentication AND SQL 
Server’s. Otherwise, this example will not work. To do so right-click on the Server object and select the 
PROPERTIES menu item. Below is a picture of the security properties set to the appropriate setting.
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3. Using SQL Enterprise Manager create a database. Follow the pretty pictures!

Right-click on the Databases object to bring a pop-up menu similar to the one shown below. Select 
New Database

We will name the database DTDEMO. Click the OK button to create it. 

Now, let's create a user with full rights to the DTDEMO database. Right-click the Logins object to bring 
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the pop-up menu shown below. Select New Login to create the user. 

Name it user4DTDEMO and enter a password. For this exercise, we will use user as the password. 

Give this user full rights to the DTDEMO database. The picture below shows the correct settings. Click 
the OK button to create this user.
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Now we are ready to import the data.

Right-click on the DTDEMO object to get a pop-up menu. Select Import Data. 

A series of dialogs will be shown to guide you through the set-up. The first one is the most important 
because it defines the source. Select Microsoft Access. Click on the browse button next to the File 
name field; find and select the catalog.mdb file using the Browse dialog. Click on the Next button to 
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continue the set-up. 

This next dialog allows you to enter the user ID and password to the DTDEMO database. Click on the 
Next button to continue. 

Click the Next button to continue.
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This dialog shows you the tables found in the Access database. At the very least, you should see the 
first six tables shown in our picture. Click on the Select All button. Click on the Next button to continue. 
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Click the Next button to continue. 

Click the Next button to continue. 
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The next dialog shows the importing process as it is executing. Wait until it is done. 

Once the importing process is done, a dialog will show you how many tables were imported. Click on 
the OK button to continue. 
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Click on the Done button to finish. 

Verify that the database was populated with the tables by selecting the Tables object from the 
DTDEMO object. Once you are satisfied that the data is in the database. Let's continue with our 
migration. 

4. Make sure that NOBODY is logged onto the system except you. You cannot make these structural 
changes until everyone is off the system. If you need to practice, make a copy of the system in 
question and practice until you successfully finish all of the steps in this document. I cannot stress this 
enough. The changes that you’re about to make are BIG, really BIG.

5. Save some of the system's files to a safe location. This is very important in case you really mess up 
the login's parameters. You need to save the following files: admin.db, admin.pdb, and sysdef.dbf.
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6. Run the viewer from a DOS prompt as shown below. The -S3 switch only works with DT v2.06.7 and 
later versions. This is a critical step because if you're not able to inform DT that the SQL server is to be 
used, DT will continue to modify the Access database. Make sure that you only change from Access to 
SQL and viceversa (yes, you can switch back to the original type w/o any problems.) DO NOT change 
from encrypted to unencrypted or viceversa. Write down whether the database is encrypted or 
unencrypted in case you need to switch back to Access.

RMSDT32   -S3

7. Open the system's security properties and change the database type to SQL Server. Make sure that 
you enter the information previously entered when the database was created. Our testing lab has a 
server named ENGTEST1\DT2SQL2K. We enter all the pertinent information in the system's property 
dialog and save it.

Server Name ENGTEST1\DT2SQL2K

Database Name DTDEMO

Database UID USER4DTDEMO

Database PW USER

Once the system's database setting are changed to the SQL Server, it is time to test the tree structure. 
First, rename the file named nametree.dat that resides in the system's home directory to nametree.old. 
Run RMS/DeskTop and log onto the system. Open every node in the tree (if possible) to make sure 
that all the leaves show. Exit RMS/DeskTop. At a DOS prompt go to the system's home directory. Here 
you should see a newly-created nametree.dat file. To compare the two trees use the File Comparison 
program. It should report no differences between the two files. Here is how to run this program

FC    nametree.old    nametree.dat

If the file comparison program reports differences, a table is missing from the SQL catalog. If this is the 
case, delete the SQL database and start all over from the top of this document. 

If your login parameters are not working you will need to restore the files saved earlier (admin.db, 
admin.pdb, and sysdef.dbf) and go back to step six(6).

We need to create navigational indexes for the migrated tables. Run the Importer and open the 
migrated system. Select "Edit->Catalog Cleanup" from the menu bar. A dialog will be shown (see 
below) where you can check the field named "Rebuild catalog's indexes". Just click OK and the 
Importer will automatically rebuild the indexes. This process may take awhile.
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Notice
MANTISSA AND/OR ITS RESPECTIVE SUPPLIERS MAKE NO REPRESENTATIONS ABOUT THE 
SUITABILITY OF THE INFORMATION CONTAINED IN THE DOCUMENTS AND RELATED GRAPHICS 
PUBLISHED. ALL SUCH DOCUMENTS ARE PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND. 
MANTISSA AND/OR ITS RESPECTIVE SUPPLIERS HEREBY DISCLAIM ALL WARRANTIES AND 
CONDITIONS WITH REGARD TO THIS INFORMATION, INCLUDING ALL IMPLIED WARRANTIES AND 
CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-
INFRINGEMENT. IN NO EVENT SHALL MANTISSA AND/OR ITS RESPECTIVE SUPPLIERS BE LIABLE 
FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, 
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE 
OR PERFORMANCE OF INFORMATION AVAILABLE FROM THIS DOCUMENT.

THE DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. 
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN. MANTISSA AND/OR ITS 
RESPECTIVE SUPPLIERS MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/
OR THE PROGRAM(S) DESCRIBED HEREIN AT ANY TIME. 

NOTICES REGARDING DOCUMENTS. 
IN NO EVENT SHALL MANTISSA AND/OR ITS RESPECTIVE SUPPLIERS BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM 
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER 
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF 
SOFTWARE, DOCUMENTS, PROVISION OF OR FAILURE TO PROVIDE SERVICES.
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C h a p t e r  1 2 :

Installation (*)

RMS/DeskTop Installation Planning
When installing RMS/DeskTop for the first time a few considerations need to be taken into account, because even 
though RMS/DeskTop is very versatile some potential problems can be overcome by having the correct version 
installed.

There now exists two separate RMS/DeskTop products; RMS/DeskTop Enterprise Edition (Viewer, Importer, System 
Generator); and RMS/DeskTop Personal Edition (Viewer and one system).

Below are a few scenarios that we know of which cover the majority of installs – listed first is the preferred method of 
install for companies running a LAN.

Scenario 1
Users logon to a company’s network server. For this scenario, we recommend a NETWORK install. This type of 
install saves on administrative work in the future, because once the product base version is installed and all clients are 
installed from the server any future product upgrades only have to be made to the server – all clients installed this 
way will be automatically be upgraded the next time the user logs on to RMS/DeskTop.

Scenario 2
Users logon to a company’s network server. For this scenario, RMS/DeskTop is copied from a CD into a folder and 
then installed on each client from this folder. This type of installation will require an administrator to physically visit 
each client PC and load any upgrades.

Scenario 3
Users logon to a company’s network server, but the company also runs a software distribution server (i.e. Microsoft 
SMS Server). RMS/DeskTop can be distributed to clients via this method although Mantissa does not support 
Microsoft SMS Server.

Scenario 4
Users logon to a company’s network server, but you want to create client clones before rolling out RMS/DeskTop. 
Refer to “Creating a Clone Install” in this chapter.

Scenario 5 (and the least attractive)
Users logon to a company’s network server or a company that does not have a central server or LAN. The 
RMS\DeskTop Administrator physically visits every machine that requires Desktop and installs via the CD and then 
physically revisits each client PC and loads any upgrades. 

RMS/DeskTop Upgrade Guidelines
Mantissa Corporation strongly advises its RMS/DeskTop users to adhere to the following installation upgrade 
guidelines when performing an upgrade installation. Without doing so may result in performance and production 
issues. 

NOTE: Mantissa Corporation will require all users to upgrade to RMS\DeskTop v. 3.20 by December 
31, 2006.  Notices will be mailed to all administrators.  Those users/clients that do not upgrade 
will find that they will no longer have viewing abilities to any systems that have been upgraded 
to v. 3.20.  Until their machine is upgraded they will have no RMS/DeskTop system viewing 
capability.

1. Keep RMS\DeskTop current. 
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Mantissa Corporation averages four maintenance releases annually for RMS\DeskTop. If you question 
as to what release you should be installing contact Mantissa Customer Support at 
support@mantissa.com.  Schedule regular upgrades as soon as it is convenient. As always, with the 
upgrade of any software, we strongly advise testing each new release on your test systems first. 

2. Perform Adequate Testing.  

RMS\DeskTop testing in its most basic form should address two very important items:

• "Ensure that the Importer can execute and import all defined file types to its intended host machine.

• "Verify that RMS\DeskTop can access and view reports on the client machines.

3. Use Network installations when possible.  Mantissa always encourages users to install its client base 
using the provided Network installation. See the CD documentation for more information on how this is 
accomplished.  A network install dramatically lessens the administrator's time spent on any installation, 
as only the server will need to be upgraded.  When users next log on they will be automatically 
upgraded.

Mantissa has now provided the LAN administrator with the ability of performing "silent installs" via 
batch file.  This can be performed either for individual installs or for network installs. Please see the 
Installation chapter within the RMS\DeskTop System Reference Guide for more information. 

4. Important issues relating to use of UNC paths.  

Mantissa Corporation reports two known issues for those users currently using UNC paths. 
RMS\DeskTop 2.xx allowed UNC paths.  We no longer allow UNC paths under v. 3.xx.  You may find 
problems relating to the following:

• "Some of the Importer's DLLs do not work well with UNC paths. We do not have much control over this 
issue.

• "INI file settings may be lost due to the replacement of a system's host machine. Using mapped drives keeps 
the system's path relative. Thus, the system can be moved to another machine without affecting these 
settings. This event has happened enough times for us to STRONGLY advise customers not to use UNC 
paths in our product.

RMS/DeskTop Installation Notes
There are two versions of RMS\DeskTop Enterprise Edition that are available for install: server and client. First, 
install the server version.

System Requirements for Windows Server 2008, Vista, Windows 7 and Windows 8
1. 1GHz x86 processor or 1.4GHz x64 processor (if installing 64-bit version)

2. 2GB of memory

3. 40GB of storage

Installation for WINDOWS
1. Insert CD-ROM disc into CD-ROM drive.

2. Auto-run will display RMS/DeskTop's Installer dialog box.

3. Select Server to proceed with the server installation. Select Next to continue.
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4. Follow the on-screen prompts to complete the installation. 
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When asked to select features, select the features by checking the desired options. 

Items available for install from this dialog include RMS/DeskTop Program Files, RMS/DeskTop Application Files, 
the RMS/DeskTop Viewer, the RMS/DeskTop Importer, the RMS/DeskTop Security (Sysgen), MDAC (not to be 
installed without direction to do so by Mantissa Customer Support), an RMS/DeskTop Demo system for training 
purposes, SSL Certificates (to be used with iDT, an internet version of RMS\DeskTop), a separate component.

If at install time no demo system already exists on the pc, the install will automatically check for the Demo System to 
be installed. Uncheck the Demo install if you do not desire for this to be installed.

You will notice that the installation script also provides an MDAC install option. Take care in checking this option. 
You must verify the MDAC you require per your catalog type. We provide the MDAC Checker on the installation CD 
for download in the event you need a means in which to verify your pc’s current MDAC release level.

NOTE: RMS/DeskTop installations prior to release level 3.0 required both a Base and Interim install. 
This previous two-step install operation is now performed as a single-step procedure. This takes 
place now transparent to the user.

5.  The Select Program Folder dialog is presented next. The RMS 3.0 32-bit folder is automatically 
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selected. Click Next. 
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6.  The Check Setup Information dialog is shown. This allows you a review of the selections for setup for 
this installation. If all selections meet your approval, continue by selecting Next. 
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7. A Setup Status dialog will indicate the files installing as shown.  
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8. When the install is complete the install wizard will indicate complete as indicated below.

Network Installation
Installing RMS/DeskTop on Workstations
There are several ways to accomplish the workstation install. The method you choose should depend upon the 
following factors: 

• The number of users
• Are they all at the same location
• What is the current company policy for installing software
• How does you company distribute software and software upgrades
• How much time does the administrator have in a day (especially if they are not solely concentrating on 

RMS/DeskTop®)
The installation we recommend is what we call a “Network” Installation. Other options such as the Silent Installation 
is covered later on in this chapter.

Network Installation – What Is It?
Installing clients using this method is the most beneficial method, because it allows an Administrator to update RMS/
DeskTop® to only one source. 
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Once the base installation is installed on the workstation (i.e. 3.20), future updates only need to be applied to the 
server. This means that a lot of administrative work is removed and users have access to the latest versions of RMS/
DeskTop® as quickly as possible. There is no need to go to each workstation to perform the upgrade, email the 
upgrades to users or any other method of upgrading your company employs.

This type of installation provides the user with full RMS/DeskTop® functionalility.

Performing The Install on The Server
To be able to install from the Server, the RMS/DeskTop® Administrator must have access to the shared folder that 
RMS/DeskTop® has been installed into (if not, contact your local NT Administrator).

To install to each user’s workstation depends on how your company distributes software. The scenario here is that the 
Security Administrator will visit each workstation to load the base product.

Earlier RMS/DeskTop® was installed onto the server into the default folder

C:\Program Files\Mantissa\RMS DT 3.0 32-bit. 
This folder contains several folders and it is the Installation folder that houses the install files for a Network 
Installation.

On The Workstation
As long as the user’s PC can access the shared folder, open the Installation folder, then Base, and Disk 1 will be 
listed. Select Disk 1. Disk 1 will contain a Setup.exe file. (If file extensions are not shown it is Setup next to the 
monitor icon).

The Setup.exe is the executable file you will need to initiate the install of RMS/DeskTop® on each workstation.
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If the drive that houses RMS/DeskTop® on the server has not been mapped on the local workstation, and if the 
administrator locates the Installation folder and double clicks Setup.exe the following error message will occur. 

To install RMS/DeskTop® onto the workstation map a drive to the folder that will house RMS/DeskTop®, then locate 
the Installation folder. With the mapping complete, when Setup.exe is executed, the installation will begin and the 
following screen will appear.
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The next screen prepares the setup for InstallShield Wizard. 
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From the Setup dialog select Next.

An Information dialog will be presented with the current release level, build date and a list of important notes 
relating to major bug fixes and enhancements provided within the release being installed. 

If the Read Me file is not read now it can be accessed by clicking Start –Programs - RMS/DeskTop 3.0 32-bit – 
Release Notes and the Release Notes file will appear. 

This file also holds historical data pertaining to the product.
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From the Information dialog press Next to continue.
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The RMS/DeskTop Installation dialog presents a selection screen for the type of install you prefer; a Client install 
for a user’s workstation, or a Server install for a network installation.

Select Next to continue when selection is determined.

NOTE: To add product upgrades, as and when they come out, the base product must be installed – 
3.00 is the most recent base product available (although this is going to change in the future as 
the product is modified. Check with Mantissa Customer Support at support@mantissa.com for 
the most current base release of RMS/DeskTop). 
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The Choose Destination Location will be presented. This dialog allows installer to indicate placement of the 
installation for RMS/Desktop.

If Next is selected and the network path selected is invalid you will receive an error:

The user can browse to change the destination for the setup by selecting Browse. For this exercise we will choose the 
defaults.

NOTE: If the network path you are attempting to install to is not mapped on the client machine an error 
will be presented stating that the installation could not find the network path where 
RMS\DeskTop is installed. You will be prompted for it in the next dialog. The installation cannot 
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continue until the RMS\DeskTop path is found. If the user selects “OK” at this point the Network 
Path dialog appears to enable the user to browse to find the correct network path. The use of 
UNC paths are not encouraged. 
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An example of a network path in this installation would be \\mantissadc\program files\mantissa\rms dt 3.0 32-bit 

If using a network path, continue by selecting OK. If selecting the default path as we are in this exercise select Next 
to bring up the Select Components dialog. 

From the SELECT COMPONENTS dialog select the options required for install. 
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The Importer and System Creator (Sysgen) options are not needed as this user will not be installed with 
administrative rights.

If these options are selected they give the user the ability to be able to perform admin tasks on the Importer from their 
desktop, and create new “systems” if so required.

One reason for installing the Importer onto a client workstation would be to enable this user the ability to monitor the 
Importer from a client in the event the server install for the importer is not in close quarters for ease of monitoring.

Selecting Next will bring forward the Select Program Folder dialog. With the Program Folder selected, select Next to 
continue.
298 © 2013 Mantissa Corporation. All rights reserved.



R
D

_C
ha

pt
er

_1
2.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3
RMS/DeskTop® Version 3.25 

Reference Guide Installation (*)
Network Installation
The Check Setup Information dialog will be presented. Review the install configuration. If correct, continue by 
selecting Next.
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The next screen shows the files being installed with a progress bar in view at all times. 
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Once all the files are installed dialog appears telling you that Setup is configuring ODBC. The Install wizard will then 
show complete.

If the administrator wanted to create all users exactly the same then open up the client on this workstation – make any 
changes required (i.e., Feature Deny, etc), then install all other clients and copy the rmsdt32.ini from the first client 
install onto all the following clients.

Creating a Clone Install
As mentioned in the previous chapter, Feature Deny can be configured on the very first client PC to create an 
rmsdt32.ini file that can then be copied to all other clients so they have the same configuration.

There are a few other options that can be pre-configured and the paths saved in rmsdt32.ini.

The first few options have already been covered earlier in this manual and are as follows:

• DATADIR
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• TEMPDIR 

The RMS/Desktop® Viewer’s log file (rmsdt32-log.txt) can also be stored centrally if preferred but as this 
may assist in trouble shooting why RMS/Desktop® on an individual PC is having problems it may be 
advisable to store it on the local PC.

Finally each user can have their own Explorer View but if the company policy is to have a set standard then the 
Explorer View can be set on the first PC install then saved to a central server, maybe the same folder deny.ini, and 
other centrally stored files are located. 

Below shows the Explorer1 path pointing showing the path to the server. 

After the RMS/Desktop® Viewer has been opened for the first time when the user comes to close it make 
sure the file is saved to the central location and not the default C:\ drive. Explorer files are saved with a .dte 
extension.

Clone “Feature Deny .ini”
To create a deny.ini file to be used to clone other client installs save the file to a server and the path will be used in 
rmsdt32.ini.
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Below is a copy of the deny.ini file. 

As mentioned previously, the denial file path is entered into the rmsdt32.ini file, therefore if deny.ini is placed on a 
central server and the path is shown here, the first rmsdt32.ini is copied to all the other cloned PC’s they will all be 
pointing to the same file and have the same restrictions.

Below is an excerpt from the rmsdt32.ini showing the Denial file path to a shared folder on a central server.

Denial file path 
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Folders and Files Installed with RMS/DeskTop®
The RMS/DeskTop Installation CD will contain the following folders and files. Once the CD is loaded in the CD 
drive the CDInstaller.exe will automatically prompt the installation script for your convenience. 

This screen is an example of RMS/DeskTop® having been installed into the default C: directory path. 

Four folders (only three if the Dt3Demo system is not installed) and seven files are installed into the default path of 
C:\Program Files\Mantissa\RMS DT 3.0 32-bit if installing a client. 

An explanation of what each folder represents: 

Data An empty folder on install used to house local filters, name tree files, etc.
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Dt3Demo This holds the RMS/DeskTop® demo version’s system files/folders.
Program This holds the RMS/DeskTop® executables, catalog database, log files and help files.
temp This holds locally generated RMS/DeskTop® temp files (i.e., cache files, etc.).

       The following files are also added to WINNT: 

• DtImport32.ini

• DtSecure32.ini

• Rmsdt32.ini
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Folders and Files Installed with a System
When a system is created, RMS/DeskTop® will install the following folders and files associated with this system.The 
necessary folders and files installed with an RMS/DeskTop system are provided in the screen below. 
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A brief explanation of each folder:

Cache This “system” folder keeps “often used” RMS/DeskTop® files in quick access mode 
from the catalog file such that RMS/DeskTop® does not have to keep extracting them 
from the catalog.

DFS1 DFS1 is the default “system” directory where a “system’s” report data is stored in a 
compressed format. This does not have to reside here and can be situated on a com-
pletely different machine.

ExtDefs A desktop system file that houses all extraction definitions created within a desktop 
“system”. These definitions are normally housed in the EXDEFS folder, however 
they can be stored in any directory.

Forms This stores any form overlay files that are created.
Import The import folder is the destination folder for all incoming reports downloaded for 

inclusion in a “system” from the mainframe or from other PC Applications. Files are 
housed within the import folder until the Importer is activated and an attempt is made 
to import files into a system using predefined Report Series Definitions. This folder 
does not have to reside here and can be placed on a different machine.

SysExps The SysExps folder is the destination folder for the system’s auto exports. 
 

Listed below is a brief definition of each file exclusing any file ending with *.sem.  Semaphore files are temporary 
and are automatically regenerated upon startup:

Admin.db This system file houses security files such as group/user rights and report security 
records.

Admin.pdb This system file houses this system’s password definitions. 

NOTE: When a corrupted admin.db is replaced, the Admin.pdb from the same backup must 
accompany the admin.db. Both must match or the entry will be denied.

Catalog.mda This system file houses vital information in relation to the catalog.mdb.

NOTE: When replacing a corrupted Catalog.mdb, the Catalog.mda must always accompany it. Both 
must be retrieved from the same backup otherwise it will not be accessible.

Catalog.mdb This system file contains all the data related to the RMS/DeskTop® Explorer tree and 
is a link to where everything is stored.

Default.dtp This is the default printer file and houses the printer definitions and printer setup 
information for your RMS/DeskTop® system.

Default.idb Default importer file for a defined RMS/DeskTop® system (i.e.NewSystem).
Forms.ini Houses all settings for all form overlays for this system.
ReadTest.txt DeskTop verifies that the user has full read/write rights to the system’s folder by cre-

ating this file.
Sysdef.dbf A DB4 file that houses the desktop system’s report series definitions, storage classes 

and object stores. This file has an embedded system file entry and cannot be placed 
with any other system.

The following files are generated when a “new system” is created using Sysgen and are only visible once the system 
becomes active. This is due to the fact that they are dynamically allocated each time the system is started/stopped.
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Catalog.ldb A temporary system lock file used for the catalog file. This file provides locking 
capabilities and should not be copied during RMS\DeskTop system file backups. This 
file will cause problems accessing the system files copied. 

NOTE: The user is advised not to copy the Catalog.ldb file as part of the system file backups. Its 
placement into a new system will result in the system’s inability to be unlocked.

CatalogInfo_nNextAnnotationID.SEM  
A system generated file that keeps track of the next Annotation id number within the 
catalog. If a catalog becomes corrupted it may be that the user has replaced a catalog 
that does not match the numbers associated with the Next Catalog ID, or the Next 
Node ID assigned numbers previous to the catalog being replaced.

ICAV1.dbf Tracking file associated to the Importer. As a file is imported it goes into this import 
database where it begins the import process. If a file is in error and cannot be 
imported, the file will remain within this database. Problem files can be cleared from 
the Importer’s problem pane by deleting both ICAV*.* files and cycling the 
Importer.

ICAV1.mdx The ICAV1.mdx file is the importer’s index file. This file is associated with the 
ICAV1.dbf database file. This file houses the index entry for the file contained in the 
ICAV1.dbf database file.

Nametree.dat System file that houses required information used in the creation of the RMS/Desk-
Top® Explorer tree – it lists all nodes/reports as listed in Explorer View.

Nametree.sno System file that houses a dynamically created sequence number that is used to iden-
tify whether the name tree node ids are in numeric sequence with the catalog.mdb.

Nametree.sem Nametree.sem is a temporary file that is used during the creation of the nametree.dat 
file. Once RMS/DeskTop® is cycled this information is updated anew. 

Silent Installation
Installing RMS/DeskTop with Automated Distribution
With the release of RMS\DeskTop 3.xx, administrators can create silent installations for RMS/Desktop. The 
procedure is very simple. 

The procedure records the answers (fields) from the dialogs that one interacts with and saves the data in a file named 
'setup.iss'. The file is saved in the Windows directory.

1. Go to a DOS prompt

2. Change folder to where the installation is located. This step could be dealing with our network  
installation or a FULL installation copied from our CD.

3. Change folder to the DISK1 folder.

4. Type “SETUP -R” and press <enter>

5. Go through the installation like you'd normally do. Keep in mind that if you check to install the importer 
and sysgen, they will be installed during silent installation. Any answers or mouse clicks are recorded.

At this point a file named 'setup.iss' exists in the Windows directory. You may copy this file to the DISK1 folder. Now 
you have the ability to create a simple batch file in the DISK1 folder. 

One command will now launch the silent installation: SETUP -S
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You can now use this batch file to perform silent installations.

Creating A Shortcut to RMS/DeskTop
After installation, a shortcut to RMS/DeskTop can be created by the following procedure:

Shortcut on a Windows desktop:
1. Click START – Programs

2. From the Programs sub menu right click on RMS DT 3.0 32-bit

3. With the right mouse button drag the MRS DT 3.0 32-bit icon onto the windows desktop and release

4. Select Create shortcut(s) Here

5. Right click on the desktop shortcut icon.

6. Select Properties – then from the Run field change Normal window to Maximized. 

The next time RMS/DeskTop opens it will be maximized.
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Getting Help
Talk to Mantissa
Mantissa has added a new customer communications capability in RMS/DeskTop and DT/Archive Manager. The 
“Talk to Mantissa” feedback form is accessible in the RMS/DeskTop Viewer and Importer applications as well as the 
DT/Archive Manager application via a toolbar button and “Help” menu command, as shown below:
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Getting Help
The “Talk to Mantissa” feedback feature allows customers to suggest product improvements, report problems or 
correspond with Mantissa support personnel via direct email transmission.

Using the “Talk to Mantissa” Feature
When a user selects the “Talk to Mantissa” feature for the first time, the “Your contact information” fields will be 
empty. The contact information is retained on the local workstation for future use, eliminating the need to repeatedly 
enter it in the future.

Selecting the Feedback Type
Users may select from “Enhancement Request”, “Problem Report”, or “General Correspondence” feedback types. 
The user may also specify the product that their feedback pertains to via the “Product” combo box. The available 
choices are “RMS/DeskTop Viewer”, “RMS/DeskTop Importer”, “RMS/DeskTop Archiver”, “SysGen”, “Installation 
(Setup Program)” and “NA - correspondence”. The “Viewer”, “Importer” and “Archiver” options will be 
automatically selected by default based on the application being used to submit feedback.

If the “Enhancement request” option is selected, the user will be prompted to enter a one-line summary and as many 
details as necessary regarding the request or report. The user will also be given the opportunity to specify the priority 
for the enhancement, choosing from “Medium (when convenient)”, “High (as soon as possible)” or “Critical”. 

Submitting a request does not guarantee that an enhancement will be implemented. It will be considered.
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Getting Help
If a problem report is being submitted, the user is asked to provide a one-line summary, detailed description and step-
by-step instructions for reproducing the problem.

The “General Correspondence” option provides an easy way for the user community to initiate communication with 
their respective support personnel. The return email address will be determined based on their selected geographic 
location.

Submitting Feedback
When a user has completed feedback, they may submit it by clicking the “Send” button or pressing <ENTER>. A 
confirmation dialog is displayed to verify they have completed their submission and want it to be transmitted.

Additional Submission Options
There are additional options offered to the user if a problem report is being submitted. Users are prompted to include 
configuration files that may be helpful to Mantissa support in diagnosing a problem.

Internet

Website: www.mantissa.com

Ftp Site: ftp.mantissa.com

Email: Support@Mantissa.com For Mantissa product support questions.

Sales@Mantissa.com For product features, specifications, or pricing.

Info@Mantissa.com For general information or any other questions.

Telephone

Tech Support: (205) 262-4760

Fax: (205) 968-3932

Sales: (800) 438-7367 

Written correspondence

Mantissa Corporation

1121 Edenton Street

Birmingham, AL 35242 USA
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DRS Overview
C h a p t e r  1 3 :

The Document Retrieval System (DRS)

DRS Overview
Mantissa has enhanced the RMS system’s ability to retrieve current and archived documents and place them in the 
RMS/Desktop client systems running on Windows systems.  This capability eliminates all the overhead incurred by 
“Help desk” operations typically setup to help users retrieve older reports.

The system utilizes a server running on the mainframe communicating with Desktop clients running on Windows 
systems.  The Desktop client submits a TCP/IP request to the server on the mainframe.  This request is submitted by 
the server to JES as an RMS batch process requesting report(s) matching the passed variables.  The output of the 
retrieval is sent from RMS to Spool which sends the report back to the requesting Desktop client.  

The system is highly configurable and includes a new “pattern” matching feature to allow users to selectively pull 
only pages matching the requested “pattern”.

Requirements:
• RMS/Desktop version 3.23 client.
• RMS version 11.34 PTM level 15.
• RMS/Spool version 11.34 PTM level 21 or version 11.35 PTM level 00. 
• RMS mainframe print server (PRTCAP runs as a started task).
• JCL and PROCs .
These requirements will be discussed in detail in the following pages.

Connectivity Diagram
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RMS/Desktop version 3.23 client.
RMS/Desktop version 3.23 client.
The RMS/Desktop version 3.23 client is required to support DRS.  To access the RMS task area, a Desktop 
administrator would right click in the Systems Hierarchy tree panel.  In the ensuing window, click the System 
Properties tab.  In the System Properties panel, click the “Tasks” button.  This will bring up the following panel which 
is used to setup the various “print retrieval” tasks for a user.  The “General” tab lets the administrator define one or 
more tasks.  Each task includes: task name, mainframe job name to use (samples SBSAPRTA-print all or 
SBSAPRTP-print partial using a pattern), the DeskTop ID to receive the report and the mainframe’s IP address where 
the server resides. 

Next, you would setup the field definitions that are to be used with each task.  The provided fields for use are Class 
(Access Group), Location, Report ID and Pattern.  These fields can be arranged in any order you want the user to see 
them for each task.   The task will only submit 4 fields to the mainframe.  Any data content entered on this panel will 
become the default shown when user starts the submission request process.  Note the Read-only check box for each 
field.  If the check box is selected, the user will not be able to change the field’s default data at submission time.  This 
means the administrator can restrict the retrievals to specific classes (access group) etc.  

Additional fields can be added, modified or deleted by clicking the appropriate "add" or "delete" button in the "fields" 
panel or editing the data and clicking OK.  The "Name" value must match the NAME value used in the JCL specified 
by the "Job Name" value.  The "Name" value is prefixed by a "%" in the mainframe JCL.  For example, PATTERN 
314 © 2013 Mantissa Corporation. All rights reserved.
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RMS/Desktop version 3.23 client.
(shown below) would have %PATTERN referenced in the mainframe JCL specified by "Job Name".  The %name can 
be anywhere in "Job Name" JCL member. 

The "pattern" field is a powerful selection tool.  

TEMPLATE FORMAT: 
* is a wild card but not a place holder. 

+ is a wild card that serves as a place holder. 

*+ is equivalent to +*. 

** is equivalent to *, etc. 

TEMPLATE EXAMPLES AND DESCRIPTIONS FOLLOW:
1. ISF* match if key begins with ISF.

2. ISF+P match if key begins with ISF, has anything in position 4, then ends in position5 with P.

3. ISF*+P match if key begins with ISF, then has at leastone space before the last letter P. 

4. I*S*F match if I is first, F is last, and at least one S in between.

5. ++P*S match if key has P as the third character and terminates with the letter S.

6. ++P*S* same as 5, except that the S need not be the very last character. 

7. ISF+*P same as example 3.

8. **P*S same as example 5 except that P may be anywhere.

EXAMPLE:  
For a template of ‘*ACCOUNT++83088402*DATE++09/03/01*TEBOW*RAMBO’ 
The compare will return MATCH if the literal ACCOUNT followed by any two characters fol-
lowed by 83088402 followed by DATE (with any number of characters in between the account 
number and DATE ) followed by any two characters followed by 09/03/01.  Also, TEBOW and 
RAMBO could be any place in the buffer (with any number of characters separating them) so long 
as they appear in that order after the ACCOUNT/DATE string.
© 2013 Mantissa Corporation. All rights reserved.  315



R
D

_C
ha

pt
er

_1
3.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3

RMS/DeskTop® Version 3.25 

The Document Retrieval System (DRS) Reference Guide
TO RETRIEVE A REPORT:
TO RETRIEVE A REPORT:
In theReport/Versions area, the retrieve a report, right click on the report version you wish to retrieve and left click on 
the "RMS task..." option.  Desktop will present the input screen below: 

When the above task is submitted, only those pages that match the pattern specified will be returned.  Also, note in 
the setup panel, there is a Read-only check box for each field.  If the check box is selected for a field, the user will not 
be able to change the field’s data at submission time.

RMS version 11.34 PTM level 15.
RMS version 11.34 PTM level 15 is the release that supports DRS functionality.

RMS/Spool version 11.34 PTM level 21 or version 11.35 PTM level 00.
RMS/Spool version 11.34 PTM level 21 or version 11.35 PTM level 00 are the releases that support the DRS 
functionality.

RMS mainframe print server (PRTCAP).
PRTCAP is the mainframe TCP/IP server for the DRS task.  This name can be changed to any name as it is a started 
task executed out of a PROCLIB.  Various configurations parameters are input on startup and they are described 
below.  The server waits for data from Desktop clients, merges the selection criteria sent with the JCL specified by 
JOBNAME and submits the JOB to JES.

JCL  and PROCs.
Various JCL members and PROCs on the mainframe are required to implement the DRS solution.  The JCL and 
PROCs are used to process the information from the user and kick off the mainframe jobs required to retrieve the 
report.  They reside in a PDS and PROCLIB and are described below (samples supplied by Mantissa).

JCL for started task PRTCAP resides in a suitable PROCLIB.  This PROCEDURE references startup parameters at 
the bottom of the member (default is SYS1.PARMLIB(PRTCAP)).   

The JCL for initial jobs to be submitted to the JES internal reader by the PRTCAP started task are in the 
SUBMIT_LIBRARY specified in the PRTCAP PROC.   The job submitted will be based on the data received from 
the DESKTOP system submitting the request.  The predefined names are SBSAPRTA (for print all) and SBSAPRTP 
(for print partial) but they can be changed.  If changed, be sure to enter the new names in the DESKTOP 
customization.
316 © 2013 Mantissa Corporation. All rights reserved.
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TO RETRIEVE A REPORT:
The JCL for PROCEDURE SBSAPRT resides in a suitable PROCLIB.  This PROC is used by the report reprinting 
project jobs (SBSAPRTA and SBSAPRTP) and as a sample, it is setup to submit two requests: SBSAJCL1 and 
SBSAJCL2 (this could be a remote system).  The proc could be changed to support any combination of requests (ex 
SBSAJCL1, SBSAJCL2, .., SBSAJCLn).   The sample uses the SUBMIT_LIBRARY library as the source for the 
SBSAJCL# JCL.

The JCL for individual print jobs to be submitted to the JES internal reader by the SBSAPRT procedure reside in the 
SUBMIT_LIBRARY.   The sample names are SBSAJCL1 (for one system) and SBSAJCL2 (for a second system 
using an override pointing to a different repository) but they can be changed.  If changed, be sure to enter the new 
names in the SBSAPRT procedure.  You can add as many different jobs as you need based on need.

The JCL for PROCEDURE SBSAXPRC resides in a suitable PROCLIB.  This PROC is used by the report reprinting 
project jobs (SBSAPRT1, SBSAPRT2, …, SBSAPRTn) and is the job that actually does the print request. 

RMS/Desktop interfacing with other mainframe applications
RMS/Desktop DRS could be used to kick off any mainframe process. DRS will pass a JOBNAME and up to 4 fields 
of information to the mainframe started task PRTCAP. PRTCAP will get the JCL member named “JOBNAME”, do 
the variable substitution and send the job to JES. This job could be anything the user wants. The “pattern” feature 
would not be available as described above.  The four variables passed would have to be supported in the application 
process being initiated.

SPOOL, of course, makes the output of the RMS request (our default) seamlessly flow back to the initiating 
DESKTOP with the header to categorize the report. A user could use the job submitted above to spawn any number 
of tasks to get report(s) out to a PC directory defined as the RMS/Desktop INBOX.  RMS/Desktop would then need 
to be configured to import files based on the PC filename and load them into the appropriate folders.
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TO RETRIEVE A REPORT:
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DeskTop System
G l o s s a r y :

Glossary of Terms

DeskTop System
An RMS/DeskTop system is a logical collection of reports arranged in a hierarchical node structure, and a set of 
administrative attributes that control the storage, access, and use of those reports.

An RMS/DeskTop resides in some directory. To access an RMS/DeskTop system, the system's directory must be 
listed in a workstation's Systems Path.

Group
A group is an entity, used for security, that allows multiple users to be identified and referenced collectively. A group 
can have any number of member users, and a user may belong to more than one group.

A group has a name by which it is referenced.

Report Access Privileges
Report Access Privileges are the individually controllable capabilities that may be granted or denied users for each 
report.

The following table lists each privilege and what it controls.

PRIVILEGE CONTROLS

View Controls access to the report. If one cannot view a report, one cannot 
access the report in any way. Note: if a user is unable to view a report, 
then none of the other access controls are meaningful because to 
manipulate a report, a user must be able to first see that the report 
exists in a chooser.

Print Controls whether the user can print the report.

Delete Controls whether the user can delete the report. This applies to both 
direct attempts to delete report from the chooser and indirect attempts 
to delete the report through the aging process.

Hide Controls whether the user can mark any of the report versions as 
“hidden” through the REPORT PROPERTIES dialog in the application. 
Consult the application’s online help for more information on hidden 
reports and other report properties.

Date Controls whether the user can change the business date of the report. 
Changing the business date for a report will cause the versions for the 
report series to be re-sequenced.

Info Controls whether the user can alter the report’s Description or User 
Info properties.

Copy Controls whether report data may be copied to the windows clipboard 
or not.

Export Rpt Whether the user is allowed to export the report to a text file

Export Table Whether the user is allowed to export tabular (index) report data

Save Table Whether the user is allowed to save indices into the repository

Rearrange Rpt Cols Whether the user is allowed to re-order the report columns
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Report Access Record
Report Access Record
A report access record the combination of a report mask, and privilege settings for each group and user report series 
governed by the mask.

A report access record may define as few privileges as needed. Any privilege which is left blank is not defined, and 
must be resolved by a more general report access record.

Report Index
A report index is a collection of records which are produced by extracting information from the original report data. 
Each report version may have any number of indices. The content of an index is displayed in a table view by selecting 
the index's name in the view menu. 

Report Mask
A report mask is a special type of report specification that can include wildcard characters and thus may identify one 
or more report series.

In addition to the characters allowed in a report specification, report masks may also contain asterisks (*) and 
question marks (?).

A question mark (?) will match any one character.

An asterisk (*) will match zero or more characters up to the next backslash. An asterisk must either end a report mask 
or must be followed by a backslash.

Report masks always match recursively. For example, \FOO\BAR will match a report series of \FOO\BAR or any 
report series that begins with \FOO\BAR\. There cannot exist both a node \FOO\BAR and a report \FOO\BAR in a 
single RMS/DeskTop system.

Any mask that ends in “\*” is the same as a mask with the trailing “\*” removed. Both masks will match any report in 
the indicated node or any subnode thereof.

Report Series
A report series is a sequence of one or more versions of a report. Each version in a report series has the same Report 
ID and is located in the same node. The version order is determined primarily by a descending sort on the business 
date, and secondarily by a descending sort on the import time.

Report Series Specification
A report series specification is a string that specifies a specific report series by name. The string must start with a 
backslash and contain a sequence of zero or more node names separated by backslashes. The last component of the 
report series specification is the report ID. This is sometimes referred to as a report specification or series 
specification, and specification is sometimes abbreviated as spec.

Extract Whether the user is allowed to perform data extractions for the report

View Annt Whether the user is allowed to view annotations for the report

Edit Annt Whether the user is allowed to edit annotations for the report

View Arch Whether archived reports are displayed in the DT Explorer window.

Import Files Whether the user can import files. This right only applies to the ad-
hoc import function in the DT Explorer window.

PRIVILEGE CONTROLS
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Report Version
Report specifications may contain spaces and mixed case, which will be preserved; however, anytime a match is 
performed against a report specification, spaces are collapsed and case is ignored. Therefore, the report specification 
“\A mixed case spaced out spec” is the same as “\AMIXEDCASESPACEDOUTSPEC”.

The valid characters for a report specification are the letters A-Z or a-z, the numeric digits 0-9, space, period (.), and 
colon (:).

Report Version
A report version is any instance of a report in a report series. Each version has a unique business time and/or import 
time. Each version of a report series may or may not have unique user information or description. The version order is 
determined primarily by a descending sort on the business date, and secondarily by a descending sort on the import 
time.

Versions are referred by number. The most recent is the “tip” or version 0. The next most recent would be version 1, 
and so on.

RMS/DeskTop Security
Each RMS/DeskTop system is administered separately. To gain access to an RMS/DeskTop system, a valid user ID 
and password from the system’s security setup is required.

The RMS/DeskTop security system has three main components. These are: users, groups, and Report Access records

Of these three, report access records are central to accomplishing the main purpose of RMS/DeskTop security. A 
security setup can have many report access records. These records are all used to calculate the final access privileges 
for a specific user to a specific report.

Temporary Directory
The temporary directory is used to store temporary files that the application needs to perform its normal tasks.

RMS/DeskTop System
An RMS/DeskTop system is a logical collection of reports arranged in a hierarchical node structure, and a set of 
administrative attributes that control the storage, access, and use of those reports.

An RMS/DeskTop resides in some directory. To access an RMS/DeskTop system, the system's directory must be 
listed in a workstation's Systems Path.

Systems Path
The Systems Path is a semi-colon separated list of directory paths which reference directories that contain RMS/
DeskTop systems. 

For an RMS/DeskTop workstation to be able to access an RMS/DeskTop System, the system's directory must be 
listed in the workstation's systems path.

User
An individual user, from a security point of view, of an RMS/DeskTop system is known to RMS/DeskTop by his/her 
User ID, which is a sequence of characters uniquely identifying the user.

In addition to a user ID, a user may have a password. If so, the password must be supplied for the user to gain access 
to the system.

User's may or may not have Administration privileges. Only users that have Security Administration privileges may 
view and modify the security setup for a given RMS/DeskTop system. The only exception to this is when there are 
no users which have Administrator privileges. In this case, any user may access the security setup.
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Workstation Data Directory
Workstation Data Directory
The workstation data directory is where the application stores persistent workstation information such as local printer 
definitions and overrides and other client persistent data.

SSL Certificate
It refers to the cryptographical key used to encrypt the data exchanged between two entities in the internet. RMS/
DeskTop iDTServer utilizes a certificate to encrypt a system’s data (reports, configuration, and security) when it is 
transmitted via the internet to a remote client.
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A p p e n d i x - A

iDT Server (*)

Description
iDTServer allows remote workstations to access RMS/Desktop systems via an internet connection. It uses Secure 
Socket Layer (SSL) protocol and is capable of handling up to 5,000 simultaneous connections.

Benefits
iDTServer allows large sites to consolidate and manage RMS/Desktop systems from one central location or 
computer. Sites running multiple servers across a WAN will benefit greatly and those thinking of allowing access to 
reports via the internet (remote sites) will find this product extremely useful.

Requirements
It runs on all Windows XP versions and above, and it and requires a port (default 5375) to handle connection requests 
from the remote workstations. Firewalls are supported and can be utilized with this product. Product should be run on 
a very powerful machine since it will behave as a web server. We recommend at least 1GB of memory with very fast 
storage. This product does not require IIS services.

In order to view the reports transmitted from iDT Server you will need RMS/DeskTop Viewer v3.20 or later. With the 
exception of viewing and editing annotations a remote system’s data is treated as read-only by the remote viewers

Configuration
When configuring the iDTServer for communications you need to consider a couple of issues: Law and Security. You 
may be forced to use a secured communication line by law due to the nature of your reports’ content. Your company 
may also be forced to use a secured communication line due to company’s policy regarding customer’s data. We 
advice that you utilize a secured line.

iDTServer can utilize a secured line with a SSL certificate. We provide one with iDTServer and we will show you 
how to install it later on.
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General Properties
You can set the communication line’s properties with the Application Properties window. You can open this window 
via the Properties->Application on the main menu.

Firewall Type: This field allows you to pick the type of proxy used by your site’s firewall. Tunnel-type uses port 80. 
SOCKS4-type and SOCKS5-type use port 1020.

Host: This field is the IP address where the firewall is running. It can also be a domain name like www.ibm.com. If a 
domain name is used, a DNS request is performed in order to retrieve the host's IP address.

Port: This is the port number used by the firewall. You can override the default port number.

User: A firewall will likely require a user-id. Network administrator should provide you with one.

Password: A password will very likely be needed to use the firewall.

Timeout: This value is in seconds. If the workstation shows no activity within this period, the transmission is closed. 
We recommend 300 seconds but you can use higher numbers. A remote client will always try to re-establish a 
connection once the user requests data from the server.

Retries: This value indicates how many times a failed packet can be resent before aborting its transmission.
324 © 2013 Mantissa Corporation. All rights reserved.
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General Properties
Threads: The servers utilizes threads to handle requests from clients. This value should never be higher than the 
number of simultaneous connections. Set this value to sixteen or 1/3 the number of connections; whichever is highest.

Connections: This is the number of simultaneous connections (clients) that the server will support. If your iDT 
server is licensed for fifty users, you would normally set this value to fifty.

Buffer Size: This is the size of the incoming buffer. This buffer receives client's requests. The outgoing buffer's size 
is not relevant to the server's communication. The default is more than enough to receive the requests from the 
clients.

Server Port: The port where the server will accept connections from clients. The default is 5375.
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Server Certificate
Server Certificate
This SSL certificate is created by Mantissa Corporation or another certificate authority (CA) entity and sent via e-
mail to your place of business. The server's certificate provided by Mantissa is enclosed in a binary PFX file that you 
install with Internet Explorer.

Server Certificate Installation
This is a two-step process. First, you need to import the certificate into Internet Explorer. Second, you will need to 
use the certificate with iDTServer. You should have received two certificates from Mantissa. The server certificate is 
in PFX format and the client certificate is in CER format and should be distributed to the workstations. Let's address 
the server certificate:

Run IE and bring up the Options window (click Tools->InternetOptions on main menu). The image below 
corresponds to IE running under XP Pro
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Now click on the Contents tab in order to get to the certificates. Click on the Certificates button to open a dialog 
similar to the one below. Ignore the MANCORP certificate since it's used by our office and you will not get such an 
entry in your list. However, the certificate that you receive from us will be signed by Mantissa Corporation. 
Therefore, the Issued By column will have MANCORP.
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Server Certificate
 Click on the Import button to bring up a wizard. Click on the Next button to get the dialog below:
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Click on the Browse button to get a dialog like the one below. Change the field File Type to .PFX. Change the folder 
to where the certificate is located and select it. Click Open to close the dialog.
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Click Next until you get this dialog below. Change the default setting to Automatically select the certificate store. 
Click Next to finish the import. At this point, you will be back to the main window that lists the certificates and you 
should see the one that you imported

Now you need to go back to iDTServer and select the certificate using the SSL Certificate dialog. This is our next 
topic.
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Using SSL Certificate
Once you have successfully installed the server’s certificate, you can use it to communicate with remote clients 
(using a client certificate--more on that later.) Using a certificate will encrypt your data packets that travel to and from 
remote clients.

To select the certificate open the Application Properties window (Properties->Application menu item). Select the 
SSL Certificate tab. You will now see a window similar to the one below.

We select MANCUST certificate from the list. Keep in mind that your site may have other certificates but you should 
choose one with the proper signature and certification path. In this particular case, we are using the certificate shipped 
with iDTServer’s installation. This particular certificate is good for one year.

If you uncheck the Enable SSL field, the server will be communicating in a unsecured line. Although a DeskTop 
system’s data is already encrypted when sent via a unsecured line, you might be violating company’s policy or local 
laws by not using a secured line. Check with your supervisor or company’s legal department if the server will use a 
unsecured line.
© 2013 Mantissa Corporation. All rights reserved.  331



R
D

_A
pp

en
di

x-
A.

fm
: R

ev
is

ed
 S

at
ur

da
y,

 N
ov

em
be

r 2
3,

 2
01

3

RMS/DeskTop® Version 3.25 

iDT Server (*) Reference Guide
Server Certificate
Distributing Certificates
Server’s certificate should be shared with your remote clients since they need to know your public key. Otherwise, 
your remote client will not be able to establish a secured connection. If you received a certificate from Mantissa 
Corporation, there is nothing to do. If you lost or your certificate did not come from Mantissa Corporation, the 
instructions below will show you how to export the certificate.

Open Internet Explorer (6.xx) and open the Internet Options window. You should get the window similar to the one 
below.

Click on the Content tab and click the Certificates button. You should now see a dialog like the one in the next page.
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Click the Export button. You will now get a series of dialogs that we will now present with comments.
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Sometimes the certificate does have its private key stored in IE. You SHOULD NEVER export the private key. In this 
particular instance the private key cannot be exported. Public key is what will be used by the remote client to 
communicate with the server. Click Next to continue the export process.
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This is the most important dialog in this series. The arrow points to the certificate format that you should use. This 
format is very important since the remote clients can only read Base-64 format. Click Next to continue to the next 
dialog.
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Click on the Browse button to set the folder to one that you are familiar---remember the folder’s location! Enter the 
file name and click Next to export the file. E-mail the file to your remote clients. They will need to configure the 
client to use the certificate. The Viewer’s online help tells them how to do so.
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A p p e n d i x - B

Archive Manager(*)

Description
Archive Manager is a snap-in component designed to work with RMS/DeskTop output management system for intel 
environments. It provides a powerful yet flexible data archiving solution for RMS/DeskTop users, including several 
unique features:

Features
Relational Archiving
Most PC-based data archiving applications build archive volumes based on their creation time. In other words, 
unrelated data is thrown together in an archive volume based solely on when they were introduced to the system.

Archive Manager makes it easy to build archive volumes based on information content and relationships instead of 
creation time. You can create an unlimited number of archive "profiles" which describe your data relationships on a 
per-system basis.

This feature allows you to tailor archive volume content to the unique ways you need to access archived information. 
. Using this feature, you can generate archive volumes that contain

• a single department, division or regions data
• a specific customers data
• related financial statements
• any other grouping you can imagine to meet your research or archival needs

Easy Data Publishing
Archive Manager effectively offers double-duty service by making it easy to publish repository data into self-
contained, distributable/portable RMS/DeskTop systems. You control whether or not a documents inclusion in a 
volume causes it to be marked as having been archived. Using this feature, you can quickly generate standalone 
RMS/DeskTop systems that contain

• sales documents for an outside sales agent
• corporate financial documents for a third-party accounting/auditing firm
• account billing history for a customer
• required off-site archive files
• research data for specific departments
all without affecting the standard archiving operations on your live repository content.

Cumulative Volume Generation
Sometimes, regulations require you to move data offsite within a specific time period. As a result, archive volumes 
must be generated long before their maximum volume size is reached. This not only causes your physical 
warehousing requirements to escalate more rapidly than expected, it makes using the archived data tedious and time-
consuming. DeskTop/AM was designed to overcome this issue by offering a feature called "Cumulative Volume 
Generation".
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Basic Operating Concepts
A cumulative volumes content is retained by Archive Manager when it is generated. Subsequent volumes for the 
same archive profile contain the previous volumes content as well as the new content, allowing you to replace the 
previous iteration. This process is repeated until the specified maximum volume size is reached.

This feature delivers the largest possible grouping of related data items/versions per volume and the smallest possible 
archive volume library to store and maintain.

Universal Device Support
The Archive Manager works equally well with both online and offline storage systems. Any storage device that is 
accessible via a DOS drive letter or UNC path is supported. All you have to do is specify the path and maximum 
volume size (such as 650MB for CD-R). AM can generate archive volumes as raw files or "ready-to-burn" ISO 9660 
CD-R images for use with third-party CD authoring applications.

Basic Operating Concepts
Before you get started with Archive Manager, there are a few concepts you should be familiar with.

Archive Repository
Your live repository, which is managed by RMS/DeskTop, contains both document data and a catalog of its contents. 
Archive Manager manages your archived data content through its own contents catalog called the archive repository. 
RMS/DeskTop and Archive Manager work together to integrate your live and archive repositories into one seamless 
entity. This tight product integration makes your archived data always appear to be part of your live system, even 
though it may be spread across multiple network paths or even physically separate media.

Archive and Distribution Profiles
The first step in getting Archive Manager up and running is to describe how you want your repository contents to be 
archived and/or distributed. This is achieved by creating profiles. Profiles specify what nodes and/or documents are to 
be archived/distributed together and how often volumes should be generated.

You can create as many different profiles as needed. They are defined on a per-system basis. This makes it possible to 
create commonly-named profiles for different repository systems that will control the archiving/distributing of 
similar materials.

You will find that profiles provide a wealth of flexibility in how your repository data is archived and/or distributed.

Archive and Distribution Volumes
Simply put, archive and distribution volumes are what Archive Manager is all about. Archive Manager uses the 
profile settings you've specified to generate volumes that contain data from your RMS/DeskTop system repository. 
Each volume may be a physically separate piece of media if removable media, such as CD-Rs, JAZ/Zip disks, etc., 
are used. Alternatively, it could be nothing more than an individual subdirectory on a managed drive array.

A documents inclusion in an archive or distribution volume won't result in it being removed from the live repository. 
Document removal (deletion) from the live repository is usually handled by the RMS/DeskTop aging process. For 
more information on the aging process, refer to the online or printed RMS/DeskTop documentation.

Both archive and distribution volume contents are stored in a compressed, secure form. They can only be accessed in 
the RMS/DeskTop application by users who have the appropriate security settings to do so.

Archive volumes are NOT self-contained repositories. Accessing them requires the live repository that they were 
built from to be online. Security settings in the current live repository control access to the archived data.

Distribution volumes, on the other hand, are self-contained, redistributable RMS/DeskTop systems. Access to their 
content is governed by the security settings that they contain. You may also choose not to include security settings in 
a distribution volume, allowing any RMS/DeskTop user to view it's contents.
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Specifying output to an archive or distribution volume is as simple as selecting a single control in the Archive 
Manager application. Your live repository data can be copied to as many different distribution volumes as needed, but 
will only be copied to a single archive volume.

Cumulative Volumes
As volumes are created, their contents may require no more than a fraction of the target medias storage capacity, 
depending on the volume generation conditions. Over time, this can lead to an archive library having substantially 
more volumes than would be required if the medias full capacity had been used.

You can instruct Archive Manager to generate cumulative volumes to minimize this issue. Each cumulative volume 
contains all of its cumulative predecessors content as well as its own. Once it has been successfully generated and 
verified, it replaces its previous iteration. This process is repeated until as much of the storage medias capacity is 
consumed as possible.

Staging Area
Archive Manager requires temporary storage space to create archive and distribution volumes. This temp space is 
referred to as the "staging area". The size of the staging area can grow to be quite large, particularly if you are 
generating cumulative volumes. To calculate the staging area size, add the maximum volume sizes you specified in 
all of the profiles for all of your systems. For example, let's say you've created ten profiles, each with a specified 650 
megabytes maximum volume size. The staging area storage requirement would equal 650 MB times 10 profiles, or 
6500 MB, which is approximately 6.5 gigabytes.

Creating and Maintaining Profiles
Profiles provide the control mechanism for archive/distribution generation. A profiles settings control a volumes 
content, how often volumes are generated, and the location where they are stored.

Managing Profiles
Profiles are stored on a per-system basis, so you should first select the system you want to edit profiles for. Once a 
system is selected, its profiles are displayed in the Profiles list box. New profiles may be created or existing profiles 
renamed or deleted by pressing the appropriate Profile Maintenance buttons (New, Rename and Delete).

NOTE:  You will only see profiles that you have the security rights to modify. "Archive Administrator" and 
"Distribution Administrator" rights are configured in the "Security Properties" dialog, accessed via RMS/DeskTop.

You may temporarily disable a profile (so that volumes won’t be generated by its settings) by unchecking the Enabled 
check box.

When you're satisfied with your changes, click the Apply button. Likewise, click Reset to discard any changes made 
to the selected profile since it was last saved.

Selecting Nodes/Documents in Profiles
Individual documents or entire nodes may be selected in a profile. To modify the selections, confirm the Nodes tab is 
selected in the Nodes/Properties tabbed window contained in the right side of the Profiles tab.

A node/document may be assigned to multiple distribution profiles, but only one archive profile. A profile is 
considered to be a distribution or archive type of profile based on its Archive or Distribution setting, which is 
described later in this topic. The Profile Assignments column in the nodes tree lists all of the profile assignments for 
each node, making it easy to determine which nodes have already been assigned to a profile.

Editing Profile Properties
The Properties tab allows you to control how often archive/distribution volumes are generated and how/where they 
are stored.
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Selecting Profile Volume Type, Starting Date
The Archive and Distribution radio buttons, located at the top of the Properties tab's work area, control the creation of 
archive or distribution volumes based on the current profiles settings.

The Start Date date control, located to the right of the Archive and Distribution radio buttons, allows you to specify a 
future date for Archive Manager to commence generation of volumes based on the current profiles settings.

Distribution Options
When a distribution volume generation is specified by selecting the Distribution radio button, several controls are 
enabled to allow you to specify options that only apply to distribution volumes.

You may specify a distribution volume's system name by entering a title in the System Name edit field. If no name is 
specified, Archive Manager generates a default name by appending -D to the end of the live repository systems name, 
i.e., DTDemo-D.

You may also control the number of document versions included in a distribution by checking the Versions check 
box, followed by selecting the All, First or Last radio buttons. If the First or Last radio buttons are selected, you must 
also enter a specific number of versions in the Versions edit field.

Generation Interval
Volume generation may be scheduled on a daily or weekly basis, with a variety of options that control each of these 
frequencies:

• Daily - Every x days, Every Weekday
• Weekly - Recur every x week(s) on Sunday, Monday, Tuesday, Wednesday, Thursday, Friday and/or Sat-

urday
The settings are very flexible and allow practically any kind of regularly-recurring schedule you can think of.

Controlling Archive Volume Size and Destination
Archive volumes maximum size may be controlled by specifying a value in the Maximum volume size edit field. 
This value is typically the storage capacity of the media being used to store the archive volume, such as 650 
megabytes for a CD-ROM. Multiple volumes may be created at a time based on the amount of data to be archived and 
the specified maximum volume size.

NOTE:  You should not specify a maximum volume size equivalent to the maximum device storage capacity unless 
you are using removable media. If your archive/distribution volumes will be stored online, you should avoid 
maximum volume sizes larger than ten percent of your total storage capacity.

Keep in mind that your volume staging area must be of sufficient capacity to store one in-progress volume per profile, 
per system. Each in-progress volume size will be as much as specified in the Maximum volume size edit field. For 
example, if you create volumes for three systems, each containing ten profiles, with a 2GB maximum volume size 
specified for every profile, your staging area will have to have at least 60GB available storage capacity (3 systems 
times ten profiles each, times 2GB per in-progress volume).

NOTE:  Archive Manager does not support volume spanning for document storage. The "Maximum Volume Size" 
value should always be larger than the largest documents being archived/distributed.

You may specify any UNC-compatible path for completed archive volumes to be written to in the Volume path edit 
field. You may optionally select the Browse button to select a volume path via the standard Windows Browse for 
Folder dialog.

Generating Cumulative Volumes
As archive/distribution volumes are created, it is possible that their contents will require no more than a fraction of 
the media’s storage capacity that they are being written to. Over time, this can lead to an archive library having 
substantially more volumes than it would have had if the media’s full capacity had been used.
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You have the option of minimizing this issue by checking the Generate Cumulative Volumes checkbox, causing 
cumulative volumes to be generated. Each cumulative archive volume contains all of its cumulative predecessors 
content as well as its own. Once it has been successfully generated and verified, it replaces its previous iteration. This 
process is repeated until as much of the storage medias capacity is consumed as possible.

Using cumulative archive volumes may substantially increase the amount of needed temporary working storage. This 
is due to every profile’s working area growing to the maximum volume size before they are reset.

Generating "Ready to Burn" CD-ROM Images
If you plan to use CD-R recording media for storing your archive/distribution volumes, you should check the 
Generate ISO 9660 (MS Joliet) CD-ROM images checkbox. This causes Archive Manager to generate a "ready to 
burn" ISO 9660 CD-ROM image. This also allows Archive Manager to have exact control over the volumes content. 
ISO 9660 images are an internationally-accepted format and can be read by practically all CD authoring applications. 
Other standardised image formats, such as those used by DVD-ROM, may be added to Archive Manager in the 
future.

Aging Archived Reports
Reports are automatically aged by the properties set in a report’s Storage Class object.
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